Notice

The company reserves the right to revise this publication or to change its contents without notice. Information contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse) of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, transmitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trademarks of their respective companies. They are mentioned for identification purposes only and are not intended as an endorsement of that product or its manufacturer.

©February 2014

Trademarks

Intel and Intel Core are trademarks/registered trademarks of Intel Corporation.
Preface

R&TTE Directive
This device is in compliance with the essential requirements and other relevant provisions of the R&TTE Directive 1999/5/EC.

This device will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, Luxembourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland, United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slovenia.

ErP Off Mode Power Consumption Statement:
The figures below note the power consumption of this computer in compliance with European Commission (EC) regulations on power consumption in off mode:

• Off Mode < 0.5W
CE Marking

This device has been tested to and conforms to the regulatory requirements of the European Union and has attained CE Marking. The CE Mark is a conformity marking consisting of the letters “CE”. The CE Mark applies to products regulated by certain European health, safety and environmental protection legislation. The CE Mark is obligatory for products it applies to: the manufacturer affixes the marking in order to be allowed to sell his product in the European market.

This product conforms to the essential requirements of the R&TTE directive 1999/5/EC in order to attain CE Marking. A notified body has determined that this device has properly demonstrated that the requirements of the directive have been met and has issued a favorable certificate of expert opinion. As such the device will bear the notified body number 0560 after the CE mark.

The CE Marking is not a quality mark. Foremost, it refers to the safety rather than to the quality of a product. Secondly, CE Marking is mandatory for the product it applies to, whereas most quality markings are voluntary.
Preface

FCC Statement
(Federal Communications Commission)
You are cautioned that changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Re orient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
   And
2. This device must accept any interference, including interference that may cause undesired operation of the device.
FCC RF Radiation Exposure Statement:

1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator and your body.

**Warning**

Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not expressly approved by the manufacturer for compliance with the above standards could void your authority to operate the equipment.
IMPORTANT SAFETY INSTRUCTIONS

Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet basement or near a swimming pool.
2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There may be a remote risk of electrical shock from lightning.
3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit:

- **Models A, B & C** - Full Range AC/DC Adapter - AC Input 100 - 240V, 50 - 60Hz, DC Output 19.5V, 9.2A & 19V, 9.5A (180W) minimum.
- **Model D** - Full Range AC/DC Adapter - AC Input 100 - 240V, 50 - 60Hz, DC Output 19.5V, 6.15A (120W) minimum.
- **Models E & F** - Full Range AC/DC Adapter - AC Input 100 - 240V, 50 - 60Hz, DC Output 19.5V, 11.8A (230W) minimum.

This Computer’s Optical Device is a Laser Class 1 Product
Instructions for Care and Operation

The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. **Don’t drop it, or expose it to shock.** If the computer falls, the case and the components could be damaged.

   ![Diagram](Image1)
   - Do not expose the computer to any shock or vibration.
   - Do not place it on an unstable surface.
   - Do not place anything heavy on the computer.

2. **Keep it dry, and don’t overheat it.** Keep the computer and power supply away from any kind of heating element. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly damaged.

   ![Diagram](Image2)
   - Do not expose it to excessive heat or direct sunlight.
   - Do not leave it in a place where foreign matter or moisture may affect the system.
   - Don’t use or store the computer in a humid environment.
   - Do not place the computer on any surface that will block the Vents/Fan Intakes.
Preface

3. **Avoid interference.** Keep the computer away from high capacity transformers, electric motors, and other strong magnetic fields. These can hinder proper performance and damage your data.

4. **Follow the proper working procedures for the computer.** Shut the computer down properly and don’t forget to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

<table>
<thead>
<tr>
<th>Do not turn off the power until you properly shut down all programs.</th>
<th>Do not turn off any peripheral devices when the computer is on.</th>
<th>Do not disassemble the computer by yourself.</th>
<th>Perform routine maintenance on your computer.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td><img src="image2.png" alt="Image" /></td>
<td><img src="image3.png" alt="Image" /></td>
<td><img src="image4.png" alt="Image" /></td>
</tr>
</tbody>
</table>

5. **Take care when using peripheral devices.**

<table>
<thead>
<tr>
<th>Use only approved brands of peripherals.</th>
<th>Unplug the power cord before attaching peripheral devices.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image5.png" alt="Image" /></td>
<td><img src="image6.png" alt="Image" /></td>
</tr>
</tbody>
</table>
Power Safety

The computer has specific power requirements:

- Only use a power adapter approved for use with this computer.
- Your AC/DC adapter may be designed for international travel but it still requires a steady, uninterrupted power supply. If you are unsure of your local power specifications, consult your service representative or local power company.
- The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong is an important safety feature; do not defeat its purpose. If you do not have access to a compatible outlet, have a qualified electrician install one.
- When you want to unplug the power cord, be sure to disconnect it by the plug head, not by its wire.
- Make sure the socket and any extension cord(s) you use can support the total current load of all the connected devices.
- Before cleaning the computer, make sure it is disconnected from any external power supplies (i.e. AC/DC adapter or car adapter).

Power Safety

Warning

Before you undertake any upgrade procedures, make sure that you have turned off the power, and disconnected all peripherals and cables (including telephone lines and power cord).

You must also remove your battery in order to prevent accidentally turning the machine on. Before removing the battery disconnect the AC/DC adapter from the computer.

Do not plug in the power cord if you are wet.
Do not use the power cord if it is broken.
Do not place heavy objects on the power cord.
Preface

Polymer Battery Precautions
Note the following information which is specific to polymer batteries only, and where applicable, this overrides the general battery precaution information overleaf.

- Polymer batteries may experience a slight expansion or swelling, however this is part of the battery’s safety mechanism and is not a cause for concern.
- Use proper handling procedures when using polymer batteries. Do not use polymer batteries in high ambient temperature environments, and do not store unused batteries for extended periods.

See also the general battery precautionary information overleaf for further information.
General Battery Precautions

• Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
• Do not remove any batteries from the computer while it is powered on.
• Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire.
• If you do not use the battery for an extended period, then remove the battery from the computer for storage.
• Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
• Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qualified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries may explode or leak if exposed to fire, or improperly handled or discarded.
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.

Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life, under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s instructions.
Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the power supply. Then refer servicing to qualified service personnel under any of the following conditions:

• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to rain or other liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your computer.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and screw(s) before restoring power to the system.
Also note the following when the cover is removed:
• Hazardous moving parts.
• Keep away from moving fan blades.
Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hardware and software. Make sure your “papers” are handy.

Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the Vents/Fan Intakes to be blocked. To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intakes while the computer is in use.
Preface

On the Road
In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting, keep these points in mind:

**Hand-carry the notebook** - For security, don’t let it out of your sight. In some areas, computer theft is very common. Don’t check it with “normal” luggage. Baggage handlers may not be sufficiently careful. Avoid knocking the computer against hard objects.

**Beware of Electromagnetic fields** - Devices such as metal detectors & X-ray machines can damage the computer, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). **Note**: Some airports also scan luggage with these devices.

**Fly safely** - Most airlines have regulations about the use of computers and other electronic devices in flight. These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

**Get power where you can** - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies) charged.

**Keep it dry** - If you move quickly from a cold to a warm location, water vapor can condense inside the computer. Wait a few minutes before turning it on so that any moisture can evaporate.
Developing Good Work Habits

Developing good work habits is important if you need to work in front of the computer for long periods of time. Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or other joints. The following are some tips to reduce the strain:

- Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.
- Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a footrest if necessary.
- Use a chair with a back and adjust it to support your lower back comfortably.
- Sit straight so that your knees, hips and elbows form approximately 90-degree angles when you are working.
- Take periodic breaks if you are using the computer for long periods of time.

Remember to:
- Alter your posture frequently.
- Stretch and exercise your body several times a day.
- Take periodic breaks when you work at the computer for long periods of time. Frequent and short breaks are better than fewer and longer breaks.
Preface

Lighting
Proper lighting and a comfortable viewing angle can reduce eye strain and shoulder and neck muscle fatigue.

- Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
- Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
- Position the display directly in front of you at a comfortable viewing distance.
- Adjust the display-viewing angle to find the best position.

LCD Screen Care
To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for an extended period of time) take the following precautions:

- Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.
- Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
- Rotate desktop background images every few days.
- Turn the monitor off when the system is not in use.

LCD Electro-Plated Logos
Note that in computers featuring a raised LCD electro-plated logo, the logo is covered by a protective adhesive. Due to general wear and tear, this adhesive may deteriorate over time and the exposed logo may develop sharp edges. Be careful when handling the computer in this case, and avoid touching the raised LCD electro-plated logo. Avoid placing any other items in the carrying bag which may rub against the top of the computer during transport. If any such wear and tear develops contact your distributor/supplier.
## Contents

Notice .............................................................................................................................................................I
ErP Off Mode Power Consumption Statement: ................................................................. II
FCC Statement ...........................................................................................................................................IV
FCC RF Radiation Exposure Statement: ................................................................................... V
Instructions for Care and Operation ................................................................................... VII
Power Safety ........................................................................................................................................ IX
Polymer Battery Precautions ........................................................................................................ X
General Battery Precautions ....................................................................................................... XI
Cleaning ........................................................................................................................................... XII
Servicing .......................................................................................................................................... XII
Travel Considerations ..................................................................................................................... XIII

### Quick Start Guide

Overview ............................................................................................................................................ 1-1
Advanced Users ............................................................................................................................. 1-2
Beginners and Not-So-Advanced Users .................................................................................. 1-2
Warning Boxes ............................................................................................................................. 1-2
Not Included ................................................................................................................................. 1-3
System Software ............................................................................................................................ 1-4
Model Differences ....................................................................................................................... 1-5
System Startup ............................................................................................................................. 1-6
## Preface

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Desktop Application</td>
<td>1-40</td>
</tr>
<tr>
<td>The Charms Bar</td>
<td>1-41</td>
</tr>
<tr>
<td>Windows 8.1 Taskbar</td>
<td>1-43</td>
</tr>
<tr>
<td>Video Features</td>
<td>1-44</td>
</tr>
<tr>
<td>Microsoft Hybrid Graphics</td>
<td>1-44</td>
</tr>
<tr>
<td>Configuring External Displays</td>
<td>1-48</td>
</tr>
<tr>
<td>Power Options</td>
<td>1-49</td>
</tr>
<tr>
<td>Running Apps</td>
<td>1-50</td>
</tr>
</tbody>
</table>

## Storage Devices, Mouse, & Audio

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>2-1</td>
</tr>
<tr>
<td>Hard Disk Drive</td>
<td>2-2</td>
</tr>
<tr>
<td>Optical Device</td>
<td>2-3</td>
</tr>
<tr>
<td>Loading Discs</td>
<td>2-3</td>
</tr>
<tr>
<td>Handling CDs or DVDs</td>
<td>2-4</td>
</tr>
<tr>
<td>DVD Regional Codes</td>
<td>2-5</td>
</tr>
<tr>
<td>Multi-in-1 Card Reader</td>
<td>2-6</td>
</tr>
<tr>
<td>Audio Features</td>
<td>2-7</td>
</tr>
<tr>
<td>Setup for Audio Recording</td>
<td>2-8</td>
</tr>
<tr>
<td>Setup for 5.1 or 7.1 Surround Sound</td>
<td>2-9</td>
</tr>
<tr>
<td>Touchpad and Buttons/Mouse</td>
<td>2-11</td>
</tr>
<tr>
<td>Touchpad Configuration for Driver Version 1</td>
<td>2-13</td>
</tr>
</tbody>
</table>
Preface

Gestures and Device Settings ..................................................................................................................2-14
Touchpad Configuration for Driver Version 2 .....................................................................................2-18
Finger Sensing Pad Configurator .............................................................................................................2-19

Power Management
Overview ....................................................................................................................................................3-1
The Power Sources .................................................................................................................................3-2
AC/DC Adapter ........................................................................................................................................3-2
Battery ....................................................................................................................................................3-2
Turning On the Computer .........................................................................................................................3-3
Shutting the Computer Down ..................................................................................................................3-4
Power Plans ...........................................................................................................................................3-5
Power-Saving States ...............................................................................................................................3-7
Sleep .........................................................................................................................................................3-7
Hibernate ...............................................................................................................................................3-8
Shut down ..............................................................................................................................................3-8
Configuring the Power Buttons ............................................................................................................3-9
Resuming Operation .................................................................................................................................3-11
Power Conservation Modes ..................................................................................................................3-12
Battery Information ...............................................................................................................................3-14
Battery Power ........................................................................................................................................3-14
Conserving Battery Power ....................................................................................................................3-15
Battery Life ..............................................................................................................................................3-16
New Battery .............................................................................................................................................3-16
Recharging the Battery with the AC/DC Adapter ...................................................................................3-16
Proper handling of the Battery Pack ........................................................................................................3-17
Battery FAQ .............................................................................................................................................3-18

Drivers & Utilities
What to Install ............................................................................................................................................4-1
Module Driver Installation .........................................................................................................................4-1
Driver Installation ......................................................................................................................................4-2
Updating/Reinstalling Individual Drivers ..................................................................................................4-4
User Account Control ................................................................................................................................4-5
Windows Security Message .......................................................................................................................4-5
New Hardware Found ................................................................................................................................4-5
Driver Installation Procedure .....................................................................................................................4-6
Chipset ......................................................................................................................................................4-6
Video (VGA) .............................................................................................................................................4-6
NVIDIA Video (VGA) .................................................................................................................................4-6
AMD Video (VGA) ...................................................................................................................................4-6
LAN .........................................................................................................................................................4-7
Card Reader .............................................................................................................................................4-7
Touchpad ..................................................................................................................................................4-7
Preface

Airplane ...................................................................................................................................................... 4-7
Hot Key ..................................................................................................................................................... 4-7
MEI Driver ................................................................................................................................................. 4-7
Audio .......................................................................................................................................................... 4-7
Optional Drivers ........................................................................................................................................ 4-8

BIOS Utilities

Overview .................................................................................................................................................... 5-1
The Power-On Self Test (POST) ............................................................................................................... 5-2
Failing the POST ........................................................................................................................................ 5-3
Fatal Errors ................................................................................................................................................ 5-3
Non-Fatal Errors ....................................................................................................................................... 5-3
The Setup Utility ....................................................................................................................................... 5-4
Entering Setup ............................................................................................................................................. 5-4
Setup Screens ............................................................................................................................................ 5-5
Main Menu .................................................................................................................................................. 5-6
System Time & Date (Main Menu) ............................................................................................................ 5-6
SATA Port # (Main Menu) ........................................................................................................................ 5-7
System/Extended Memory (Main Menu) ................................................................................................... 5-7
MB Series / BIOS Revision / KBC/EC firmware Revision (Main Menu) .................................................. 5-7
Advanced Menu ....................................................................................................................................... 5-8
Intel(R) Rapid Start Technology (Advanced Menu) ................................................................................. 5-8
Preface

Intel(R) Rapid Storage Technology (Advanced Menu) ................................................................. 5-9
SATA Mode (Advanced Menu) ................................................................................................... 5-9
Boot Logo (Advanced Menu) ..................................................................................................... 5-9
Power On Boot Beep (Advanced Menu) .................................................................................... 5-10
Battery Low Alarm Beep (Advanced Menu) ............................................................................. 5-10
Security Menu ............................................................................................................................ 5-11
Set Supervisor Password (Security Menu) ................................................................................ 5-11
Set User Password (Security Menu) .......................................................................................... 5-12
Password on boot: (Security Menu) .......................................................................................... 5-12
Secure Boot Control (Security Menu) .......................................................................................... 5-13
TPM Configuration (Security Menu) .......................................................................................... 5-14
TPM State (Security Menu > Security Device Support Enabled) .................................................. 5-15
Pending TPM operation (Security Menu > Security Device Support Enabled & TPM State Enabled) 5-16
Boot Menu .................................................................................................................................... 5-17
Boot Option Priorities (Boot Menu) ............................................................................................ 5-18
UEFI Boot (Boot Menu) .............................................................................................................. 5-18
Exit Menu .................................................................................................................................... 5-19

Upgrading The Computer
Overview ........................................................................................................................................ 6-1
When Not to Upgrade .................................................................................................................. 6-2
Removing the Battery .................................................................................................................... 6-3
## Preface

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Removing The Battery from Model A, B, C &amp; D Computers</td>
<td>6-4</td>
</tr>
<tr>
<td>Removing The Battery from Model E &amp; F Computers</td>
<td>6-5</td>
</tr>
<tr>
<td>Upgrading the Optical Device</td>
<td>6-6</td>
</tr>
<tr>
<td>Upgrading the Optical Device (Models A, C &amp; D)</td>
<td>6-7</td>
</tr>
<tr>
<td>Upgrading the Optical Device (Model B)</td>
<td>6-8</td>
</tr>
<tr>
<td>Upgrading the Optical Device (Models E &amp; F)</td>
<td>6-9</td>
</tr>
<tr>
<td>Upgrading the Hard Disk Drive(s)</td>
<td>6-10</td>
</tr>
<tr>
<td>Removing the Cover from the Primary HDD Bay (Models A, C &amp; D)</td>
<td>6-11</td>
</tr>
<tr>
<td>Removing the Cover from the HDD/ODD Bay (Model B)</td>
<td>6-12</td>
</tr>
<tr>
<td>Removing the Cover from the Primary HDD Bay (Models E &amp; F)</td>
<td>6-13</td>
</tr>
<tr>
<td>Removing the Primary HDD Assembly</td>
<td>6-14</td>
</tr>
<tr>
<td>Removing the Hard Disk from the Caddy HDD Bay (Models A, C &amp; D)</td>
<td>6-17</td>
</tr>
<tr>
<td>Removing the Hard Disk from the Secondary HDD Bay (Model B)</td>
<td>6-18</td>
</tr>
<tr>
<td>Removing the Hard Disk from the Secondary HDD Bay (Models E &amp; F)</td>
<td>6-21</td>
</tr>
<tr>
<td>Upgrading the System Memory (RAM)</td>
<td>6-24</td>
</tr>
<tr>
<td>Removing the Component Cover (Models A, C &amp; D)</td>
<td>6-25</td>
</tr>
<tr>
<td>Removing the Component Cover (Model B)</td>
<td>6-26</td>
</tr>
<tr>
<td>Removing the Component Cover (Model E)</td>
<td>6-27</td>
</tr>
<tr>
<td>Removing the Component Cover (Model F)</td>
<td>6-28</td>
</tr>
<tr>
<td>System Memory (RAM) Module Removal</td>
<td>6-29</td>
</tr>
<tr>
<td>Upgrading the mSATA SSD</td>
<td>6-30</td>
</tr>
</tbody>
</table>
# Modules

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>7-1</td>
</tr>
<tr>
<td>Setting Up SATA RAID or AHCI Mode</td>
<td>7-2</td>
</tr>
<tr>
<td>AHCI Mode</td>
<td>7-2</td>
</tr>
<tr>
<td>RAID</td>
<td>7-2</td>
</tr>
<tr>
<td>Intel® Rapid Storage Technology Application</td>
<td>7-2</td>
</tr>
<tr>
<td>SATA RAID Setup Procedure (Windows 8.1)</td>
<td>7-4</td>
</tr>
<tr>
<td>IRST Driver Installation</td>
<td>7-10</td>
</tr>
<tr>
<td>Deleting a RAID (Windows 8.1)</td>
<td>7-11</td>
</tr>
<tr>
<td>PC Camera Module</td>
<td>7-12</td>
</tr>
<tr>
<td>PC Camera Audio Setup</td>
<td>7-13</td>
</tr>
<tr>
<td>Camera App</td>
<td>7-14</td>
</tr>
<tr>
<td>Camera Options</td>
<td>7-15</td>
</tr>
<tr>
<td>Taking Pictures/Capturing Video</td>
<td>7-16</td>
</tr>
<tr>
<td>Camera Roll</td>
<td>7-17</td>
</tr>
<tr>
<td>Wireless LAN Module</td>
<td>7-21</td>
</tr>
<tr>
<td>3rd Party 802.11b/g/n Driver Installation</td>
<td>7-22</td>
</tr>
<tr>
<td>Intel® WLAN Driver Installation</td>
<td>7-22</td>
</tr>
<tr>
<td>Qualcomm Atheros WLAN Combo Driver Installation</td>
<td>7-23</td>
</tr>
<tr>
<td>Qualcomm Atheros Killer Network Manager</td>
<td>7-24</td>
</tr>
<tr>
<td>WLAN Configuration in Windows</td>
<td>7-30</td>
</tr>
<tr>
<td>Fingerprint Reader Module</td>
<td>7-33</td>
</tr>
</tbody>
</table>
Preface

AuthenTec Fingerprint Reader Driver Installation ............................................................... 7-34
BioExcess Fingerprint Reader Driver Installation ............................................................. 7-34
AuthenTec Fingerprint Module Configuration ................................................................. 7-35
Bluetooth & WLAN Combo Module .................................................................................. 7-37
3rd Party Bluetooth (V4.0) Combo Driver Installation ..................................................... 7-38
Intel Bluetooth Combo Driver Installation ....................................................................... 7-38
Bluetooth Configuration in Windows ................................................................................ 7-39
Trusted Platform Module ............................................................................................... 7-42
Enabling & Activating TPM ............................................................................................ 7-43
Trusted Platform Module (TPM) Driver Installation ....................................................... 7-45
Initializing TPM ............................................................................................................. 7-46
Infineon Security Platform Settings Tool ......................................................................... 7-48
Intel® Rapid Storage Technology .................................................................................... 7-56
IRST Driver Installation ................................................................................................ 7-56
Intel® Rapid Storage Technology for RAID Systems ....................................................... 7-57
RAID Volume Data Verification and Repair .................................................................... 7-59
Replacing and Reverting Recovery and Master Volumes ................................................. 7-59
Intel® Rapid Start Technology Driver ............................................................................. 7-62
Intel® Rapid Start Technology Configuration ................................................................. 7-63
Intel® Rapid Start Technology Driver Installation ......................................................... 7-69
Sound Blaster Audio ...................................................................................................... 7-70
Sound Blaster X-Fi MB-3 Audio AP Installation .............................................................. 7-70
## Preface

Wireless Display ........................................................................................................................................7-79  
Wireless Display Configuration ..............................................................................................................7-80  

## Troubleshooting

Overview ...................................................................................................................................................8-1  
Basic Hints and Tips ...............................................................................................................................8-2  
Backup and General Maintenance .............................................................................................................8-3  
Viruses ......................................................................................................................................................8-4  
Upgrading and Adding New Hardware/Software ......................................................................................8-5  
Problems and Possible Solutions ............................................................................................................8-7  

## Interface (Ports & Jacks)

Overview ...................................................................................................................................................A-1  
Ports and Jacks ..........................................................................................................................................A-2  
Card Reader ..............................................................................................................................................A-2  
DC-In Jack ................................................................................................................................................A-2  
DisplayPort / ..........................................................................................................................................A-2  
Mini DisplayPort .....................................................................................................................................A-2  
e-SATA / USB 3.0 Combo Port ..................................................................................................................A-2  
HDMI-Out Port .........................................................................................................................................A-3  
Headphone-Out Jack .................................................................................................................................A-3  
Line-In Jack .............................................................................................................................................A-3  
Microphone-In Jack .................................................................................................................................A-3
Preface

Mini-IEEE 1394a Port ................................................................. A-4
RJ-45 LAN Jack ........................................................................ A-4
S/PDIF-Out Jack ........................................................................ A-4
Security Lock Slot ..................................................................... A-4
USB 2.0/1.1 Ports ...................................................................... A-5
USB 3.0 Port ............................................................................. A-5
Powered USB 3.0 Port ............................................................ A-5

Control Center

Overview .................................................................................. B-1
Power Modes ........................................................................... B-2
Control Center Menus ............................................................... B-3
Power Status (System Program) / ........................................... B-4
Brightness (System Program) ................................................... B-4
Volume (System Program) ......................................................... B-4
Power Conservation (System Program) ..................................... B-4
Sleep Button (System Program) ................................................ B-5
Display Switch (System Program) ............................................ B-5
Time Zone (System Program) .................................................. B-5
Desktop Background (System Program) ................................. B-5
TouchPad/PC Camera (Device) ............................................... B-5
Caps Lock/Scroll Lock/ Number Lock/Airplane Mode ............ B-5
| Preface |
|-----------------------------------------------|---|
| Left Windows Key (Gaming)                     | B-6 |
| Fan Speed (Gaming)                            | B-6 |
| Headphone (Gaming)                            | B-6 |
| Backlight Keyboard (Gaming)                   | B-6 |

**Video Driver Controls**

<table>
<thead>
<tr>
<th>Overview</th>
<th>C-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Hybrid Graphics</td>
<td>C-2</td>
</tr>
<tr>
<td>Video Driver Installation</td>
<td>C-4</td>
</tr>
<tr>
<td>Video (VGA)</td>
<td>C-4</td>
</tr>
<tr>
<td>NVIDIA Video (VGA)</td>
<td>C-4</td>
</tr>
<tr>
<td>Intel® HD Graphics Control Panel</td>
<td>C-5</td>
</tr>
<tr>
<td>Display Devices &amp; Options</td>
<td>C-20</td>
</tr>
<tr>
<td>Attaching Other Displays</td>
<td>C-21</td>
</tr>
<tr>
<td>Attaching Other Displays - Devices (Charms Bar)</td>
<td>C-24</td>
</tr>
<tr>
<td>Configuring an External Display In Windows</td>
<td>C-25</td>
</tr>
<tr>
<td>HDMI Audio Configuration</td>
<td>C-27</td>
</tr>
<tr>
<td>NVIDIA Control Panel</td>
<td>C-30</td>
</tr>
<tr>
<td>Customization Options</td>
<td>C-32</td>
</tr>
<tr>
<td>Set PhysX® Configuration</td>
<td>C-36</td>
</tr>
</tbody>
</table>

**Specifications**

| Processor                                     | D-2 |
Preface

Core Logic .................................................................................................................................................. D-2
Memory ...................................................................................................................................................... D-2
Display ...................................................................................................................................................... D-2
Video Adapter Options ............................................................................................................................. D-3
Storage ....................................................................................................................................................... D-3
BIOS ......................................................................................................................................................... D-3
Audio ....................................................................................................................................................... D-3
Keyboard & Pointing Device ..................................................................................................................... D-4
Indicators .................................................................................................................................................. D-4
Interface .................................................................................................................................................... D-4
Security ..................................................................................................................................................... D-4
Slots .......................................................................................................................................................... D-4
Card Reader ............................................................................................................................................. D-4
Communication ......................................................................................................................................... D-4
Operating System .................................................................................................................................... D-5
Features ................................................................................................................................................... D-5
Power Management ................................................................................................................................. D-5
Power ......................................................................................................................................................... D-5
Environmental Spec ............................................................................................................................... D-5
Physical Dimensions & Weight ................................................................................................................ D-5
Chapter 1: Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the computer and to getting your system started. The remainder of the manual covers the following:

- **Chapter 2** A guide to using some of the main features of the computer e.g. the storage devices (hard disk, optical device, card reader), TouchPad & Mouse & Audio Features.
- **Chapter 3** The computer’s power management options.
- **Chapter 4** The installation of the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems.
- **Chapter 5** An outline of the computer’s built-in software or BIOS (Basic Input Output System).
- **Chapter 6** Instructions for upgrading your computer.
- **Chapter 7** A quick guide to the computer’s PC Camera, Wireless LAN, Fingerprint, Bluetooth & WLAN Combo, Sound Blaster Audio and Intel modules (some of which may be optional depending on your purchase configuration).
- **Chapter 8** A troubleshooting guide.
- **Appendix A** Definitions of the interface, ports/jacks which allow your computer to communicate with external devices.
- **Appendix B** Information on the Control Center.
- **Appendix C** Information on the Video driver controls.
- **Appendix D** The computer’s specification.
Quick Start Guide

Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful to refer to “Drivers & Utilities” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on page 6 - 1 in the User’s Manual. You may also find the notes marked with a of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then the information contained in this Quick Start Guide should be enough to get you up and running. Eventually you should try to look through all the documentation (more detailed descriptions of the functions, setup and system controls are covered in the remainder of the User’s Manual), but do not worry if you do not understand everything the first time. Keep this manual nearby and refer to it to learn as you go. You may find it useful to refer to the notes marked with a as indicated in the margin. For a more detailed description of any of the interface ports and jacks see “Interface (Ports & Jacks)” on page A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the symbol. Also please note the safety and handling instructions as indicated in the Preface.
Not Included

Operating Systems (e.g. Windows 8.1) and applications (e.g. word processing, spreadsheet and database programs) have their own manuals, so please consult the appropriate manuals.

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install the appropriate drivers. Drivers are programs which act as an interface between the computer and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order listed in Table 4 - 1, on page 4 - 3. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If your system hasn’t been properly configured (your service representative may have already done that for you), refer to “Drivers & Utilities” on page 4 - 1 for installation instructions.

Ports and Jacks

See “Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your computer to communicate with external devices, connect to the internet etc.
Quick Start Guide

System Software

Your computer may already come with system software pre-installed. Where this is not the case, or where you are re-configuring your computer for a different system, you will find the *Windows 8.1* operating system is supported.

Windows OS

Note that the information included on the following pages is for *Windows 8.1 only*.

In order to run *Windows 8/8.1 (64 bit)* your computer requires a minimum 2GB of system memory (RAM).
Model Differences

This notebook series includes six different model types that mainly differ as indicated in the table below. Note that your model may appear slightly different from those pictured in this manual.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Model A</th>
<th>Model B</th>
<th>Model C</th>
<th>Model D</th>
<th>Model E</th>
<th>Model F</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPUs Supported</td>
<td>See “Processor” on page D - 2 for more details</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Display Type Supported</td>
<td>15.6” (39.62cm) FHD (1920 * 1080) 16:9 Backlit Panel</td>
<td>17.3” (43.94cm) FHD (1920 * 1080) 16:9 Backlit Panel</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Video Adapters Supported</td>
<td>See “Video Adapter Options” on page D - 3 for more details</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Keyboard LED</td>
<td>Keyboard LED Supported</td>
<td>Not Supported</td>
<td>Keyboard LED Supported</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Illuminated Touchpad Option</td>
<td>Not Supported</td>
<td>Illuminated Touchpad Option Supported</td>
<td>Not Supported</td>
<td>Illuminated Touchpad Option Supported</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power Supply</td>
<td>AC/DC Adapter – (180 Watts)</td>
<td>AC/DC Adapter – (120 Watts)</td>
<td>AC/DC Adapter – (230 Watts)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dimensions &amp; Weight</td>
<td>See “Physical Dimensions &amp; Weight” on page D - 5 for more details</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 1 - 1 - Model Differences
System Startup

1. Remove all packing materials, and place the computer on a stable surface.
2. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
3. Attach the AC/DC adapter to the DC-In jack at the rear of the computer, then plug the AC power cord into an outlet, and connect the AC power cord to the AC/DC adapter.
4. Use one hand to raise the lid/LCD to a comfortable viewing angle (it is preferable not to exceed 135 degrees); use the other hand (as illustrated in Figure 1 - 1 below) to support the base of the computer (Note: Never lift the computer by the lid/LCD).
5. Raise the lid/LCD to a comfortable viewing angle, and press the power button on the top left of the computer for about 2 - 3 seconds to turn the computer “on” (note that the power LED on the front of the computer will turn from orange to green when the computer powers on).

Shutdown

Note that you should always shut your computer down by choosing the Shut Down command in Windows (see page 1 - 49). This will help prevent hard disk or system problems.

Figure 1 - 1 - Computer with AC/DC Adapter Plugged-In/Opening the Lid/LCD
Quick Start Guide

LCD Panel Open - Models A, C & D

1. Built-In PC Camera
2. PC Camera LED
3. Built-In Microphone
4. LCD
5. Speakers
6. Power Button
7. LED Lock Indicators
8. LED Status Indicators
9. Keyboard (Model A supports an Illuminated Keyboard)
10. TouchPad and Buttons
11. Fingerprint Reader (Optional)

Note that the keyboard for Models A, C & D are different, and only Model A is pictured (see Table 1 - 1, on page 1 - 5).

Note that the Touchpad and Buttons has a valid operational area indicated within the red dotted lines above.
Quick Start Guide

Figure 1 - 3
LCD Panel Open
Model B

1. Built-In PC Camera
2. PC Camera LED
3. Built-In Microphone
4. LCD
5. Speakers
6. Power Button
7. LED Indicators
8. Illuminated Keyboard
9. Illuminated Touchpad and Buttons
10. Fingerprint Reader (Optional)

Note that the Illuminated Touchpad has a defined valid operational area of sensitivity indicated within the sensor area of the illustration below. See “Illuminated Touchpad Sensitivity” on page 2 - 12.
LCD Panel Open - Model E

1. Built-In PC Camera
2. PC Camera LED
3. Built-In Microphone
4. LCD
5. Speakers
6. LED Indicators
7. Power Button
8. Illuminated Keyboard
9. TouchPad and Buttons
10. Fingerprint Reader (Optional)

Note that the Touchpad and Buttons has a valid operational area indicated within the red dotted lines above.
Quick Start Guide

LCD Panel Open - Model F

1. Built-In PC Camera
2. PC Camera LED
3. Built-In Microphone
4. LCD
5. Speakers
6. LED Indicators
7. Power Button
8. Illuminated Keyboard
9. TouchPad and Buttons
10. Fingerprint Reader (Optional)

Note that the Illuminated Touchpad has a defined valid operational area of sensitivity indicated within the sensor area of the illustration below. See...
**LED Indicators**

The LED indicators display helpful information about the current status of the computer.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Lock Icon]</td>
<td>Blue / White</td>
<td>Number Lock is Activated</td>
<td>![Battery Icon]</td>
<td>Orange</td>
<td>The Battery is Charging</td>
</tr>
<tr>
<td>![Lock Icon]</td>
<td>Blue / White</td>
<td>Caps Lock is Activated</td>
<td>![Battery Icon]</td>
<td>Blinking Orange</td>
<td>The Battery has Reached Critically Low Power Status</td>
</tr>
<tr>
<td>![Lock Icon]</td>
<td>Blue / White</td>
<td>Scroll Lock is Activated</td>
<td>![Battery Icon]</td>
<td>Green</td>
<td>The Battery is Fully Charged</td>
</tr>
<tr>
<td>![Lock Icon]</td>
<td>Blue / White</td>
<td>Hard Disk Activity</td>
<td>![Battery Icon]</td>
<td>Orange</td>
<td>AC/DC Power is Plugged In</td>
</tr>
<tr>
<td>![Lock Icon]</td>
<td>Blue / White</td>
<td><strong>Airplane Mode is ON</strong> (the WLAN &amp; Bluetooth Modules are OFF)</td>
<td>![Battery Icon]</td>
<td>Blinking Orange*</td>
<td>The Powered USB Port is On (see “USB 3.0 Ports &amp; Powered USB 2.0 Port” on page 1 - 28)</td>
</tr>
<tr>
<td>![Lock Icon]</td>
<td>Blue / White</td>
<td>Integrated GPU (iGPU) Activated</td>
<td>![Battery Icon]</td>
<td>Green</td>
<td>The Computer is On</td>
</tr>
<tr>
<td>![Lock Icon]</td>
<td>Blue / White</td>
<td>Discrete GPU (dGPU) Activated</td>
<td>![Battery Icon]</td>
<td>Blinking Green</td>
<td>The Computer is in Sleep Mode</td>
</tr>
</tbody>
</table>

**Wireless Device Operation Aboard Aircraft**

The use of any portable electronic transmission devices (e.g. WLAN or Bluetooth) aboard aircraft is usually prohibited. Make sure any wireless modules are OFF (i.e. the system is in **Airplane Mode**) if you are using the computer aboard aircraft.

Use **Fn + F11 Airplane Mode** key combination to toggle Airplane Mode On/Off, and check the LED indicator for the power status.

*Table 1 - 2 - LED Indicators*
Illuminated LED Keyboard - Models A, B, E & F

The illuminated keyboard has an embedded numerical keypad for easy numeric data input, and features function keys to allow you to change operational features instantly. See Table 1 - 7, on page 1 - 22 for full function key combination details.

Figure 1 - 6 - Illuminated LED Keyboard

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters. These special characters can only be produced by using the numeric keypad. Regular number keys (in the upper row of the keyboard) will not work. Make sure that NumLk is on.

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will detect and enable it automatically. However special functions/hot-keys unique to the system’s regular keyboard may not work.

Num Lk & Scr Lk

Hold down the Fn Key and Scr Lk/Num Lk to enable scroll lock/number lock, and check the LED indicator for status.
Keyboard LED - Models A, B, E & F

Press **Fn** plus the key to toggle the keyboard LED on/off. The keyboard LED may be configured using the **Fn + key combination** outlined in the table below. In addition press **Fn** plus the key to launch the keyboard backlight application to configure the settings.

<table>
<thead>
<tr>
<th>Main Keyboard LED Function key Combinations</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Fn +</strong></td>
</tr>
<tr>
<td>1 Launch the Keyboard Backlight Application</td>
</tr>
<tr>
<td>2 Toggle the Keyboard Backlight On/Off</td>
</tr>
<tr>
<td>3 Keyboard LED Illumination Decrease</td>
</tr>
<tr>
<td>(see <em>Table 1 - 5, on page 1 - 17</em>)</td>
</tr>
<tr>
<td>4 Keyboard LED Illumination Increase</td>
</tr>
<tr>
<td>(see <em>Table 1 - 5, on page 1 - 17</em>)</td>
</tr>
</tbody>
</table>

*Table 1 - 3 - Main Keyboard LEDs*
The combination of the **Fn** key and numerical keypad keys listed below allow you to turn the LED on/off for parts of the keyboard, and the touchpad (if applicable).

<table>
<thead>
<tr>
<th>Keyboard LED Section Function key Combinations</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Fn + 7</strong></td>
</tr>
<tr>
<td><strong>Fn + 8</strong></td>
</tr>
<tr>
<td><strong>Fn + 9</strong></td>
</tr>
<tr>
<td><strong>Fn + 5</strong></td>
</tr>
</tbody>
</table>

*Table 1 - 4 - Keyboard LED Section Function Key Combinations*
Keyboard Backlight Application (Models A, B, E & F)
The Keyboard Backlight application can be accessed by pressing the **Fn** plus ⌘ key (or by clicking the button in the Gaming section of the Control Center).

![Keyboard Backlight Application](image)

*Figure 1 - 7 - Keyboard Backlight Application*
Quick Start Guide

Brightness
Click on any of the numbers (0 - 3) on the brightness bar to set the brightness level of the keyboard backlight.

Color Swatch
The color swatch in the top right of the screen allows you to select a range of colors for your keyboard backlight by clicking on the color required. You can choose to display the swatch either in Full Color or as a 8 Color Scheme (note that if your system features an illuminated Touchpad it can be only configured in 8 colors). Click the Custom mode button to select any colors from the swatch and to apply your chosen colors to parts of the keyboard (and touchpad if applicable).
Modes
The buttons surrounding the swatch allow you to alter the effects of the keyboard backlight. Click on any of the buttons to view the effects on the keyboard. Click **Save** when exiting the application to retain the setting.

<table>
<thead>
<tr>
<th>Mode Buttons</th>
<th>Wave Up/Down</th>
<th>Dancing Effect</th>
<th>Tempo Beat</th>
<th>Flashing</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Random Color" /></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Custom - Display &amp; Configure" /></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Breathe (All Colors)" /></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Cycle Colors" /></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Illumination Keys**

Note that the keyboard illumination (increase/decrease) keys may be used to configure the keyboard LED in **Custom Mode** only.

**Table 1 - 5 - Mode Buttons**
Quick Start Guide

Preview
The bottom left section of the application allows you to preview setting changes made to colors on the keyboard and touchpad (if applicable).

Figure 1 - 8 - Preview

Keyboard (and Touchpad) Sections
The bottom right section of the application allows you to select partial areas, or all, of the keyboard (and touchpad if applicable) on which to apply the color changes and effects.

Figure 1 - 9 - Keyboard Sections
Sets
The application allows you to save up to 3 sets of color and effect combinations. Click **Save** when exiting the application to retain the settings.

![Sets](image)

**Figure 1 - 10 - Sets**

Save & Exit
Click **Exit** to quit the application without saving, or **Save** to exit and retain the settings.

![Save & Exit](image)

**Figure 1 - 11 - Save & Exit**
Keyboard - Models C & D

The keyboard has an embedded numerical keypad for easy numeric data input, and features function keys to allow you to change operational features instantly. See Table 1 - 7, on page 1 - 22 for full function key combination details.

Other Keyboards
If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will detect and enable it automatically. However special functions/hot-keys unique to the system’s regular keyboard may not work.

Num Lk & Scr Lk
Hold down the Fn Key and Scr Lk/Num Lk to enable scroll lock/number lock, and check the LED indicator for status.

Special Characters
Some software applications allow the number-keys to be used with Alt to produce special characters. These special characters can only be produced by using the numeric keypad. Regular number keys (in the upper row of the keyboard) will not work. Make sure that NumLk is on.
Keyboard Shortcuts

The following Windows Logo Key (Winkey) keyboard shortcuts are useful for navigation/operation in *Windows 8.1*.

<table>
<thead>
<tr>
<th>Windows Logo Key +</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap Winkey</td>
<td>Toggle between the <em>Start</em> screen and the foremost running app or the <em>Windows Desktop</em></td>
</tr>
<tr>
<td>C</td>
<td>Display <em>Charms</em> menu</td>
</tr>
<tr>
<td>D</td>
<td>Switch to the <em>Windows Desktop</em> and toggle show Desktop</td>
</tr>
<tr>
<td>E</td>
<td>Switch to the Windows desktop and launch <em>Windows Explorer</em> with <em>Computer</em> displayed</td>
</tr>
<tr>
<td>F</td>
<td>Display file <em>Search</em></td>
</tr>
<tr>
<td>I</td>
<td>Open the <em>Settings</em> charm</td>
</tr>
<tr>
<td>K</td>
<td>Open the <em>Connect</em> charm</td>
</tr>
<tr>
<td>L</td>
<td>Lock the computer and display the <em>Lock screen</em></td>
</tr>
<tr>
<td>P</td>
<td>Display the <em>Second Screen</em> menu (see Figure 1 - 37 on page 1 - 48)</td>
</tr>
<tr>
<td>R</td>
<td>Switch to the <em>Windows Desktop</em> and display the <em>Run</em> dialog box</td>
</tr>
<tr>
<td>Z</td>
<td>Access the <em>Customize Bar</em> (see Figure 1 - 29 on page 1 - 39)</td>
</tr>
</tbody>
</table>

*Table 1 - 6 - Keyboard Shortcuts*
## Function Keys & Visual Indicators

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the **Fn** key is held down.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function/Visual Indicators</th>
<th>Keys</th>
<th>Function/Visual Indicators</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fn + !1</td>
<td>Fan Control Toggle Automatic / Full Power</td>
<td>Fn + Esc</td>
<td>Control Center Toggle (see over)</td>
</tr>
<tr>
<td>Fn + $</td>
<td>Play/Pause (in Audio/Video Programs)</td>
<td>Fn + F7</td>
<td>Display Toggle</td>
</tr>
<tr>
<td>Fn + !F1</td>
<td>Touchpad Toggle</td>
<td>Fn + !F6 !F8 !F9</td>
<td>Brightness Decrease/Increase</td>
</tr>
<tr>
<td>Fn + !F2</td>
<td>Turn LCD Backlight Off (Press a key to or use Touchpad to turn on)</td>
<td>Fn + !F10</td>
<td>PC Camera Power Toggle</td>
</tr>
<tr>
<td>Fn + !F3</td>
<td>Mute Toggle</td>
<td>Fn + !F11</td>
<td>Airplane Mode Toggle</td>
</tr>
<tr>
<td>Fn + !F4</td>
<td>Sleep Toggle</td>
<td>Fn + Power Button</td>
<td>Powered USB 3.0 Port Power Toggle</td>
</tr>
<tr>
<td>Fn + !F5 !F6</td>
<td>Volume Decrease/Increase</td>
<td>Fn + !F12</td>
<td>Keyboard LED (Models A, B, D &amp; E) Toggle</td>
</tr>
</tbody>
</table>

*Table 1-7 - Function Keys & Visual Indicators*
Control Center

When in the **Windows Desktop application** (not in the **Start** screen) press the **Fn + Esc** key combination, or **double-click the icon** in the **notification area of the taskbar** to toggle the **Control Center** on/off. The **Control Center** gives quick access to frequently used controls and enables you to quickly turn the camera/Touch Pad on/off (see **Appendix B** for full details).

![Control Center Access](image)

To run the Control Center press the **Fn + Esc** key combination, or double-click the icon in the notification area of the taskbar.

Close the Control Center by clicking the close icon in the top right of the panel (move the cursor onto the top right corner of the panel to highlight it).

*Figure 1 - 13 - Control Center*
Front & Rear Views (Models A, B, C & D)

1. LED Power Indicators
2. Vent/Fan Intake
3. Display Port
4. HDMI-Out Port
5. Mini Display Port
6. DC-In Jack

HDMI Port

Note that the HDMI Port supports video and audio signals to attached external displays (see “HDMI Audio Configuration” on page C - 27).

Note that Sound Blaster X-Fi MB3 audio will be disabled when you are connecting to an external display through an HDMI connection.
Front & Rear Views (Models E & F)

1. LED Power Indicators
2. Vent/Fan Intake
3. Display Port
4. HDMI-Out Port
5. Mini Display Port
6. DC-In Jack
7. Security Lock Slot

Note that the HDMI Port supports video and audio signals to attached external displays (see “HDMI Audio Configuration” on page C - 27).

Note that Sound Blaster X-Fi MB3 audio will be disabled when you are connecting to an external display through an HDMI connection.
Figure 1 - 16

Right View

1. Optical Device Drive Bay
2. Headphone Jack
3. Microphone Jack
4. S/PDIF-Out Jack
5. Line-In Jack
6. 1 * USB 2.0 Port
7. Security Lock Slot (Models A, C & D Only)

USB Ports

Note that the connections to the USB ports only fit one way, do not force them.

USB 3.0 ports are denoted by their blue color; USB 2.0 ports are colored black.
Left View

Models A, C & D
1. Mini-IEEE 1394a Port
2. RJ-45 LAN Jack
3. 1 * Powered USB 3.0 Port
4. 1 * USB 3.0 Port
5. Combined eSATA/ USB 3.0 Port
6. Multi-in-1 Card Reader

Model B

Model E

Model F

Figure 1 - 17
Left View

1. Mini-IEEE 1394a Port
2. RJ-45 LAN Jack
3. 1 * Powered USB 3.0 Port
4. 1 * USB 3.0 Port
5. Combined eSATA/ USB 3.0 Port
6. Multi-in-1 Card Reader

Mini-IEEE 1394a Port

The Mini-IEEE 1394a port only supports SELF POWERED IEEE 1394 devices.
Quick Start Guide

USB 3.0 Ports & Powered USB 2.0 Port

USB 3.0 ports are denoted by their blue color; USB 2.0 ports are colored black. Note that the USB 3.0 port is not operational under DOS and does not support wake on USB. The **powered USB 3.0** (in Figure 1 - 17 on page 1 - 27) port can supply power (**for charging devices only, not for operating devices**) when the system is off but still powered by the AC/DC adapter plugged into a working outlet, or powered by the battery with a capacity level above 20% (this may not work with certain devices - see page 8 - 12). Toggle power to this port by using **Fn + power button**.

Multi-in-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:

- MMC (MultiMedia Card) / RSMMC
- SD (Secure Digital) / Mini SD / SDHC / SDXC
- MS (Memory Stick) / MS Pro / MS Duo
Bottom View - Models A, C & D

Figure 1 - 18
Bottom View

1. Sub Woofer
2. Fan Outlet/Intake
3. Component Bay Cover
4. HDD Bay
5. Battery

Battery Information
Always completely discharge, then fully charge, a new battery before using it. Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges. See “Battery Information” on page 3 - 14 for full instructions.

Overheating
To prevent your computer from overheating make sure nothing blocks the vent(s)/fan intake(s) while the computer is in use.
1. Sub Woofer
2. Fan Outlet/Intake
3. Component Bay Cover
4. HDD/ODD Bay
5. Battery

Overheating
To prevent your computer from overheating make sure nothing blocks the vent(s)/fan intake(s) while the computer is in use.

Battery Information
Always completely discharge, then fully charge, a new battery before using it. Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges. See “Battery Information” on page 3 - 14 for full instructions.
Bottom View - Model E

1. Sub Woofer
2. Fan Outlet/Intake
3. Component Bay Cover
4. Primary HDD Bay
5. Secondary HDD Bay
6. Battery

Battery Information
Always completely discharge, then fully charge, a new battery before using it. Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges. See “Battery Information” on page 3 - 14 for full instructions.

Overheating
To prevent your computer from overheating make sure nothing blocks the vent(s)/fan intake(s) while the computer is in use.
Quick Start Guide

Bottom View - Model F

Figure 1 - 21
Bottom View

1. Sub Woofer
2. Fan Outlet/Intake
3. Component Bay Cover
4. Primary HDD Bay
5. Secondary HDD Bay
6. Battery

Overheating
To prevent your computer from overheating make sure nothing blocks the vent(s)/fan intake(s) while the computer is in use.

Battery Information
Always completely discharge, then fully charge, a new battery before using it. Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges. See “Battery Information” on page 3 - 14 for full instructions.
Windows 8.1 Control Panel

Throughout this manual you will see an instruction to open the Control Panel. Right-click the lower left hot corner to bring up the context menu (or use the Windows Logo Key + X key combination) and select Control Panel in both the Desktop app or Start screen.

Figure 1 - 22 - Windows Context Menu

Windows Versions

Note that the information included on the following pages is for Windows 8.1 only.

The Windows 8 interface is slightly different in appearance and in methods of navigation, and a separate manual is provided on the Device Drivers & Manual Disc with reference to Windows 8.
Right-click the **Start button** in the **Desktop** app (or use the **Windows Logo Key + X** key combination) to bring up an advanced context menu of useful features such as Control Panel, Programs and Features, Power Options, Task Manager, Search, File Explorer, Command Prompt, Device Manager and Network Connections etc.

![Advanced Context Menu (Right-Click Start Button)](image)

*Figure 1 - 23 - Advanced Context Menu (Right-Click Start Button)*
In many instances throughout this manual you will see an instruction to open the Control Panel. The Control Panel can be accessed in a number of ways in Windows 8.1.

- Click Search in the Windows Charms Bar (see previous page) and the search pane will pop out. Type Control Panel and select it from the results to the left.

- Click on This PC (in Apps, or you can to pin This PC to the Start screen), click on Computer in the top menu and select Open Control Panel from the ribbon.
Quick Start Guide

• When in the Desktop app (this does not apply to the Start screen) click on Settings in the Windows Charms Bar and select Control Panel from the menu.

![Settings Charms Bar (Desktop App Only)](image)

*Figure 1 - 26 - Settings Charms Bar (Desktop App Only)*

• Click the arrow at the bottom of the Start screen and click Control Panel in Apps (Windows System).

![All Apps - Control Panel](image)

*Figure 1 - 27 - All Apps - Control Panel*
• Right-click the Start button to bring up the menu and select Control Panel (see Figure 1 - 23 on page 1 - 34).

Although the Control Panel can be opened through the menu, you can also use keyboard shortcuts to access the Control Panel. Press the Windows logo key and X to bring up the context menu, and then press P to bring up the Control Panel. Alternatively press the Windows logo key and R to bring up the Run dialog box, and then type “Control Panel” and press Enter to access the Control Panel.
Quick Start Guide

Windows 8.1 Start Screen & Desktop

The Apps, control panels, utilities and programs within Windows are accessed from the Start screen and/or Windows Desktop app. The Desktop (which runs as an app within the Start screen) can be accessed by clicking the Desktop item in the Start screen (or by using the Windows Logo Key + D key combination). Click the arrow at the bottom of the Start screen to access Apps.

Figure 1 - 28 - Windows Start Screen
Apps & Tiles
The Start screen will contain a number of apps, and many more will be installed as you add more applications etc. Not all of these apps can fit on one screen so you will often need use the slider at the bottom of the screen in order to view all the necessary Apps.

Accessing Pinning/Unpinning All Apps
You can add and remove the tiles for apps and control panels in the Start screen. Right-click on a blank area of the Start screen, and you will see the Customize icon. Click the Customize icon to display all the installed applications etc. Right-click any icon to bring up the menu at the bottom of the screen and you can then click the appropriate icon to pin the App to (or unpin from) the Start screen, or to the taskbar in the Desktop application (you can also open the app in a new window, run as administrator or open the file location).

Figure 1 - 29 - Customize Apps
Quick Start Guide

Desktop Application

When the Desktop app is running (click the app in the Start screen or use the Windows Logo Key + D key combination) you can use lower left hot corner to switch between the Start screen and the Windows Desktop app. To do so move your mouse to hover over the bottom left corner of the Desktop app and left-click.

When you move to the lower left hot corner in the Start screen it will take you back to your most recently used app (if one is running).

![Move the mouse to the bottom left of the screen and click to switch back to the Start screen.](image)

Figure 1 - 30 - Desktop
The Charms Bar
The right side of the screen displays the Charms Bar. The Charms Bar contains the Search, Share, Start, Devices and Settings menus. To access up the Charms Bar move the cursor to the upper or lower right corners of the screen, and then hover over one of the items in the Charms Bar to activate it (the bar will be black when it is active), or use the Windows Logo Key + C key combination.

*Figure 1 - 31 - Start Screen with Charms Bar*
Quick Start Guide

Charms Bar Items

- **Search**: You can search for any file, application, Apps and control panel settings with instantaneous results.
- **Share**: This button is used to share information with people via mail or social networks.
- **Start**: Click to bring up the Start screen (the same function as pressing the Windows Logo Key or clicking the bottom left of the screen).
- **Devices**: Click this button to change connected peripheral device settings e.g. an external display.
- **Settings**: This button gives instant access to the computer settings, such as Network, Audio, Notifications, Power and Keyboard (click **Change PC Settings** to activate the PC Settings menu).

![Charms Bar - TouchPad Access](image)

**Charms Bar - TouchPad Access**

To quick access the Charms Bar using the TouchPad:

1. Place your finger off the TouchPad (slightly to the right of the pad resting on the computer).
2. Move your finger across to the left on to the TouchPad.
3. The Charms Bar will then pop-up.

*Figure 1 - 32 - Settings Menu*
Windows 8.1 Taskbar

In many instances throughout this manual you will see an instruction to access the notification area of the taskbar (system tray). In *Windows 8.1* the taskbar is accessed from the Desktop application; if you are in the Start screen you will need to switch to the Desktop.

The taskbar is displayed at the bottom of the Desktop screen, and you can see the notification area (system tray) of the taskbar in the bottom right of the screen. Some of the control panels and applications referred to during the course of this manual can be accessed from here.

![Figure 1 - 33: Desktop Taskbar & Notification Area (System Tray)](image)

You can pin/unpin apps to/from the taskbar in much the same way as you can to the Start screen (see “Accessing Pining/Unpinning All Apps” on page 1 - 39).
Quick Start Guide

Video Features
You can switch display devices, and configure display options, from the Display control panel (in Appearances and Personalization) in Windows 8 when running the Desktop app (see “Desktop Application” on page 1-40).

Microsoft Hybrid Graphics
Your computer will feature Microsoft Hybrid Graphics switchable graphics technology. This seamless technology is designed to get best performance from the graphics system while allowing longer battery life, without having to manually change settings. The computer will automatically switch between the integrated UMA (Unified Memory Architecture) GPU (iGPU) and the discrete GPU (dGPU) when required by the applications in use. This switch is seamless to the user (see Appendix C).

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Off</td>
<td>Integrated GPU (iGPU) Activated</td>
</tr>
<tr>
<td></td>
<td>Blue/White</td>
<td>Discrete GPU (dGPU) Activated</td>
</tr>
</tbody>
</table>

Table 1 - 8 - GPU Mode LED Indicator
To access Display (Control Panel) and Screen Resolution in Windows:
1. Go to the Control Panel.
2. Click Display (icon) - In the Appearance and Personalization category.
3. Adjust resolution.

Right-Click Desktop App
1. You can right-click the desktop and select Screen resolution (Figure 1 - 34).
2. Use the dropbox to select the screen Resolution (Figure 1 - 34).
3. Click Advanced settings (Figure 1 - 34) to bring up the Advanced properties tabs.

Figure 1 - 34 - Screen Resolution
Quick Start Guide

To access the Intel(R) Graphics Control Panel:
1. Click Advanced settings (Figure 1 - 34 on page 1 - 45) in the Screen Resolution control panel in Windows.
2. Click the Intel(R) tab and click Graphics Properties (button) (Figure 1 - 35 on page 1 - 46).
3. Right-click the desktop and select Graphics Properties from the menu.
4. Click the icon in the notification area of the Desktop taskbar and select Graphics Properties from the menu.
To access the **NVIDIA Control Panel**:  
1. Right-click the desktop and select **NVIDIA Control Panel** *(Figure 1 - 36).*  
   **OR**  
2. Double-click the icon *(Figure 1 - 36)* in the **Windows** control panel.
Quick Start Guide

Configuring External Displays
It is possible to quickly configure external displays from the Devices menu item in the Charms Bar (see “The Charms Bar” on page 1 - 41).

To Configure Displays from Devices (Charms Bar):
1. Attach your display to the appropriate port, and turn it on.
2. Go to the Charms Bar, select Devices.
3. Click Project (you may need to click Second Screen).
4. Click on any one of the options from the menu to select PC screen only, Duplicate, Extend or Second screen only.

Figure 1 - 37 - Devices (Project)
Power Options

Power Options (Hardware and Sound) can be accessed from the Control Panel. The Power Menu item in Settings in the Charms Bar in Windows may be used to Shut down or Restart (you can also add Hibernate/Sleep to the menu - see “Adding Hibernate/Sleep to the Power Menu” on page 3 - 10). You can also use the context menu (Shut down or sign out) shut the computer down/restart etc.

Shut Down, Restart or Sleep (Charms Bar)
1. Go to the Charms Bar and click Settings.
2. Click Power  
3. Select Sleep, Shut Down or Restart.

Figure 1 - 38 - Shut Down/Restart
Running Apps

To run apps in Windows 8.1 you will need to check that the Screen Resolution and User Account Control Settings are compatible with the system requirements.

Screen Resolution Settings
1. Switch to the Windows Desktop (click the app or use the Windows logo key + D key combination).
2. Right-click a blank area of the Windows Desktop and select Screen Resolution. Adjust the Resolution to make sure that it is at least 1024 * 768, although preferably 1366 * 768 or above (see sidebar).

Figure 1 - 39 - Screen Resolution

The minimum resolution in which Apps will run is 1024x768.

The minimum resolution required to support all the features of Windows 8 (including multitasking with snap) is 1366x768.

These specs are the minimum screen resolution that supports all the features of Windows 8.1 on a useful physical size.
User Account Control Settings

If your computer meets the minimum screen resolution requirements, and still you can't run apps, then that you have to check the status of **User Account Control** (UAC). Apps may fail to open when the UAC is turned off. To check whether the UAC is on or off, follow the instructions below.

1. Open the **Control Panel**.
2. Click on **User Accounts** and then click on **Change User Account Control settings** (or click **System and Security** and click **Change User Account Control Settings** under **Action Center**).
3. If the slider is in the **Never notify** position, then the UAC is disabled.
4. To enable or turn on the UAC, move the slider to **Always notify** or **Notify me when apps try to make changes to my computer (default)** position, and then click **OK**.

*Figure 1 - 40 - User Account Control*
Chapter 2: Storage Devices, Mouse, & Audio

Overview

Read this chapter to learn more about the following main features and components of the computer:

- Hard Disk Drive
- Optical Device
- Multi-in-1 Card Reader
- Audio Features
- Touchpad and Buttons/Mouse
Storage Devices, Mouse, & Audio

Hard Disk Drive

The hard disk drive(s) is used to store your data in the computer. The hard disks can be taken out to accommodate other 2.5” serial (SATA) hard disk drives with a height of 9.5 mm. The primary hard disk bay is accessible from the bottom of your computer as seen below.

Further details on removing and inserting the hard disk are available in “Upgrading the Hard Disk Drive(s)” on page 6 - 10.

Some models feature a primary and secondary hard disk bay (you may have a second hard disk installed as part of a RAID). Other models may have a secondary hard disk drive installed in an optional caddy bay.

Figure 2 - 1
Primary Hard Disk Location

Power Safety

Before attempting to access any of the internal components of your computer please ensure that the machine is not connected to the AC power, and that the machine is turned off. Also ensure that all peripheral cables, including phone lines, are disconnected from the computer.
Storage Devices, Mouse, & Audio

Optical Device

There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual device will depend on the model you purchased (see “Storage” on page D - 3). The optical device is usually labeled “Drive D:” and may be used as a boot device if properly set in the BIOS (see “Boot Menu” on page 5 - 17).

Loading Discs

To insert a CD/DVD, press the open button 1 and carefully place a CD/DVD onto the disc tray with label-side facing up (use just enough force for the disc to click onto the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you are ready to start. The busy indicator 2 will light up while data is being accessed, or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupted, insert an object such as a straightened paper clip into the emergency eject hole 3 to open the tray.

Sound Volume Adjustment

How high the sound volume can be set depends on the setting of the volume control within Windows. Click the Volume icon on the notification area to check the setting.

Peripherals must be connected before you turn on the system.

Figure 2 - 2
Optical Device
Handling CDs or DVDs

Proper handling of your CDs/DVDs will prevent them from being damaged. Please follow the advice below to make sure that the data stored on your CDs/DVDs can be accessed.

Note the following:

- Hold the CD or DVD by the edges; do not touch the surface of the disc.
- Use a clean, soft, dry cloth to remove dust or fingerprints.
- Do not write on the surface with a pen.
- Do not store or place the CD or DVD in high-temperature areas.
- Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
- Do not bend the CD or DVD.
- Do not drop or subject the CD or DVD to shock.
To change the DVD regional codes:

1. Go to the **Control Panel**
2. Double-click **Device Manager (Hardware and Sound)**, then click the + next to DVD/CD-ROM drives.
3. Double-click on the DVD-ROM device to bring up the **Properties** dialog box, and select the **DVD Region** (tab) to bring up the control panel to allow you to adjust the regional code.

- **Region 1** - USA & Canada
- **Region 2** - Western Europe, Japan, South Africa, Middle East & Egypt
- **Region 3** - South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong
- **Region 4** - South & Central America, Mexico, Australia, New Zealand
- **Region 5** - N Korea, Russia, Eastern Europe, India & Most of Africa
- **Region 6** - China
Multi-in-1 Card Reader

The card reader allows you to use some of the latest digital storage cards. Push the card into the slot and it will appear as a removable device, and can be accessed in the same way as your hard disk(s). Make sure you install the Card Reader driver (see “Card Reader” on page 4 - 7).

- MMC (MultiMedia Card) / RSMMC
- SD (Secure Digital) / Mini SD / SDHC / SDXC
- MS (Memory Stick) / MS Pro / MS Duo

Note: Some of these cards require PC adapters that are usually supplied with the cards.

Card Reader Cover

Make sure you keep the cover in the card reader when not in use. This will help prevent foreign objects and/or dust getting in to the card reader.

Push-Push Card Reader

The card reader features a push-in/push-out card insertion and ejection mechanism. Simply push the card to insert and eject it, however Ms Duo cards require an adapter.

Figure 2 - 4
Left View
1. Card Reader

2 - 6 Multi-in-1 Card Reader
Audio Features

You can configure the audio options on your computer from the Sound control panel in Windows, or from the Realtek HD Audio Manager icon in the notification area/control panel (right-click the notification area icon to bring up an audio menu). The volume may also be adjusted by means of the \texttt{Fn + F5/F6} key combination (see Table 1-6, on page 1-21).

Volume Adjustment

The sound volume level is set using the volume control within Windows (and the volume function keys on the computer). Click the volume icon in the notification area to check the setting.

Headphone Configuration

It is recommended that you set the Speaker Configuration to Stereo (not to 5.1 or 7.1 Speaker) when listening through headphones in order to maximize audio quality.

See “HDMI Audio Configuration” on page C-27 for a description of the audio configuration when connecting an HDMI supported display device.

See “Sound Blaster Audio & HDMI” on page 7-78 for more information on the THX TruStudio Pro Audio setup.
Setup for Audio Recording

To record audio sources on your computer at optimum quality follow the instructions below:

1. Click **Control Panel** and make sure you are in **Classic View**.
2. Click **Realtek HD Audio Manager** (or right-click the notification area icon and select **Sound Manager**).
3. Click **Microphone Effects** (tab) in **Microphone** (tab), and then click to select **Noise Suppression** (button), or adjust the **Recording Volume** level to around 60, to obtain the optimum recording quality.
4. Click **OK** to close the control panel and save the settings.
Setup for 5.1 or 7.1 Surround Sound

To setup your system for 5.1 or 7.1 surround sound you will need to connect the audio cables to the Headphone-Out, Line-In, Microphone-In jack and S/PDIF-Out jacks (note: the S/PDIF jack is used for 7.1 surround sound only).

1. Click **Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**) and make sure you are in **Classic View**.
2. Click **Realtek HD Audio Manager** (or right-click the notification area icon and select **Sound Manager**).
3. Click **Speakers** (tab) and click **Speaker Configuration** (tab).
4. Select **5.1 or 7.1 Speaker** from the **Speaker Configuration** pull-down menu.

Sound Blaster Audio & HDMI

Note that the Sound Blaster audio effects do not apply to audio generated through an HDMI connection (see page 7 - 70).

Figure 2 - 7
Speaker Configuration (7.1)
5. Plug the **front speaker** cables into the **Headphone-Out Jack**.
6. Plug in the other cables (you may require an adapter to connect each cable to the appropriate jack e.g. a stereo mini to dual RCA adapter) from your speakers as follows:
   - Line-In Jack = Rear Speaker Out
   - Microphone-In Jack = Center/Subwoofer Speaker Out
   - S/PDIF-Out Jack = Side Speaker Out (**for 7.1 Surround Sound Only**)
7. As you plug in each cable a dialog box will pop up (see “**Auto Popup Dialog**” on page 2 - 9).
8. Click to put a check in the appropriate box according to the speaker plugged-in (e.g. Rear Speaker Out), and then click **OK** to save the setting.
9. Click **OK** to exit **Realtek HD Audio Manager**.

**Figure 2 - 8**
**Connected Device Auto Popup**

*Note: Side Speaker Out is required for 7.1 Surround only.*

---

**2 - 10 Audio Features**
Touchpad and Buttons/Mouse

The Touchpad is an alternative to the mouse; however, you can also add a mouse to your computer through one of the USB ports. The Touchpad buttons function in much the same way as a two-button mouse.

The Touchpad driver installed on your system will be dependent on your computer model. See overleaf for Touchpad sensitivity information, and see the pages indicated below for configuration information.

- See pages 2 - 13 to 2 - 17 for Touchpad information for driver version 1.
- See pages 2 - 18 to 2 - 27 for Touchpad information for driver version 2.

Mouse Driver

If you are using an external mouse your operating system may be able to auto-configure your mouse during its installation or only enable its basic functions. Be sure to check the device's user documentation for details.
Illuminated Touchpad Sensitivity

Note that the illuminated Touchpad (Models B & F) has a defined valid operational area of sensitivity indicated within the sensor area of the illustration below:

- **Model B Computers** - 4 mm from the top/bottom of the touchpad edges, and 5 mm from the left/right sides of the touchpad.
- **Model F Computers** - 5 mm from the top of the touchpad edges, and 5 mm from the left/right sides of the touchpad.

The standard Touchpad (featured in Model A, C, D & E computers) also have a valid operational area is that indicated within the red dotted lines above.
Storage Devices, Mouse, & Audio

Touchpad Configuration for Driver Version 1

Once you have installed the TouchPad driver (see “Touchpad” on page 4 - 7) you can configure the functions from the Mouse control panel in Windows, or by double-clicking the TouchPad driver icon in the notification area of the taskbar in the Desktop app. You may then configure the TouchPad tapping, buttons, scrolling, pointer motion and sensitivity options to your preferences. You will find further information at www.synaptics.com.

TouchPad Scrolling
This computer model series may feature different TouchPad versions.

These TouchPads may differ in their vertical scrolling function in most scrollable windows.

Some TouchPads require sliding the finger up and down on the right of the TouchPad to scroll the window. Other versions require tapping/holding down the finger at the top right or bottom right of the TouchPad to scroll the window.

Figure 2 - 10
Mouse Properties
Gestures and Device Settings

The Synaptics Gestures Suite application allows you to use a specific gesture (action) on the surface of the Touchpad to perform specific actions to manipulate documents, objects and applications.

You can configure the settings from the Device Settings tab in Mouse Properties:

1. Go to the Control Panel.
2. Click Mouse (Hardware and Sound).
3. Click Device Settings (tab) and click Settings.
4. Use the menu tree on the left to access the user configurable settings.

For more details on any of the gestures see the help in the lower part of the right menu window.
Disabling the Touchpad
If you need to disable the Touchpad for any reason (e.g. you may find that when using the computer’s internal keyboard you accidentally trigger the Touchpad when resting your wrists or palms on it) you can do so by using **Fn + F1** key combination.

You can also set the system to automatically disable the internal Touchpad when an external USB point device (e.g a USB mouse) is attached.

1. Go to the **Mouse Properties** control panel.
2. Click to select **Device Settings** (tab).
3. Click to place a check in the “**Disable internal pointing device when external USB pointing device is attached**” check box.
4. Click **OK** to save the setting.

![Figure 2 - 12 Mouse Properties (Disable Touchpad)](image-url)
Storage Devices, Mouse, & Audio

2 - 16 Touchpad Configuration for Driver Version 1

Scrolling
The Two-Finger scrolling feature works in most scrollable windows and allows you to scroll horizontally and vertically. Place two fingers, slightly separated, on the TouchPad surface and slide both fingers in the direction required (in a straight continuous motion).

Figure 2 - 13
Scrolling Gesture

Zooming
The Pinch Zoom gesture can be used to perform the same function as a scroll wheel in Windows applications that support CTRL + scroll wheel zoom functionality. Place two fingers on the TouchPad (for best results use the tips of the fingers) and slide them apart to zoom in, or closer together to zoom out.

Figure 2 - 14
Zooming Gesture
Rotating
Use the Pivot Rotate gesture to rotate objects (e.g. photos) in 90 degree increments. Place a finger down on the left “target” zone and keep it stationary. Place another finger near the middle of the TouchPad and slide it in a circular motion around the stationary finger (clockwise or counterclockwise) to rotate the object.

Three Finger-Flick/Three Fingers Down (Press)
The Three Finger-Flick gesture may be used to enhance navigation with a variety of applications such as browsing the Internet or scrolling through a photo viewer. The Three Fingers Down gesture may be used to launch user-selectable applications.
Touchpad Configuration for Driver Version 2

Once you have installed the Touchpad driver (see “Touchpad” on page 4-7) you can configure the functions by double-clicking the Touchpad driver icon in the notification area of the Desktop taskbar, or from the Mouse control panel in Windows. You may then configure the Touchpad tapping, buttons, scrolling (see sidebar), pointer motion and sensitivity options to your preferences.

![Figure 2 - 17 Mouse Properties](image-url)
Finger Sensing Pad Configurator

The Finger Sensing Pad Configurator allows you to configure the settings for the Finger Sensing Pad device and software. The left pane in the control panel contains all the configurable items, and you can click the “+” to expand the menu selections.

1. Go to the Control Panel.
2. Click Mouse (Hardware and Sound).
3. Click Finger Sensing Pad (tab) and click Configure.
4. Use the menu tree on the left to access the user configurable settings.

- Configuration

Click Defaults to restore all the factory settings.

Press OK to save the changes and close the configurator.

Click Apply to save changes but remain in the configurator.

Figure 2-18: Finger Sensing Pad Configurator
Disabling the Touchpad

If you need to disable the Touchpad for any reason (e.g. you may find that when using the computer’s internal keyboard you accidentally trigger the Touchpad when resting your wrists or palms on it) you can do so by using \texttt{Fn + F1} key combination.

You can also set the system to automatically disable the internal Touchpad when an external USB pointing device (e.g. a USB mouse) is attached, or while you are typing (see over).

1. Go to the Mouse control panel and click to select 	extit{Finger Sensing Pad} (tab).
2. Click to place a check in the “\textit{Disable pad while external mouse is plugged in}” box.
3. Click OK to save the setting.

\textit{Figure 2 - 19}  
Mouse Detection
You can also enable **Typing Detection** to disable the pad while you are typing. The pad will be disabled while typing is detected, and will be reactivated after a set interval of time when typing is not detected. You can use the slider to adjust the reactivation time for an appropriate interval.

![Figure 2 - 20: Disable Pad While Typing](http://www.sentelic.com)
On-pad Functions
Put a check in the appropriate box to enable the function.

• **On-pad Click** - The same function as a left mouse click.
• **Vertical/Horizontal Scrolling** - This will enable sensing zones on the pad to allow you to touch to enable scrolling.
• **On-pad Click Page Slider** - This will enable sensing zones on the pad to allow you to touch to enable sliding up and down the pad.
• **On-pad Cursor Speed** - Use the slider to adjust the pad pointer speed.
• **Two Finger Scrolling** - You can enable/disable reverse two-finger scrolling (see below) from this item.

**Figure 2 - 21**
Enable Reverse Scrolling Direction

**Traditional or Reverse Scrolling**
With **traditional scrolling**, when you want to scroll up a webpage, you put fingers on the pad and then move upwards. When you want to scroll down, you move your fingers down.

**Reverse scrolling** reverses the process; to make a webpage scroll down, you have to move fingers up on the pad, and to scroll up you move your fingers down.
Gestures
Click **Gestures** and make sure that the **Enable Gestures** check box is clicked. Double-click **Gestures** and then double-click **Tailor-made or Applications** to open the submenu. You can enable/disable and configure any of the **Tailor-made** gestures from these submenus.

You can get a clearer view of the gestures involved by clicking the **Play Video** option for each gesture item.

**Figure 2 - 22**
Finger Sensing Pad - Gestures
Storage Devices, Mouse, & Audio

• **Two Fingers Straight Up/Down** - Place two fingers side by side on the pad, slightly apart. Slide the fingers upwards/downwards in a continuous motion.

![Figure 2 - 23: 2F Straight Up/Down]

• **Two Fingers Straight Right/Left** - Place two fingers side by side on the pad, slightly apart. Slide the fingers right/left in a continuous motion.

![Figure 2 - 24: 2F Straight Right/Left]

• **Two Fingers Zoom In/Out** - Place two fingers side by side on the pad, slightly apart. Slide the fingers apart in a continuous motion to zoom in, or slide the fingers closer together to zoom out.

![Figure 2 - 25: 2F Zoom In/Out]

2 - 24 Touchpad Configuration for Driver Version 2
• **Two Fingers Click** - Tap the pad with two slightly separated fingers. This simulates the use of a middle mouse button often used in the most common internet browsers.

![Two Fingers Click](image)

*Figure 2-26*

2F Click

• **One Finger Edge Swipe Top** - Place a single finger on the top edge of the pad and slide the finger downwards onto the pad. This is used to open the **App** bar in the **Windows Start menu** (not the desktop).

![One Finger Edge Swipe Top](image)

*Figure 2-27*

1F Edge Swipe Top
• One Finger Edge Swipe Right - Place a single finger on the right edge of the pad and slide the finger to the left onto the pad. This is used to open the Charms bar.

Figure 2 - 28
1F Edge Swipe Right

• One Finger Edge Swipe Left - Place a single finger on the left edge of the pad and slide the finger to the right onto the pad. This is used to switch to the last used application.

Figure 2 - 29
1F Edge Swipe Left
Applications
A number of programs/applications support gestures which trigger functions within the program. The Program List displays the programs/applications supporting these functions, and you can use the scroll bar to the right to scroll up/down the list. Click to select the program/application and click View (or just double-click) to see the gestures supported.

Figure 2 - 30
Applications
Chapter 3: Power Management

Overview

To conserve power, especially when using the battery, your computer power management conserves power by controlling individual components of the computer (the monitor and hard disk drive) or the whole system. This chapter covers:

• The Power Sources
• Turning On the Computer
• Power Plans
• Power-Saving States
• Configuring the Power Buttons
• Battery Information

The computer uses enhanced power saving techniques to give the operating system (OS) direct control over the power and thermal states of devices and processors. For example, this enables the OS to set devices into low-power states based on user settings and information from applications.

OS Note

Power management functions will vary slightly depending on your operating system. For more information it is best to refer to the user's manual of your operating system.
The Power Sources

The computer can be powered by either an AC/DC adapter or a battery pack.

**AC/DC Adapter**

Use only the AC/DC adapter that comes with your computer. The wrong type of AC/DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack at the rear of the computer.
2. Make sure the battery is inserted and locked in position.
3. Plug the AC power cord into an outlet, and connect the AC power cord to the AC/DC adapter (make sure you use the adapter when first setting up the computer, as to safeguard the computer during shipping the battery will be locked to not power the system until first connected to the AC/DC adapter).
4. Raise the lid/LCD to a comfortable viewing angle.
5. Press the power button to turn “On”.

**Battery**

The battery allows you to use your computer while you are on the road or when an electrical outlet is unavailable. Battery life varies depending on the applications and the configuration you're using. To increase battery life, let the battery discharge completely before recharging (see “Battery FAQ” on page 3 - 18).

We recommend that you do not remove the battery. For more information on the battery, please refer to “Battery Information” on page 3 - 14.

---

**Forced Off**

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the power button for 4 seconds, or longer, to force the system to turn itself off.
Turning On the Computer

Now you are ready to begin using your computer. To turn it on simply press the power button on the front panel.

When the computer is on, you can use the power button as a Stand by/Hibernate/Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and holding the power button for longer than this will shut the computer down). Use Power Options (Hardware and Sound) in the Windows control panel to configure this feature.

Power Button as Stand by or Hibernate Button

You can use the OS's “Power Options” control panel to set the power button to send the system into Stand by or Hibernate mode (see your OS’s documentation, or “Configuring the Power Buttons” on page 3 - 9 for details).
Shutting the Computer Down

Note that you should always shut your computer down by choosing the **Shut down** command as this will help prevent hard disk or system problems. Use the **Shut down or sign out** item in the **Context Menu** (right-click the lower left corner of the screen to bring up the menu).

You can also use the **Power Menu** in **Settings** in the **Windows 8.1 Charms Bar**. If you want to add Hibernate/Sleep to the Power Menu see “**Adding Hibernate/Sleep to the Power Menu**” on page 3 - 10.
Power Management

Power Plans

The computer can be configured to conserve power by means of power plans. You can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and to send the computer into Sleep after a period of inactivity.

Click Change plan settings and then click Change advanced power settings to access further configuration options in Advanced Settings.

Password

It is recommended that you enable a password on system resume in order to protect your data.

Figure 3 - 2

Power Plan Advanced Settings

Resuming Operation

See Table 3 - 1, on page 3 - 11 for information on how to resume from a power-saving state.

Table 3 - 1

<table>
<thead>
<tr>
<th>Power State</th>
<th>Resume Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sleep</td>
<td>Wake up</td>
</tr>
<tr>
<td>Hibernate</td>
<td>Resume</td>
</tr>
</tbody>
</table>

Figure 3 - 2

Resuming Operation

Table 3 - 1

<table>
<thead>
<tr>
<th>Power State</th>
<th>Resume Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sleep</td>
<td>Wake up</td>
</tr>
<tr>
<td>Hibernate</td>
<td>Resume</td>
</tr>
</tbody>
</table>

Figure 3 - 2

Resuming Operation

Table 3 - 1

<table>
<thead>
<tr>
<th>Power State</th>
<th>Resume Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sleep</td>
<td>Wake up</td>
</tr>
<tr>
<td>Hibernate</td>
<td>Resume</td>
</tr>
</tbody>
</table>
Each *Windows power plan* will also adjust the processor performance of your machine in order to save power. This is worth bearing in mind if you are experiencing any reduced performance (especially under DC/battery power).

Choose **High performance** (you may need to click *Show additional plans* to view the High performance plan) for maximum performance when the computer is powered from an AC power source. Choose the **Power saver** (bear in mind that this scheme may slow down the overall performance of the computer in order to save power) for maximum power saving when the computer is battery (DC power) powered.
Power-Saving States

You can use power-saving states to stop the computer’s operation and restart where you left off. *Win 8.1* uses the *Sleep*, *Hibernate* and *Shut Down* power-saving states.

**Sleep**

In *Sleep* all of your work, settings and preferences are saved to memory before the system sleeps. When you are not using your computer for a certain length of time, which you specify in the operating system, it will enter *Sleep* to save power.

The PC wakes from *Sleep within seconds* and will return you to where you last left off (what was on your desktop) without reopening the application(s) and file(s) you last used.

If your mobile PC in *Sleep* is running on battery power the system will use only a minimum amount of power. After an extended period the system will save all the information to the hard disk and shut the computer down before the battery becomes depleted.

To add *Sleep* to the *Power Menu* see “*Adding Hibernate/Sleep to the Power Menu*” on page 3 - 10.
Power Management

Hibernate
Hibernate uses the least amount of power of all the power-saving states and saves all of your information on a part of the hard disk before it turns the system off. If a power failure occurs the system can restore your work from the hard disk; if a power failure occurs when work is saved only to memory, then the work will be lost. Hibernate will also return you to where you last left off within seconds. You should put your mobile PC into Hibernate if you will not use the computer for a period of time, and will not have the chance to charge the battery. To add Hibernate to the Power Menu see “Adding Hibernate/Sleep to the Power Menu” on page 3 - 10.

Shut down
You should Shut down the computer if you plan to install new hardware (don’t forget to remove the battery and follow all the safety instructions in Chapter 6), plan to be away from the computer for several days, or you do not need it to wake up and run a scheduled task. Returning to full operation from Shut down takes longer than from Sleep or Hibernate.
Configuring the Power Buttons

The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the computer in to a power-saving state. Click Choose what the power buttons do on the left menu in Power Options to bring up the menu.

Password Protection

It is recommended that you enable a password on wake up in order to protect your data. However you can disable this setting from the Power Options menu by clicking Require a password on wakeup in the left menu, and selecting the options (click Change settings that are currently unavailable).

Figure 3 - 5
Power Options
Define Power Buttons
Power Management

Adding Hibernate/Sleep to the Power Menu
Add Hibernate/Sleep to the Power Menu as follows.

1. Go to the Power Options (Hardware and Sound) control panel (see page 1 - 48).
2. Click “Change settings that are currently unavailable”.
3. Click Choose what the power buttons do.
4. Click to put a check in the Hibernate/Sleep box under Shutdown settings.
5. Click Save Changes and close the control panel.

Figure 3 - 6
Power Options Define Power Buttons - Shutdown Settings

3 - 10 Configuring the Power Buttons
Resuming Operation

You can resume operation from power-saving states by pressing the power button, or in some cases pressing the sleep button (Fn + F4 key combo).

<table>
<thead>
<tr>
<th>Power Status</th>
<th>Icon</th>
<th>Color</th>
<th>To Resume</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Off</td>
<td>Off</td>
<td>Off</td>
<td>Press the Power Button</td>
</tr>
<tr>
<td>Sleep</td>
<td>Blinking Green</td>
<td>Press the Power Button</td>
<td></td>
</tr>
<tr>
<td>Hibernate</td>
<td>Off (battery) Orange (AC/DC adapter)</td>
<td>Press the Power Button</td>
<td></td>
</tr>
<tr>
<td>Display Turned Off</td>
<td>Green</td>
<td>Press a Key or Move the Mouse/Touchpad</td>
<td></td>
</tr>
</tbody>
</table>

Table 3 - 1
Resuming Operation

Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down hot key button when it is pressed for less than 4 seconds (pressing and holding the power button for longer than this will force the computer to shut down).

Closing the Lid

If you have chosen to send the computer to Sleep when the lid is closed, raising the lid will wake the system up.
Power Conservation Modes

This system supports Energy Star power management features that place computers (CPU, hard drive, etc.) into a low-power sleep modes after a designated period of inactivity. Adjust Power Conservation Modes from the Control Center:

1. Press the Fn + Esc key combination to toggle the Control Center on/off.
2. Click either the Performance, Balanced or Energy Star button.

The Energy Star setting will result in maximum power saving, but with the possible loss of some performance.

Setting the mode to Balance will give power saving matched with performance.

Performance will give optimum computer performance but with less power conservation.

Note that the Energy Star setting will put the display into sleep after no more than 15 minutes of user inactivity.
Ctrl + Alt + Delete Key Combination
You can use the CTRL + ALT + DEL key combination from almost any of the Windows 8 interfaces/Apps to bring up a full-screen displaying Lock, Switch User, Log off, Change a password and Task Manager options. If you click the Power icon in the lower right corner of the screen a power management option menu appears to display Sleep, Shut down, and Restart.

To fully control all the power options (including Hibernate mode) go to the Power Options control panel and configure the power button, sleep button and lid to perform the function selected.
Battery Information

Follow these simple guidelines to get the best use out of your battery.

Battery Power

Your computer’s battery power is dependent upon many factors, including the programs you are running, and peripheral devices attached. You can set actions to be taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from power plan **Change plan settings > Change advanced power settings** (see **Figure 3 - 3 on page 3 - 6**).

Click the battery icon in the notification area to see the current battery level and charge status.

**Figure 3 - 9**
Battery Icon (Notification Area) & Battery Advanced Settings
Conserving Battery Power

- Use a power plan that conserves power (e.g. Power saver), however note that this may have an affect on computer performance.
- Lower the brightness level of the LCD display. The system will decrease LCD brightness slightly to save power when it is not powered by the AC/DC adapter.
- Reduce the amount of time before the display is turned off.
- Close wireless, Bluetooth, modem or communication applications when they are not being used.
- Disconnect/remove any unnecessary external devices e.g. USB devices, ExpressCards etc.
Battery Life
Battery life may be shortened through improper maintenance. To optimize the life and improve its performance, fully discharge and recharge the battery at least once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to remove the battery for any reason (e.g. long term storage) see “Removing the Battery” on page 6 - 3.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ” on page 3 - 18 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical outlet. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the computer is turned off but plugged into an electrical outlet, battery charge time is less. Refer to “Model Differences” on page 1 - 5 for information on the battery charge status, and to “Battery Information” on page 3 - 14 for more information on how to maintain and properly recharge the battery pack.
Proper handling of the Battery Pack

• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other

Caution
Danger of explosion if battery is incorrectly replaced.
Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer's instructions.

Damaged Battery Warning
Should you notice any physical defects (e.g. the battery is bent out of shape after being dropped), or any unusual smells emanating from the notebook battery, shut your computer down immediately and contact your distributor/supplier. If the battery has been dropped we do not recommend using it any further, as even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire. It is recommended that you replace your computer battery every two years.
Battery FAQ

How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t turn off the computer even if a message indicates the battery is critically low, just let the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.

Figure 3 - 11
Power Plan Create
3. Click *Change plan settings* (after creating it) and click *Change plan settings > Change advanced power settings*.

![Power Options settings](image)

![Edit Plan Settings](image)

*Figure 3 - 12*
Change Plan Settings / Change Advanced Power Settings
Power Management

4. Scroll down to **Battery** and click + to expand the battery options.
5. Choose the options below (click **Yes** if a warning appears):

- Low battery levels = 0%
- Critical battery Levels = 1%
- Low battery action = Do Nothing
- Critical battery action (On battery) = Shut Down
- Critical battery action (Plugged in) = Do Nothing

---

**Figure 3 - 13**
**Power Options**
**Advanced Settings - Battery**
How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges.
Power Management
Chapter 4: Drivers & Utilities

This chapter deals with installing the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems. The system takes advantage of some newer hardware components for which the latest versions of most available operating systems haven’t built in drivers and utilities. Thus, some of the system components won’t be auto-configured with an appropriate driver or utility during operating system installation. Instead, you need to manually install some system-required drivers and utilities.

What to Install

The \textit{Device Drivers & Utilities + User’s Manual} disc contains the drivers and utilities necessary for the proper operation of the computer. \textit{Table 4 - 1, on page 4 - 3} lists what you need to install and \textit{it is very important that the drivers are installed by the method outlined in this chapter, and in the order indicated.}

Note that the information included on the following pages is for Windows 8.1 (64-bit) only.

Module Driver Installation

The procedures for installing drivers for the Wireless LAN, Bluetooth & WLAN Combo, Intel Technology and Sound Blaster Cinema modules are provided in “\textit{Modules}” on page 7 - 1.
Drivers & Utilities

Driver Installation

1. Insert the *Device Drivers & Utilities + User’s Manual* disc into the computer’s DVD drive.
2. Click the message “Tap to choose what happens with this disc.”
3. Click *Run autorun.exe*.
4. Click *Install Drivers* (button), or *Option Drivers* (button) to access the *Optional* driver menu.

5. Check the driver installation order from *Table 4 - 1, on page 4 - 3* (the drivers must be installed in this order) which is the same as that listed in the *Drivers Installer* menu below.
6. Click to select the driver you wish to install, (you should note down the drivers as you install them).
7. Follow the instructions for each individual driver installation procedure as listed on the following pages.

*Figure 4 - 1* - Drivers Installer Screen 1

*Figure 4 - 2* - Install Drivers
<table>
<thead>
<tr>
<th>Win 8.1 (64-bit) Driver</th>
<th>Page #</th>
<th>Win 8.1 (64-bit) - Optional Items</th>
<th>Page #</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chipset</td>
<td>Page 4 - 6</td>
<td>Setting Up SATA RAID or AHCI Mode</td>
<td>Page 7 - 2</td>
</tr>
<tr>
<td>Video (VGA)</td>
<td>Page 4 - 6</td>
<td>PC Camera Module (no driver installation required)</td>
<td>Page 7 - 12</td>
</tr>
<tr>
<td>NVIDIA Video (VGA)</td>
<td>Page 4 - 6</td>
<td>Wireless LAN Module</td>
<td>Page 7 - 21</td>
</tr>
<tr>
<td>AMD Video (VGA)</td>
<td>Page 4 - 6</td>
<td>Fingerprint Reader Module</td>
<td>Page 7 - 33</td>
</tr>
<tr>
<td>LAN</td>
<td>Page 4 - 7</td>
<td>Bluetooth &amp; WLAN Combo Module</td>
<td>Page 7 - 37</td>
</tr>
<tr>
<td>Card Reader</td>
<td>Page 4 - 7</td>
<td>Trusted Platform Module</td>
<td>Page 7 - 42</td>
</tr>
<tr>
<td>Touchpad</td>
<td>Page 4 - 7</td>
<td>Intel® Rapid Storage Technology (required for hard disks in AHCI &amp; RAID modes)</td>
<td>Page 7 - 56</td>
</tr>
<tr>
<td>Airplane</td>
<td>Page 4 - 7</td>
<td>Intel® Rapid Start Technology Driver</td>
<td>Page 7 - 62</td>
</tr>
<tr>
<td>Hot Key</td>
<td>Page 4 - 7</td>
<td>Sound Blaster Audio</td>
<td>Page 7 - 70</td>
</tr>
<tr>
<td>MEI Driver</td>
<td>Page 4 - 7</td>
<td>Wireless Display (no driver installation required)</td>
<td>Page 7 - 79</td>
</tr>
<tr>
<td>Audio</td>
<td>Page 4 - 7</td>
<td>All drivers provided are for the Windows 8.1 (64-bit) operating system.</td>
<td></td>
</tr>
</tbody>
</table>

**Table 4 - 1 - Driver Installation**

Note that you need to install both the WLAN & Bluetooth drivers for the WLAN & Bluetooth Combo modules, however the Qualcomm Atheros WLAN (Combo) module only requires the WLAN driver installation.
Drivers & Utilities

Manual Driver Installation
Click *Browse CD/DVD* (button) in the *Drivers Installer* application and browse to the executable file in the appropriate driver folder.

Windows Update
After installing all the drivers make sure you enable *Windows Update* in order to get all the latest security updates etc. (all updates will include the latest hotfixes from Microsoft). See “*Windows Update*” on page 4 - 8 for instructions.

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it may be necessary to uninstall the original driver. To do this go to the *Control Panel* in the *Windows OS* and double-click the *Programs and Features* icon (*Programs > Uninstall a program*). Click to select the driver (if it is not listed see below) and click *Uninstall*, and then follow the on screen prompts (it may be necessary to restart the computer). Reinstall the driver as outlined in this chapter.

If the driver is not listed in the *Programs and Features* menu:

1. Go to the *Control Panel*.
2. Double-click *Device Manager* (*Hardware and Sound > Devices and Printers > Device Manager*).
3. Double-click the *device* you wish to update/reinstall the driver for (you may need to click “+” to expand the selection).
4. Click *Driver* (tab) and click the *Update Driver* or *Uninstall* button and follow the on screen prompts.
User Account Control
If a User Account Control prompt appears as part of the driver installation procedure, click Continue or Allow, and follow the installation procedure as directed.

Windows Security Message
If you receive a Windows security message as part of the driver installation process. Just click “Install this driver software anyway” or “Install” to continue the installation procedure.

You will receive this message in cases where the driver has been released after the version of Windows you are currently using. All the drivers provided will have already received certification for Windows.

New Hardware Found
If you see the message “New Hardware Found” during the installation procedure (other than when outlined in the driver install procedure), click Cancel to close the window, and follow the installation procedure.

Driver Installation General Guidelines
The driver installation procedure outlined in this Chapter (and in Chapter 7 Options & Modules), are accurate at the time of going to press.

Drivers are always subject to upgrade and revision so the exact procedure for certain drivers may differ slightly. As a general guide follow the default on screen instructions for each driver (e.g. Next > Next > Finish) unless you are an advanced user. In many cases a restart is required to install the driver.

Make sure any modules (e.g. WLAN or Bluetooth) are ON (i.e. the system is not in Airplane Mode) before installing the appropriate driver.
Drivers & Utilities

Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers (button).

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Video (VGA)
1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

NVIDIA Video (VGA)
1. Click 3.Install NVIDIA VGA Driver > Yes.
2. Click AGREE AND CONTINUE (button) to accept the terms of the license agreement.
3. Click Next.
4. Click the Restart Now to complete the installation.

AMD Video (VGA)
1. Click 4.Install AMD VGA Driver > Yes.
2. Click Next > Install (button).
3. Click the Express (or Custom if you prefer to manually configure the driver installation settings) button and click Next.
4. Click Accept (button).
5. Click Finish (button).

Note: After installing the video driver go to the Display/Display Settings control panel to adjust the video settings to the highest resolution.

Video Driver Installation
Note that you will need to install either the NVIDIA Video driver or the AMD video driver as appropriate for your system.
LAN
1. Click **5. Install LAN Driver > Yes.**
2. Click **Next > Install.**
3. Click **Finish.**

Card Reader
1. Click **6. Install Cardreader Driver > Yes.**
2. Click **Finish.**

Touchpad
1. Click **7. Install Touchpad Driver > Yes.**
2. Click **Next.**
3. Click **Finish > Restart Now** to restart the computer.

Airplane
*Note: Do not use Update Driver in Device Manager to install the Airplane mode driver.*
1. Click **8. Install Airplane Driver > Yes.**
2. Click **Next.**
3. Click **Finish** to restart the computer.

Hot Key
1. Click **9. Install Hotkey AP > Yes.**
2. Click **Next.**
3. Click **Finish** to restart your computer.

MEI Driver
1. Click **10. Install MEI Driver > Yes.**
2. Click **Next > Yes > Next.**
3. Click **Finish.**

Audio
1. Click **11. Install Audio Driver > Yes.**
2. Click **Next.**
3. Click **Finish** to restart the computer.

After installing the audio driver the system will not return to the **Drivers Installer** screen. To install any of the optional drivers, eject the **Device Drivers & Utilities + User's Manual** disc and then reinsert it (or double-click the disc icon in My Computer), and click **Option Drivers** (button) to access the optional driver menu.

(see over)
Drivers & Utilities

It is recommended that you install the **Sound Blaster Audio** application (see “Sound Blaster Audio” on page 7 - 70) and **Intel Rapid Storage Technology** driver (see “Intel® Rapid Storage Technology” on page 7 - 56 - required for AHCI & RAID mode).

**Optional Drivers**

See the pages indicated in *Table 4 - 1, on page 4 - 3* for the driver installation procedures for any modules included in your purchase option.

---

**Windows Update**

After installing all the drivers make sure you enable **Windows Update** in order to get all the latest security updates etc. (all updates will include the latest hotfixes from Microsoft).

To enable Windows Update make sure you are connected to the internet:

1. Go to the Control Panel.
2. Click **Windows Update** (System and Security/Security).
3. Click **Check for updates** (button).
4. The computer will now check for updates (you need to be connected to the internet).
5. Click **Install now** (button) to begin checking for the updates.
6. Click **Install updates** (button) to install the updates.

---

**Figure 4 - 3 - Optional Drivers Installer Screen**

Note that you need to install both the WLAN & Bluetooth drivers for the WLAN & Bluetooth Combo modules, however the Qualcomm Atheros WLAN (Combo) module only requires the WLAN driver installation.
Chapter 5: BIOS Utilities

Overview

This chapter gives a brief introduction to the computer’s built-in software:

**Diagnostics:** The POST (Power-On Self Test)

**Configuration:** The *Setup* utility

If your computer has never been set up, or you are making important changes to the system (e.g. hard disk setup), then you should review this chapter first and note the original settings found in *Setup*. Even if you are a beginner, keep a record of the settings you find and any changes you make. This information could be useful if your system ever needs servicing.

There is one general rule: *Don’t make any changes unless you are sure of what you are doing.* Many of the settings are required by the system, and changing them could cause it to become unstable or worse. If you have any doubts, consult your service representative.

BIOS Screens

Note that the BIOS screens pictured on these pages are intended for guidance in setting up your system's BIOS.

BIOS versions are subject to constant change and revision, therefore your computer's actual screens may appear slightly different from those pictured on these pages.
The Power-On Self Test (POST)

If you enable the **Boot-time Diagnostic Screen** in the Setup Utility, each time you turn on the computer the system takes a few seconds to conduct a **POST**, including a quick test of the on-board RAM (memory).

As the **POST** proceeds, the computer will tell you if there is anything wrong. If there is a problem that prevents the system from booting, it will display a system summary and prompt you to run **Setup**.

If there are no problems, the **Setup** prompt will disappear and the system will load the operating system. Once that starts, you can’t get into **Setup** without rebooting.
Failing the POST

Errors can be detected during the POST. There are two categories, “fatal” and “non-fatal”.

Fatal Errors

These stop the boot process and usually indicate there is something seriously wrong with your system. Take the computer to your service representative or authorized distributor/supplier as soon as possible.

Non-Fatal Errors

This kind of error still allows you to boot. You will get a message identifying the problem (make a note of this message!) and you can then press F7 (the F7 on screen will be highlighted to illustrate that the system is processing the request) for boot options.

Press F2 (give the system a few seconds to enter Setup; the F2 on screen will be highlighted to illustrate that the system is processing the request) to run the Setup program and try to correct the problem. If you still get an error message after you change the setting, or if the “cure” seems even worse, call for help.
The Setup Utility

The **Aptio Setup Utility** tells the system how to configure itself and manage basic features and subsystems (e.g. port configuration).

**Entering Setup**

To enter **Setup**, turn on the computer and press **F2** (give the system a few seconds to enter **Setup**; the **F2** on screen will be highlighted to illustrate that the system is processing the request) during the **POST** (or press **F7** for boot options). If you get a “Keyboard Error”, (usually because you pressed **F2** too quickly) just press **F2** again.

If the computer is already on, reboot using the **Ctrl + Alt + Delete** combination and then hold down **F2** when prompted. The **Setup** main menu will appear.

To see the boot options press **F7**.
Setup Screens

The following pages contain additional advice on portions of the Setup. Along the top of the screen is a menu bar with menu headings. When you select a heading, a new screen appears. Scroll through the features listed on each screen to make changes to Setup.

Instructions on how to navigate each screen are in the box at the bottom right side of the screen.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>←, →</td>
<td>Select Screen</td>
</tr>
<tr>
<td>↑, ↓</td>
<td>Select Item</td>
</tr>
<tr>
<td>Enter</td>
<td>Select</td>
</tr>
<tr>
<td>+/-</td>
<td>Change Opt.</td>
</tr>
<tr>
<td>F1</td>
<td>General Help</td>
</tr>
<tr>
<td>F3</td>
<td>Optimized Defaults</td>
</tr>
<tr>
<td>F4</td>
<td>Save Changes &amp; Exit</td>
</tr>
<tr>
<td>ESC</td>
<td>Exit</td>
</tr>
</tbody>
</table>

If these tools are confusing, press F1 to call up a General Help screen, and then use the arrow keys to scroll up or down the page.

The Item Specific Help on the upper right side of each screen explains the highlighted item and has useful messages about its options.

If you see an arrow next to an item, press Enter to go to a sub-menu on that subject. The sub-menu screen that appears has a similar layout, but the Enter key may execute a command.
System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., 00 = midnight; 13 = 1 pm). If you can change the date and time settings in your operating system, you will also change these settings. Some applications may also alter data files to reflect these changes.
**SATA Port # (Main Menu)**
Pressing **Enter** opens the sub-menu to show the configuration of a optical Device/HDD on the computer’s SATA Ports.

**System/Extended Memory (Main Menu)**
This item contains information on the system memory, and is not user configurable. The system will auto detect the amount of memory installed.

**MB Series / BIOS Revision / KBC/EC firmware Revision (Main Menu)**
This item contains information on the BIOS version and is not user configurable.
**Advanced Menu**

*Intel(R) Rapid Start Technology (Advanced Menu)*

Enable/disable **Intel(R) Rapid Start Technology** from this menu. The rapid start hibernation mode can resume power within 5 to 6 seconds and can remember your computer's state with zero power.
Intel(R) Rapid Storage Technology (Advanced Menu)
Enable/disable Intel(R) Rapid Storage Technology from this menu to provide high-performance SATA RAID capabilities for Windows 8. Note that this menu item will be available if UEFI Boot is enabled (see “Boot Menu” on page 5 - 17) and the SATA Mode (Advanced Menu) is set to RAID (see below).

SATA Mode (Advanced Menu)
You can configure SATA (Serial ATA) control to operate in AHCI (Advanced Host Controller Interface) or RAID (Redundant Array of Independent disks) modes from this menu. The SATA Mode should be set BEFORE installing an operating system, and after you have backed up all necessary files and data (see sidebar). See “Setting Up SATA RAID or AHCI Mode” on page 7 - 2 for details. Make sure you install the Intel Rapid Storage Technology application if you have set the SATA Mode to RAID, or to AHCI “IRST Driver Installation” on page 7 - 10.

Boot Logo (Advanced Menu)
Use this menu item to enable/disable the Boot Logo screen at system startup if you have not enabled UEFI Boot. If you disable the Boot Logo you will not see the F2 Enter Setup or F7 Boot Options prompts on the screen, however you can still press these keys, while the boot screen is displayed, to perform the Enter Setup or Boot Option functions.
**BIOS Utilities**

*Power On Boot Beep (Advanced Menu)*
Use this menu item to enable/disable the beep as the computer starts up.

*Battery Low Alarm Beep (Advanced Menu)*
Use this menu item to enable/disable the battery low alarm beep.
Set Supervisor Password (Security Menu)
You can set a password for access to the **Aptio Setup Utility**. This will not affect access to the computer OS (only the **Aptio Setup Utility**).
**Note**: To clear existing passwords press **Enter** and type the existing password, then press **Enter** for the new password (without typing any password entry) and **Enter** again to confirm the password clearance.

**Note**: *You can only set the user password after you have set the supervisor password.*

*Set User Password (Security Menu)*

You can set a password for user mode access to the **Aptio Setup Utility**. This will not affect access to the computer OS, (only the **Setup** utility) unless you choose to set a **Password on Boot** (see below). Many menu items in the **Aptio Setup Utility** cannot be modified in user mode.

**Note**: *You can only set the user password after you have set the supervisor password.*

*Password on boot: (Security Menu)*

Specify whether or not a password should be entered to boot the computer (**you may only set a password on boot if a supervisor password is enabled**). If “**Enabled**” is selected, only users who enter a correct password can boot the system (**see the warning in the sidebar**). The default setting is “**Disabled**.”
Secure Boot Control (Security Menu)
Secure Boot Control prevents unauthorized operating systems and software from loading during the startup process. Secure Boot is available as a menu option if you have enabled UEFI Boot (see “Boot Menu” on page 5 - 17). Enabling Secure Boot will bring up the Secure Boot Mode menu to enable you to configure Secure Boot as Standard (with a fixed secure boot policy), or Custom (which enables you to make changes to the Key Management database).
TPM Configuration (Security Menu)
This sub-menu will allow you to enable/disable Trusted Platform Module (TPM) support, and to configure the TPM State. Select TPM Configuration and press Enter to access the sub-menu. Press Enter to access the Security Device Support menu and select Enable to display the full TPM configuration menu (see “Trusted Platform Module” on page 7 - 42 for details).
**TPM State (Security Menu > Security Device Support Enabled)**

Select **TPM State**, press Enter and select **Enabled** to change the TPM state to enabled. You will then need to press **F4** to save the changes and restart the computer.

As the computer restarts press **F2** to enter the BIOS again and go to the **TPM Configuration menu**.
Pending TPM operation (Security Menu > Security Device Support Enabled & TPM State Enabled)

Select **Pending TPM operation**, press Enter and select the option you require (if you are initializing TPM you should select **Enable Take Ownership**). You will then need to press **F4** to save the changes and restart the computer. You can now install the TPM driver (see “Trusted Platform Module (TPM) Driver Installation” on page 7 - 45) and then initialize the TPM.

![Image](image-url)
Boot Menu

When you turn the computer on it will look for an operating system (e.g. Windows 7) from the devices listed in this menu, and in this priority order. If it cannot find the operating system on that device, it will try to load it from the next device in the order specified in the Boot Option Priorities.
Boot Option Priorities (Boot Menu)
Press Enter to select the Boot Option # and use the arrow keys to select any device in order to move its boot priority up and down the list (the selected device will be highlighted in white).

UEFI Boot (Boot Menu)
Enable/disable UEFI Boot from this menu. The Unified Extensible Firmware Interface (UEFI) specification provides a clean interface between operating systems and platform firmware at boot time. In contrast to BIOS, UEFI defines a set of standard boot and runtime services. The Network Stack item will be enabled as an option under UEFI Boot.
Exit Menu

Click **Save Changes and Reset** to save all changes made. Choosing to **Discard Changes**, or **Exit Discarding Changes**, will wipe out any changes you have made to the **Setup**. You can also choose to restore the original **Setup** defaults that will return the **Setup** to its original state, and erase any previous changes you have made in a previous session.
Chapter 6: Upgrading The Computer

Overview

This chapter contains information on upgrading the computer. Follow the steps outlined to make the desired upgrades. If you have any trouble or problems you can contact your service representative for further help. Before you begin you will need:

- A small crosshead or Phillips screwdriver
- A small regular slotted (flathead) screwdriver
- An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic wrist strap to ground yourself because static electricity may damage the components.

The chapter includes:

- Removing the Battery
- Upgrading the Optical Device
- Upgrading the Hard Disk Drive(s)
- Upgrading the System Memory (RAM)
- Upgrading the mSATA SSD

Please make sure that you review each procedure before you perform it.
When Not to Upgrade

These procedures involve opening the system’s case, adding and sometimes replacing parts. You should **not** perform any of these upgrades if:

- Your system is still under warranty or a service contract
- You don’t have all the necessary equipment
- You’re not in the correct environment
- You doubt your abilities

Under any of these conditions, contact your service representative to purchase or replace the component(s).
Removing the Battery

If you are confident in undertaking upgrade procedures yourself, for safety reasons it is best to remove the battery. **Before removing the battery disconnect the AC/DC adapter from the computer first.**

The procedure for removing the battery will depend upon your particular computer model. See the pages indicated for the appropriate information:

- “Removing The Battery from Model A, B, C & D Computers” on page 6 - 4
- “Removing The Battery from Model E & F Computers” on page 6 - 5

**Warranty Warning**

Please check with your service representative before undertaking any upgrade procedures to find out if this will VOID your warranty.
Removing The Battery from Model A, B, C & D Computers

1. Turn the computer off, remove the AC/DC adapter and turn it over.
2. Slide the latch 1 in the direction of the arrow.
3. Slide the latch 2 in the direction of the arrow, and hold it in place.
4. Slide the battery in the direction of the arrow 3.
5. Lift the battery out of the compartment 4.

Figure 6 - 1
Removing the Battery
(Models A, B, C & D)
Removing The Battery from Model E & F Computers

1. Turn the computer off, remove the AC/DC adapter and turn the computer over.
2. Slide the latch 1 in the direction of the arrow.
3. Slide the latch 2 in the direction of the arrow, and hold it in place.
4. Lever the battery up at point 3.
5. Lift the battery out of the compartment 4.

Note that though only Model F is pictured, the battery removal procedure is identical for both (E & F) computer models.
Upgrading the Optical Device

Note the appropriate page for instructions on removing the optical device for your particular model.

- “Upgrading the Optical Device (Models A, C & D)” on page 6 - 7
- “Upgrading the Optical Device (Model B)” on page 6 - 8
- “Upgrading the Optical Device (Models E & F)” on page 6 - 9

Secondary Hard Disk Module (Models A, C & D)
Model A, C & D computers also feature a secondary hard disk module which is interchangeable with the optical CD/DVD device. Remove the optical device as instructed here and replace it with the HDD module. If you need to remove the HDD from the module caddy see page 6 - 17.
Upgrading the Optical Device (Models A, C & D)

1. Turn the computer off, remove the AC/DC adapter (and battery) and turn the computer over.
2. Locate the hard disk bay cover and remove screws 1 & 2.
3. Lever up the HDD bay cover at point 3, and then remove the cover 4.
4. Remove the screw at point 4, and use a screwdriver to carefully push out the optical device at point 5.
5. Reverse the process to install any new optical (CD/DVD) device.

Figure 6 - 3
Removing the Optical (CD/DVD) Device
(Models A, C & D)
Upgrading The Computer

Upgrading the Optical Device (Model B)

1. Turn the computer off, remove the AC/DC adapter (and battery) and turn the computer over.
2. Locate the HDD/ODD bay cover and remove screws 1 - 3.
3. Slide the cover in the direction of arrow 4, until the case markers 5 line up.
4. Remove the HDD/ODD bay cover 6.
5. Remove the screw at point 7, and use a screwdriver to carefully push out the optical device.
6. Reverse the process to install any new optical (CD/DVD) device (make sure you slide on the cover and align the markers when replacing the HDD/ODD bay cover).

Figure 6 - 4
Removing the Optical (CD/DVD) Device (Model B)
Upgrading the Optical Device (Models E & F)

1. Turn the computer off, remove the AC/DC adapter (and battery) and turn the computer over.
2. Locate the secondary hard disk bay cover and remove screws 1 & 2.
3. Remove the hard disk bay cover.
4. Remove the screw at point 3, and use a screwdriver to carefully push out the optical device out of the bay.
5. Reverse the process to install any new optical (CD/DVD) device.

Note that though only Model F is pictured, the cover removal procedure is identical for all both models.
Upgrading the Hard Disk Drive(s)

The hard disk Drive(s) can be taken out to accommodate other 2.5" serial (SATA) hard disk drives with a height of 9.5mm (h) (see “Storage” on page D - 3).

Primary Hard Disk Drive Removal
Note the appropriate page for instructions on removing the HDD for your particular model. You will need to remove the Primary HDD bay cover as below:
• “Removing the Cover from the Primary HDD Bay (Models A, C & D)” on page 6 - 11
• “Removing the Cover from the HDD/ODD Bay (Model B)” on page 6 - 12
• “Removing the Cover from the Primary HDD Bay (Models E & F)” on page 6 - 13

See the instructions below for removing the hard disk assembly:
• “Removing the Primary HDD Assembly” on page 6 - 14

Secondary Hard Disk Drive Removal
Model A, C & D computers feature a secondary hard disk module which is interchangeable the optical CD/DVD device. Remove the optical device as instructed on the previous pages and replace it with the HDD module (see “Removing the Hard Disk from the Caddy HDD Bay (Models A, C & D)” on page 6 - 17).

Model B, E & F computers feature a secondary hard disk bay (you may have a second hard disk installed as part of a RAID) located under the optical device drive (see “Removing the Hard Disk from the Secondary HDD Bay (Model B)” on page 6 - 18 or “Removing the Hard Disk from the Secondary HDD Bay (Models E & F)” on page 6 - 21).
Removing the Cover from the Primary HDD Bay (Models A, C & D)

1. Turn the computer off, remove the AC/DC adapter (and battery) and turn the computer over.
2. Locate the hard disk bay cover and remove screws 1 & 2.
3. Remove the hard disk bay cover 3 by levering the cover at point 4.

Figure 6 - 6
HDD Bay Cover Screws & Cover Removal
(Model A, C & D)
Removing the Cover from the HDD/ODD Bay (Model B)

1. Turn the computer off, remove the AC/DC adapter (and battery) and turn the computer over.
2. Locate the HDD/ODD bay cover and remove screws 1 - 3.
3. Slide the cover in the direction of arrow 4, until the case markers 5 line up.
4. Remove the HDD/ODD bay cover 6.

Figure 6 - 7
HDD/ODD Bay
Cover Screws &
Cover Removal
(Model B)
Removing the Cover from the Primary HDD Bay (Models E & F)

1. Turn the computer off, remove the AC/DC adapter (and battery) and turn the computer over.
2. Locate the hard disk bay cover and remove screws 1 & 2.
3. Remove the hard disk bay cover 3 by levering the cover at point 4.

Figure 6 - 8
HDD Bay Cover Screws & Cover Removal (Models E & F)
Removing the Primary HDD Assembly

1. When the cover is removed, follow the instructions below to remove the HDD assembly.
2. Slide the HDD assembly in the direction of arrow 1.
3. Remove the hard disk assembly 2.

RAID Hard Disks

All hard disks in a RAID should be identical (the same size and brand) in order to prevent unexpected system behavior.

Hard Disk Handling

Do not press down on the center off the hard disk as this area houses the hard disk drive motor.

Figure 6 - 9
Hard Disk Assembly Removal
4. Remove screws 3 & 4 and the insulation plate 5.
5. Reverse the process to install a new disk (see over) and do not forget to install the insulation plate.

Figure 6-10
Hard Disk Insulation Plate Removal
Upgrading The Computer

Inserting the Hard Disk Into the Primary HDD Bay
1. Make sure the HDD assembly is aligned with the black taped area ①.
2. When aligned, carefully insert the HDD assembly ② into the case so that the connectors line up.
3. Replace the hard disk bay covers and screws.

Figure 6 - 11
Primary HDD Assembly Insertion
Removing the Hard Disk from the Caddy HDD Bay (Models A, C & D)

Note that the secondary hard disk module is used to replace the optical device module (CD/DVD) in Models A, C & D computers.

1. Turn the computer off, remove the AC/DC adapter (and battery) and turn the computer over.
2. Remove the optical device (see page 6 - 7 or page 6 - 8).
3. Remove screws 1 - 4 from the rear of the secondary HDD module assembly.
4. Slide the HDD in the direction of arrow 5.
5. Remove the HDD 6 from the module caddy 7.
6. Reverse the process to install a new hard disk.

Figure 6 - 12
Removing the Secondary HDD from the Module Caddy (Models A, C & D)
Removing the Hard Disk from the Secondary HDD Bay (Model B)

Note that the secondary hard disk (Model B if installed) is located under the optical device bay (CD/DVD).

1. Turn the computer off, remove the AC/DC adapter (and battery) and turn the computer over.
2. Remove the optical device (see “Upgrading the Optical Device (Model B)” on page 6 - 8)
3. When the optical device is removed the secondary HDD assembly will be visible.
4. Remove screws 1 - 4 from the secondary HDD assembly.

**Figure 6 - 13**
Secondary HDD Assembly Screws (Model B)
5. Slide the secondary HDD assembly in the direction of the arrow \( \textcircled{5} \) (it will not move fully out of the bay),

6. Lift the secondary HDD assembly \( \textcircled{6} \) up out of the bay (in the reverse direction to arrow \( \textcircled{5} \)).

Figure 6 - 14
Secondary HDD Assembly Removal (Model B)
Upgrading The Computer

7. Remove screws 7 - 10 and the insulation plate 11.

8. Reverse the process to install a new disk (make sure you install the insulation plate).
9. Slide the HDD assembly into the bay at an angle as illustrated.
10. Make sure the insulation plate slides under the HDD bay guide at point 11.
11. Slide the assembly in the direction of the arrow 12 and secure the assembly with the screws (see Figure 6 - 17 on page 6 - 21).

Figure 6 - 15
Secondary Hard Disk Insulation Plate Removal (Model B)

Figure 6 - 16
Secondary Hard Disk Assembly Installation (Model B)
Upgrading the Hard Disk Drive(s) 6 - 21

Removing the Hard Disk from the Secondary HDD Bay (Models E & F)
Note that the secondary hard disk (Models E & F if installed) is located under the optical device bay (CD/DVD).

1. Turn the computer off, remove the AC/DC adapter (and battery) and turn the computer over.
2. Remove the optical device (see “Upgrading the Optical Device (Models E & F)” on page 6 - 9)
3. When the optical device is removed the secondary HDD assembly will be visible.
4. Remove screws 1 - 3 from the secondary HDD assembly.

RAID Hard Disks
All hard disks in a RAID should be identical (the same size and brand) in order to prevent unexpected system behavior.

Figure 6 - 17
Secondary HDD Assembly Screws (Models E & F)
5. Slide the secondary HDD assembly in the direction of the arrow 4 (it will not move fully out of the bay),
6. Lift the secondary HDD assembly 5 up out of the bay (in the reverse direction to arrow 4).

Figure 6 - 18
Secondary HDD Assembly Removal (Models E & F)
7. Remove screws 6 - 9 and the insulation plate 10.

8. Reverse the process to install a new disk (make sure you install the insulation plate).
9. Slide the HDD assembly into the bay at an angle as illustrated.
10. Make sure the insulation plate slides under the HDD bay guide at point 11.
11. Slide the assembly in the direction of the arrow 12 and secure the assembly with the screws (see Figure 6 - 17 on page 6 - 21).

Figure 6 - 19
Secondary Hard Disk Insulation Plate Removal (Models E & F)

Figure 6 - 20
Secondary Hard Disk Assembly Installation (Models E & F)
Upgrading The Computer

Upgrading the System Memory (RAM)

The computer has four memory sockets for 204 pin Small Outline Dual In-line (SO-DIMM) DDR III (DDR3) type memory modules (see “Memory” on page D - 2). The total memory size is automatically detected by the POST routine once you turn on your computer.

Two primary memory sockets are located under component bay cover (the bottom case cover), and two secondary memory sockets are located under the keyboard (not user upgradable). If you are installing only two RAM modules then they should be installed in the primary memory sockets under the component bay cover.

Note the appropriate page for instructions on removing the component bay cover for your particular model.

- “Removing the Component Cover (Models A, C & D)” on page 6 - 25
- “Removing the Component Cover (Model B)” on page 6 - 26
- “Removing the Component Cover (Model E)” on page 6 - 27
- “Removing the Component Cover (Model F)” on page 6 - 28

See the instructions below for removing the system memory:

- “System Memory (RAM) Module Removal” on page 6 - 29
Removing the Component Cover (Models A, C & D)

1. Turn the computer off, remove the AC/DC adapter (and battery) and turn the computer over.
2. Remove screws 1 - 4 from the bottom of the computer.
3. Slide the component bay cover until the cover and case indicators 5 are aligned.
4. Lift the cover 6 off the computer.

Figure 6 - 21
Component Cover Screws
(Models A, C & D)

Figure 6 - 22
Component Cover Move & Removal
(Models A, C & D)
Removing the Component Cover (Model B)

1. Turn the computer off, remove the AC/DC adapter (and battery) and turn the computer over.
2. Remove screws 1 - 4 from the bottom and rear of the computer.
3. Slide the component bay cover until the cover and case indicators 5 are aligned.
4. Lift the cover 6 off the computer.

Figure 6 - 23
Component Cover Screws (Model B)

Figure 6 - 24
Component Cover Move & Removal (Model B)
Removing the Component Cover (Model E)

1. Turn the computer off, remove the AC/DC adapter (and battery) and turn the computer over.
2. Remove screws 1 - 4 from the bottom of the computer.
3. Slide the component bay cover until the cover and case indicators 5 are aligned.
4. Lift the cover 6 off the computer.

Figure 6 - 25
Component Cover Screws (Model E)

Figure 6 - 26
Component Cover Move & Removal (Model E)
Upgrading The Computer

Removing the Component Cover (Model F)
1. Turn the computer off, remove the AC/DC adapter (and battery) and turn the computer over.
2. Remove screws 1 - 6 from the bottom and rear of the computer.
3. Slide the component bay cover until the cover and case indicators 7 are aligned.
4. Lift the cover 8 off the computer.

Figure 6 - 27
Component Cover
Screws
(Model F)

Figure 6 - 28
Component Cover
Move & Removal
(Model F)

6 - 28 Upgrading the System Memory (RAM)
System Memory (RAM) Module Removal

1. Gently pull the two release latches (1 & 2) on the sides of the memory sockets in the direction indicated below.

2. The RAM module will pop-up, and you can remove it.

3. Pull the latches to release the second module if necessary.

4. Insert a new module holding it at about a 30° angle and fit the connectors firmly into the memory socket.

5. The module’s pin alignment will allow it to only fit one way. Make sure the module is seated as far into the socket as it will go. DO NOT FORCE the module; it should fit without much pressure.

6. Press the module in and down towards the mainboard until the socket levers click into place to secure the module.

7. Replace the component bay cover (see page 6 - 30).
Upgrading the mSATA SSD

1. Turn the computer off, remove the AC/DC adapter (and battery) and turn the computer over.
2. Remove the component bay cover (see the appropriate component bay cover removal page for your model).
3. Locate the mSATA SSD 1.
4. Remove screw 2 and the module will pop up.
5. You can then remove the module 3 and replace it if necessary.
6. Replace the component bay cover (see page 6 - 30).
Upgrading the Processor
If you want to upgrade your computer by replacing the existing processor with a faster/new one you will need to contact your customer service representative. We recommend that you do not do this yourself, since if it is done incorrectly you may damage the processor or mainboard.
Upgrading The Computer
Chapter 7: Modules

Overview

This chapter contains the information on the various modules (some of which are optional) which may come with your computer, depending on the configuration purchased. If you are unsure please contact your service representative.

The chapter includes information on the following:

- Setting Up SATA RAID or AHCI Mode
- PC Camera Module
- Wireless LAN Module
- Fingerprint Reader Module
- Bluetooth & WLAN Combo Module
- Trusted Platform Module
- Intel® Rapid Storage Technology
- Intel® Rapid Start Technology Driver
- Sound Blaster Audio
- Wireless Display
Setting Up SATA RAID or AHCI Mode

AHCI Mode

Advanced Host Controller Interface (AHCI) is an interface specification that allows the storage driver to enable advanced serial ATA features such as Native Command Queuing (for maximum hard disk efficiency and performance). AHCI mode can be supported by one or two hard disks. Make sure you install the Intel® Rapid Storage Technology application if you have set up your hard disk(s) in AHCI mode (see “Intel® Rapid Storage Technology” on page 7 - 56).

RAID

To configure your RAID (Redundant Array of Independent Disks) system in Stripping (RAID 0), Mirroring (RAID 1) or Recovery modes (see Table 7 - 1, on page 7 - 3) you will require at least two identical (see sidebar) hard disks. Note that you will need to install a driver from the Device Drivers & Utilities + User’s Manual disc at OS installation (see page 7 - 4).

Intel® Rapid Storage Technology Application

Make sure you install the Intel® Rapid Storage Technology application if you have set up your hard disk(s) in RAID mode (see “Intel® Rapid Storage Technology” on page 7 - 56).

RAID Hard Disks

All hard disks in a RAID should be identical (the same size and brand) in order to prevent unexpected system behavior.

SATA Mode Selection

The SATA mode selection should be made before installing your operating system. DO NOT change your selected SATA mode unless you intend to reinstall your operating system. Make sure you have backed up all your data before doing so.
### RAID Levels

<table>
<thead>
<tr>
<th>RAID Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID 0</td>
<td>Identical drives reading and writing data in parallel to increase performance. RAID 0 implements a striped disk array and the data is broken into blocks and each block is written to a separate disk drive.</td>
</tr>
<tr>
<td>RAID 1</td>
<td>Identical drives in a mirrored configuration used to protect data. Should a drive that is part of a mirrored array fail, the mirrored drive (which contains identical data) will handle all the data. When a new replacement drive is installed, data to the new drive is rebuilt from the mirrored drive to restore fault tolerance.</td>
</tr>
<tr>
<td>Recovery</td>
<td>Two identical drives copying data between a master and a recovery disk. This provides more control over how data is copied between the master and recovery drives, fast volume updates and the ability to view the data in Windows Explorer.</td>
</tr>
</tbody>
</table>

**SATA Mode Selection**

The SATA mode selection should be made before installing your operating system. DO NOT change your selected SATA mode unless you intend to reinstall your operating system. Make sure you have backed up all your data before doing so.

**RAID Hard Disks**

All hard disks in a RAID should be identical (the same size and brand) in order to prevent unexpected system behavior.
SATA RAID Setup Procedure (Windows 8.1)

To configure your RAID (Redundant Array of Independent Disks) system in Stripping (RAID 0) or Mirroring (RAID 1) modes (see Table 7 - 1, on page 7 - 3) you will require at least two identical (see sidebar) hard disks.

Note that the RAID setup in Windows 8.1 differs from that outlined for Windows 7. You need to setup a RAID before installing your Windows 8.1 operating system, and you will need to prepare the following in order to do so.

1. The Microsoft Windows 8.1 OS DVD.
2. A hard disk installed in the Primary HDD bay.
3. A second (identical) hard disk installed in the Secondary HDD bay.
5. A USB flash drive.
6. An operable computer (to copy files from the Device Drivers & Utilities + User’s Manual disc to the USB flash drive).

Before setting up the system you will need to copy a driver folder to a USB flash drive or external USB hard disk. This driver folder is included on the Device Drivers & Utilities + User’s Manual disc but you will need to go to an operable computer and copy the folder to a USB Flash drive or external USB hard disk.
1. Go to the operable computer and insert a USB Flash drive or external USB hard disk.
2. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive of the operable computer.
3. Copy the f6f1py-x86 or f6f1py-x64 folder from the location below (D: denotes your DVD drive) on the Device Drivers & Utilities + User’s Manual disc to the USB flash drive or external USB hard disk.
   - For Windows 8.1 32bit = D:\Options\RAID\f6f1py-x86
   - For Windows 8.1 64bit = D:\Options\RAID\f6f1py-x64
4. Start-up your notebook computer and press <F2> to enter the BIOS.
5. Go to the Boot menu, select UEFI Setting and press <Enter> (see page 5 - 17).
6. Set UEFI Boot to “Enabled”.
7. Press <Esc> to exit the menu and go to the Advanced menu.
8. Select SATA Mode (see page 5 - 9), press <Enter> and select “RAID Mode”.
9. Press <F4> and <Yes> to “Save Changes and Reset”.
10. After computer restarts press <F2> to enter the BIOS again.
11. Go to Intel(R) Rapid Storage Technology (in the Advanced menu) and press <Enter>.
12. Select Create RAID Volume and press <Enter>.

Figure 7 - 1
Create RAID Volume
(Advanced > Intel(R) Rapid Storage Technology)
13. You can now setup your RAID volume using any two installed disks.
14. Go to Name: and press <Enter>.
15. Type a name of your choice for your RAID volume and press <Enter>.

Figure 7-2
Name the RAID Volume (Advanced > Intel(R) Rapid Storage Technology)
16. Go to **RAID Level**: and press <Enter>.
17. Choose the RAID Level required (see *Table 7 - 1, on page 7 - 3* for details) and press <Enter>.
   - RAID0 (Stripe)
   - RAID1 (Mirror)
   - Recovery
18. Go to any of the disks listed under **Select Disks**: and select a disk name and press <Enter>.
19. Move the cursor down (use the arrow keys) onto to **X** (to select the disk required and press <Enter>.
   - If you have selected a **Recovery** level RAID then you need to select one disk to be **Master disk (M)** and one disk to be the **Recovery disk (R)**

*Figure 7 - 3*  
Select Disks  
(Advanced > Intel(R) Rapid Storage Technology)
20. You should select two identical disks to form your RAID volume.
21. If you have selected **RAID0 (Stripe)** then you can adjust the "Strip Size" to your requirements.
22. If you have selected **Recovery** then you can adjust the **Synchronization** to "On Request" or "Continuous".
23. Go to **Create Volume** and press <Enter>.
24. The RAID volume will then be created and the RAID information will be displayed under **Intel(R) Rapid Storage Technology** (in the Advanced menu).

![Figure 7-4 Created RAID Information (Advanced > Intel(R) Rapid Storage Technology)]
25. Press <Esc> to exit the menu.
26. Press <F4> and <Yes> to “Save Changes and Reset”, however ensure that the two conditions in the bulleted points below are met before doing so.
   • Make sure the Windows 8.1 OS DVD is in the DVD drive. and as the computer starts up it will automatically boot from the Windows 8.1 OS DVD (you will be prompted to press a key to boot from the DVD).
   • Make sure your USB Flash drive or external USB hard disk is attached to one of the USB ports on the computer.

27. Press <F7> as the computer starts up to bring up the boot device menu.
28. Select the DVD drive containing the Windows 8.1 OS DVD and press <Enter>.
29. Press a key at system startup to begin installing Windows from your Microsoft Windows 8.1 disc.
30. Click Next > Install Now to continue installing the operating system as normal (see your Windows documentation if you need help on installing the Windows OS).
31. A prompt will appear to ask you to Load Driver.
32. Click Browse and browse to the location you copied the files to on your USB Flash drive or external USB hard disk (X: denotes your USB Flash drive or external USB hard disk):
   • X:\f6flpy-x86 (for Windows 8.1 32bit)
   • X:\f6flpy-x64 (for Windows 8.1 64bit)
33. Click Next.
34. Follow the on-screen instructions to install the Windows 8.1 operating system.
35. Install the Windows drivers from the Device Drivers & Utilities + User’s Manual disc as per Table 4-1, on page 4-3 (make sure you install the Intel Rapid Storage Technology driver - see overleaf).

36. Run the Intel® Rapid Storage Technology application to manage your RAID volume as instructed in “Intel® Rapid Storage Technology for RAID Systems” on page 7-57.

IRST Driver Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into the DVD drive.
2. Click Option Drivers (button).
3. Click 5.Install IRST Driver > Yes.
4. Click Next > Next.
5. Click the check box to accept the license and click Next.
6. Click Next > Next > Next.
7. Click Finish to restart the computer.
Deleting a RAID (Windows 8.1)

If you wish to delete an existing RAID then follow the procedure below to do so. However backup up any necessary files and data before deleting a RAID, as doing so will result in the loss of all data on the RAID volumes.

1. Start-up your notebook computer and press <F2> to enter the BIOS.
2. Go to Intel(R) Rapid Storage Technology (in the Advanced menu) and press <Enter>.
3. Go to the RAID (listed under RAID Volumes:) and press <Enter>.
4. Select Delete and press <Enter>.
5. Select “Yes” (note that all the data on the volumes will be lost) and press <Enter>.

---

**Figure 7-5**
Delete RAID (Advanced > Intel(R) Rapid Storage Technology)
PC Camera Module

When the PC Camera application is run the LED indicator to the left of the camera will be illuminated in red. Note that you need to use the Camera app in Windows to take pictures and capture video. Use the Fn + F10 key combination (see “Function Keys & Visual Indicators” on page 1-21) to toggle power to the PC Camera module.
PC Camera Audio Setup

If you want to capture video & audio with your camera, it is necessary to setup the audio recording options in *Windows*.

1. Go to the Control Panel.
2. Click Sound (Hardware and Sound) and click Recording (tab).
3. Right-click hold and release Microphone (Realtek High Definition Audio) and make sure the item is not disabled.
4. Double-click Microphone (or select Properties from the right-click menu).
5. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to the level required.
6. Click OK and close the control panels.

*Figure 7 - 6  
Audio Setup for PC Camera*
Camera App

1. Run the Camera app from the Start screen by clicking on the Camera app icon.

2. The camera interface will display two buttons on the right side of the screen.

3. The upper button is used to record video, and the lower button is used to take still pictures.

4. Right-click on the screen to bring up menu buttons at the bottom of the screen.

5. These buttons enable you to access the camera roll (where captured pictures and video are displayed), set the timer (the time period before capture begins; 3 seconds, 10 seconds or Off) and set the exposure level using the slider to obtain the best results.
Camera Options

The Camera Options settings may be accessed as follows:

1. Run the Camera app from the Start screen by clicking on the Camera app icon.

2. While the camera app is running access the Charms Bar (e.g. click Use the Windows logo key + C key combination).

3. Click Settings and then click Options.

4. You can adjust the Photo Aspect Ratio, select the Microphone, Hide/Show grid lines and turn Location Info on or off from the Options panel.

Figure 7 - 9
Camera Options
Taking Pictures/Capturing Video

1. Run the Camera app from the Start screen by clicking on the Camera app icon.
2. Right-click the screen and select the timer if you require a countdown before capture.
3. Click the appropriate icon to take a picture or start video capture (if video capture begins a timer will appear in the bottom corner of the screen).
4. To stop video capture click the main window again (or click the stop icon).
5. Captured photos and videos will be saved to a Camera Roll folder within the Pictures folder.

Figure 7 - 10
Pictures - Camera Roll
Camera Roll
1. Run the Camera app from the Start screen by clicking on the Camera app icon.
2. Right-click on the screen to bring up menu buttons at the bottom of the screen.
3. Click Camera Roll.
4. Click the arrows < / > (on either side of the screen) to browse through the captured photos/video, and back to the Camera app.

Editing Photos
1. Clicking on a captured photo will bring up an app bar with a series of buttons.

   ![Edit Buttons](image)

   - The Camera Button will take you back to the home screen of the camera app.
   - Click Delete to remove any photo from the camera roll (you will be asked to click Delete again to confirm the deletion).
   - The Open With button will allow you to select a program with which to open the photo.
   - You can click Set as Lock screen to set the photo as the lock screen picture.
   - Clicking Slide Show will create a slide show of photos/video in the camera roll.
   - Click Rotate to rotate the picture through 90 degrees.
   - Use the handles to Crop any captured picture, and click Apply to make the changes (you can change the Aspect ratio by clicking the button and selecting an aspect ratio from the menu). You can Save a copy (create another copy of the

---

Figure 7 - 11
Edit Buttons
(for Still Photos)
photo with the edited changes), **Update original** (which changes the original picture permanently) or **Undo** any changes.

9. Click the **Edit** button to bring up a full suite of tools to edit the photo.
10. Click on the menu headings on the left, and then click on the tool on the right to edit the photo as required.

11. After the editing process is completed right-click on the photo to **Save a copy** (create another copy of the photo with the edited changes), **Update original** (which changes the original picture permanently), **Undo** any changes or **Cancel** the editing.
Editing Videos
1. Clicking on a captured video will bring up an app bar with a series of buttons.

2. Click **Delete** to remove any video from the camera roll (you will be asked to click **Delete** again to confirm the deletion).

3. The **Open With** button will allow you to select a program with which to run the Video.

4. Clicking **Slide Show** will create a slide show of photos/video in the camera roll.

5. Click **Trim** to edit the video. Use the round buttons at either end of the slider to adjust the video length and click **Save a copy** to save the changes made.

![Figure 7 - 13](image1.png)  
**Figure 7 - 13**  
*Edit Buttons (for Video)*

![Figure 7 - 14](image2.png)  
**Figure 7 - 14**  
*Trim Video (for Video Files)*

Click to select and move the rounded buttons to edit the video.
Video File Size
Note that capturing high resolution video files requires a substantial amount of disk space for each file. After recording video, check the video file size (right-click the file and select Properties) and the remaining free space on your hard disk (go to My Computer, right-click the hard disk, and select Properties). If necessary you can remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash drive.

Note that the Windows 8.1 system requires a minimum of 16GB (32-bit) or 20GB (64-bit) of free space on the C: drive system partition. In order to prevent system problems it is recommended that you move any large sized captured video file to a location other than the C: drive.
Wireless LAN Module

If you have included an Intel®, 3rd Party 802.11b/g/n or Qualcomm Atheros WLAN (Combo) module is on (i.e. the system is not in Airplane Mode) before installing the driver.

Make sure you install the drivers in the order indicated in Table 4-1, on page 4-3.

Note that you need to install both the WLAN & Bluetooth drivers for the WLAN & Bluetooth Combo modules, however the Qualcomm Atheros WLAN (Combo) module only requires the WLAN driver installation.

See the appropriate driver installation instructions on the page indicated below:

- See “3rd Party 802.11b/g/n Driver Installation” on page 7-22.
- See “Intel® WLAN Driver Installation” on page 7-22.
- See “Qualcomm Atheros WLAN Combo Driver Installation” on page 7-23.

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the WLAN & Bluetooth module(s) are OFF if you are using the computer aboard aircraft by putting the system in to Airplane Mode (see Table 1-6, on page 1-21).
3rd Party 802.11b/g/n Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device Drivers & Utilities + User’s Manual disc into the DVD drive.
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Click Next.
5. Click Finish to restart the computer.
6. The operating system is the default setting for Wireless LAN control in Windows (see page 7 - 30).

Intel® WLAN Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device Drivers & Utilities + User’s Manual disc into the DVD drive.
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Click in the check box to agree to the End User License Agreement and click Install.
5. Click Finish.
6. The operating system is the default setting for Wireless LAN control in Windows (see page 7 - 30).
Qualcomm Atheros WLAN Combo Driver Installation

1. Make sure the system is not in Airplane Mode, and then insert the Device Drivers & Utilities + User’s Manual disc into the DVD drive.
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Click Next > Yes > Next.
5. Click Install.
6. Click Yes to restart the computer.
7. The operating system is the default setting for Wireless LAN control in Windows (see page 7 - 30), and “Bluetooth Configuration in Windows” on page 7 - 39 (note that no Bluetooth driver is required for this module).
8. See “Qualcomm Atheros Killer Network Manager” on page 7 - 24 for details of the application.
Qualcomm Atheros Killer Network Manager

You can use the Qualcomm Atheros Killer Network Manager to monitor your network connection (use the method outlined on page 7 - 30 to connect to a WLAN access point).

1. Go to the Qualcomm Atheros Killer Network Manager by double-clicking the icon in the Start screen or on the desktop app.
2. Click any of the menu headings on the left to access the menu:

**Overview**

The Overview window allows you view the system information, network connection status and a summary of applications using bandwidth.
PC Monitor
The PC Monitor logs performance information on the computer. Use the drop-down menu to select Processor, Memory, FPS (frames per second), Wireless Signal Strength and Internet Bandwidth. You can click on the graph to display the time and measurement at that point.

Figure 7 - 16
Killer Network Manager - PC Monitor
(Wireless Signal Strength)
Applications

The Applications window allows you to view network applications and prioritize how each one uses any available bandwidth. The numbers to the left indicate the current priority level for the application, from 1 - highest to 4 - lowest. Click in an application to expand the item, and click the number to change the priority level, or click Allow/Block to change the status.

Figure 7 - 17
Killer Network Manager - Applications

Changing Application Bandwidth

To change the Upload or Download bandwidth position your cursor over the arrow on the right side of the bar. Click and drag the icon to adjust the setting. This will now limit internet traffic for the application to this speed.
Network
Configure the network connection settings and internet provider bandwidth speed from the **Network** window. Click **Test** to run a test of your bandwidth, and when complete use the results to configure the optimal upload and download bandwidth for the Killer Network Manager (these are the maximum values displayed in Applications).

*Figure 7-18*
Killer Network Manager - Network
Advanced
Customize Killer Network Manager features from the Advanced window. Here you can change items displayed in Overview, configure default settings for Applications and features such as updates, closing dialog, bandwidth units displayed and performance statistics.

Figure 7-19
Killer Network Manager - Advanced
Quitting Killer Network Manager
Clicking the close icon simply minimizes the application to the system tray, and it will continue to run in the background. To quit the application right-click the icon in the system tray and select Quit from the menu.
WLAN Configuration in Windows

You can configure a wireless connection using one of the following options, however make sure the Wireless LAN module is turned on (and not in Airplane Mode) before configuration begins.

Charms Bar
1. Go to the **Charms Bar**.
2. Select **Settings** and then click the **WiFi icon** (it should read **Available** under the icon and **Airplane mode** should be **Off**).
3. A list of available access points will appear.

![WiFi Settings (Charms Bar) & Networks](Figure 7 - 21)
4. Double-click an access point to connect to it (or click it and click Connect).
5. Enter a network security key (password) if required, and click Next.
6. You can choose to find other devices or not.
7. When you are connected to the network access point it will display Connected.
8. Select any connected network and click Disconnect to disconnect from a connected access point.

9. You can click the Airplane Mode button to turn the mode (including Bluetooth) On or Off.
10. Alternatively you can click the WiFi button to turn just the WiFi On or Off.
Desktop Mode
1. Switch to the Windows Desktop (click the app or use the Windows logo key + D key combination).
2. Click the wireless icon in the notification area of the taskbar.
3. A list of available access points will appear.
4. Double-click an access point to connect to it (or click it and click Connect).
5. Enter a network security key (password) if required, and click Next.
6. You can choose to find other devices or not.
7. Select any connected network and click Disconnect to disconnect from a connected access point.

Figure 7 - 23
Windows Desktop Taskbar Notification Area WLAN Connection
Fingerprint Reader Module

The fingerprint reader module provides a high level of security for your computer. Make sure you have administrator’s rights to your computer, and have a *Windows* password enabled for full security protection.

There are two different fingerprint modules supplied with this model. Install the driver from the *Device Drivers & Utilities + User’s Manual* disc by following the appropriate instructions on the page overleaf.

The fingerprint reader module uses the *Sign-in options* configuration of the *Windows Account*.
AuthenTec Fingerprint Reader Driver Installation

1. Insert the *Device Drivers & Utilities + User’s Manual* disc into the CD/DVD drive.
2. Click **Option Drivers**.
3. Click **2.Install Fingerprint Driver > Yes**.
4. Click **Next**.
5. Click **Finish** to restart the computer.
6. The fingerprint reader module uses the **Sign-in options** configuration of the **Windows Account** (see overleaf).

BioExcess Fingerprint Reader Driver Installation

1. Insert the *Device Drivers & Utilities + User’s Manual* disc into the CD/DVD drive.
2. Click **Option Drivers**.
3. Click **2.Install Fingerprint Driver > Yes**.
4. Click **Next > Install**.
5. Click **Finish** to complete the installation.
6. The fingerprint reader module uses the **Sign-in options** configuration of the **Windows Account** (see overleaf).
AuthenTec Fingerprint Module Configuration

1. Go to the Charms Bar.
2. Select Settings and then click Change PC Settings.
3. Click Accounts and then click Sign-in options.
4. You will need to add a Windows password (click Add under Password).
5. After you have added the password you will need to restart the computer and use your password to log on to the system.
6. Go to the Charms Bar.
7. Select Settings and then click Change PC Settings.
8. Click Accounts and then click Sign-in options.
9. Click Add under Fingerprint.

Figure 7 - 24
Accounts - Sign-in Options
(Add Fingerprint)
10. Input the *Windows password* and click **OK**.
11. You will then be instructed to **swipe the same finger** across the reader a number of times.

Figure 7 - 25
Add a Fingerprint

12. Click **Finish**.
13. You can choose to **Add another** finger (this is recommended) or **Remove** the current fingerprint reading.
14. You can now scan your fingerprint to log-on to the computer.
Bluetooth & WLAN Combo Module

If your purchase option includes the Combination Wireless LAN & Bluetooth module (either Intel® or 3rd Party) then install the driver as instructed overleaf.

Make sure that the module is on (i.e. the system is not in Airplane Mode) before installing the driver.

Note that you need to install both the WLAN & Bluetooth drivers for the WLAN & Bluetooth Combo modules, however the Qualcomm Atheros WLAN (Combo) module only requires the WLAN driver installation.
3rd Party Bluetooth (V4.0) Combo Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device Drivers & Utilities + User’s Manual disc into the DVD drive.
2. Click Option Drivers (button).
3. Click 3. Install Combo BT Driver > Yes.
4. Click Next.
5. Click Finish to restart the computer.

Intel Bluetooth Combo Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device Drivers & Utilities + User’s Manual disc into the DVD drive.
2. Click Option Drivers (button).
3. Click 3. Install Combo BT Driver > Yes.
4. Click Next > Next.
5. Click in the check box to accept the license and click Next.
6. Click Next > Finish.
7. See “Bluetooth Configuration in Windows” on page 7 - 39 for configuration instructions.

Note that no Bluetooth driver is required for the Qualcomm Atheros WLAN (Combo) module.

High Speed Bluetooth Data Transfer
The Combination Wireless LAN & Bluetooth module supports high speed data transfer. However, to achieve such transfer speeds, both devices must support high speed data transfer.

To obtain high speed data transfer make sure that both the WLAN and Bluetooth modules are powered on.

Check your Bluetooth compatible device’s documentation to confirm it supports high speed data transfer.
Bluetooth Configuration in Windows

You can configure a Bluetooth connection as below, however make sure the Bluetooth module is on (or the system is not in Airplane Mode) before configuration.

**Desktop Mode**
1. Switch to the Windows Desktop (click the App or use the Windows logo key `+ D` key combination).
2. Click the notification area of the taskbar and double-click the Bluetooth icon (or click and select *Show Bluetooth Devices*).
3. The **Bluetooth** item in *PC and Devices* will appear.

OR

**Charms Bar**
1. Go to the **Charms Bar**.
2. Select **Settings** and then click **Change PC Settings**.
3. Select the **Bluetooth** item in *PC and Devices*.

---

**Figure 7 - 26**
Bluetooth Taskbar Icon & Change PC Settings (Charms Bar -Settings)
4. Make sure that Bluetooth is turned on and a list of discovered devices will appear.
5. Double-click the device you want to pair with the computer and click **Pair**.
6. On first connection the computer will provide you with a pairing code to be entered onto the device.
7. Enter the code into your Bluetooth enabled device and click **Yes** on the computer to complete the pairing.
8. Select a device and click **Remove Device** to disconnect from any device.
To Make your Computer Discoverable to Bluetooth Devices
1. Switch to the Windows Desktop (click the app or use the Windows logo key + D key combination).
2. Click the notification area of the taskbar, click the Bluetooth icon and click Open Settings.
3. Click Options, and make sure that Allow Bluetooth devices to find this computer check box (Discovery) has a check inside it.
4. Make sure that the Alert me when a new Bluetooth device wants to connect check box (Connections) has a check inside it, if you want to be notified when a Bluetooth device wants to connect.

Figure 7 - 29
Bluetooth Settings
Trusted Platform Module

The **TPM security chip** allows you to create and manage digital certificates for user and platform authentication. This type of security is usually administered within large enterprises and organizations, and therefore requires implementation by a system administrator before users can access security features.

Individual users can use the TPM as an authentication with the fingerprint reader.

Make sure you have administrator’s rights to your computer, and have a *Windows* password enabled for full security protection. In addition **Make sure you prepare a removable media (e.g. a USB flash drive) to store passwords etc. before beginning the TPM initialization process.**

Before setting up the TPM functions you must initialize the security platform.
Enabling & Activating TPM

1. Restart the computer.
2. Enter the Aptio Setup Utility pressing F2 during the POST/startup.
3. Use the arrow keys to select the Security menu.
4. Select TPM Configuration and press Enter to access the sub-menu.
5. Press Enter to access the Security Device Support menu and select Enable to display the full TPM configuration menu.
6. Select TPM State, press Enter and select Enable to change the TPM state to enabled. You will then need to press F4 to save the changes and restart the computer.

7. As the computer restarts press F2 to enter the BIOS again and go to the TPM Configuration menu.
8. Select **Pending operation**, press Enter and select the option you require (if you are initializing TPM you should select **Enable Take Ownership**). You will then need to press **F4** to save the changes and restart the computer.

![Figure 7-31 Pending TPM operation (Enable Take Ownership)](image)

9. You can now install the **TPM driver** (see “**Trusted Platform Module (TPM) Driver Installation**” on page 7-45) and then initialize the TPM.
Trusted Platform Module (TPM) Driver Installation

1. Make sure you have enabled and activated the TPM in the BIOS before installing the driver.
2. Insert the Device Drivers & Utilities + User’s Manual disc into the DVD drive.
3. Click Option Drivers (button).
4. Click 4.Install TPM Driver > Yes.
5. Click Next.
6. Click the button to accept the license and click Next.
7. Click Next > Next > Install.
8. Click Finish > Yes to restart the computer.
### Initializing TPM

1. Switch to the Desktop app and click the TPM icon right-click the icon in the notification area of the taskbar, and select **Security Platform Initialization** (or click the **Security Platform State** taskbar bubble).
2. Click **User Settings** (tab) and click Yes, or right-click the icon in the notification area of the taskbar, and select **Security Platform Initialization** (or click the **Security Platform State** taskbar bubble).
3. The **Quick Initialization** method will automatically be selected for you (if you need to use advanced settings provided by your network administrator then select **Advanced Initialization**).
4. You will need to use a removable media (e.g. a USB Flash Drive) to store passwords and data (keep the media in a safe place until required).
5. Select the drive you want to use from the drop-down menu and click **Next**.

![Security Platform Quick Initialization Wizard](image-url)
6. Choose the **Security Platform Features** you want to use by clicking the appropriate check box.
7. Enter a **Basic User Password** (and re-type to confirm it) and click **Next**.

8. Click **Next** to confirm the settings.
9. The computer will then initialize the settings.
10. Click **Finish**.
11. Click the tabs and control panels to adjust the settings.
12. Double-click the icon in the taskbar notification area to access the **Infineon Security Platform Settings Tool**, or right-click the icon and select a menu item.

**Figure 7 - 33**
Settings
Infineon Security Platform Settings Tool

The Infineon Security Platform Settings Tool allows you to manage and check the TPM state, manage your password information, and to backup and restore the TPM data. As TPM is usually administered within large enterprises and organizations, your system administrator will need to assist you in managing the information here.

Menus

Note that not all the menus pictured here will be available for access. The menu items that appear will be dependent on your configuration settings etc. (see the Help file for full details).

Figure 7 - 34
Infineon Security Platform Settings Tool
User Settings
This page allows the settings to be configured for the currently logged in Infineon Security Platform user including the ability to change the password, configure secure e-mail, file and folder encryption and Enhanced Authentication. You can also import or delete certificates protected by the security platform.

Figure 7 - 35
Infineon Security Platform Settings Tool (User Settings)
Backup
Here you can configure backup and restore operations. Backup files contain the computer identification and user identification information which is used to match the machine name and user name with the current machine and user during restoration.

Figure 7 - 36
Infineon Security Platform Settings Tool (Backup)
**Migration**

The Migration tab is used to help securely transfer keys and certificates from one platform to another.

![Infineon Security Platform Settings Tool (Migration)](image-url)
Password Reset
Use Password Reset to reset basic user passwords when required.

Figure 7-38
Infineon Security Platform Settings Tool
(Password Reset)
BitLocker

BitLocker Drive Encryption can be used in conjunction with the TPM to encrypt data on the disk and is done via the Microsoft BitLocker Control Panel Applet. Click Configure and select a drive to be encrypted and then follow the Wizard to begin the encryption process.

Figure 7-39
Infineon Security Platform Settings Tool (BitLocker)
Access the Microsoft **BitLocker Drive Encryption** control panel applet from the *Windows* control panel (*System and Security*).

*Figure 7 - 40  
BitLocker Drive Encryption*
Advanced
Configure all the Security Platform owner and policy settings from the Advanced tab. The settings that can be changed are for the local computer only.

Figure 7-41
Infineon Security Platform Settings Tool (Advanced)
Intel® Rapid Storage Technology

The Intel Rapid Storage Technology application provides high-performance SATA and SATA RAID capabilities. Install the Intel Rapid Storage Technology application (after installing all necessary drivers in the correct order) to support your RAID system or SATA drive if set up in AHCI mode in the BIOS (see “SATA Mode (Advanced Menu)” on page 5 - 9).

IRST Driver Installation

1. Insert the Device Drivers & Utilities + User’s Manual disc into the DVD drive.
2. Click Option Drivers (button).
3. Click 5.Install IRST Driver > Yes.
4. Click Next.
5. Click the check box to accept the license and click Next.
6. Click Next > Next > Next.
7. Click Finish to restart the computer.

See the following pages for more information if you have set your hard disks up in a RAID configuration.
Intel® Rapid Storage Technology for RAID Systems

Intel® Rapid Storage Technology application displays status information on your RAID configuration. Run the Intel® Rapid Storage Technology application from the item in the Start menu.

When the Intel® Rapid Storage Technology application is launched the system will open the Status window. Here you can view the general health of the storage system. Various volume creation and management options are available depending on the system’s status.
Intel® Rapid Storage Technology Help

If a hard drive member of a RAID volume is reported as “Degraded” or “Failed” it may be possible to recover the volume. If the volume cannot be restored then you will need to recreate the RAID volume and restore the data from a back up. Click the Help menu (or press F1) for instructions on how to recover or recreate RAID Volumes.
RAID Volume Data Verification and Repair

The RAID volume data verification process identifies any inconsistencies or bad data on a RAID 0 or RAID 1 volume. The table outlines what occurs for each RAID level:

<table>
<thead>
<tr>
<th>RAID Level</th>
<th>Verify</th>
<th>Verify &amp; Repair</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID 0</td>
<td>Bad blocks are identified.</td>
<td>N/A</td>
</tr>
<tr>
<td>RAID 1</td>
<td>Bad blocks are identified.</td>
<td>Bad blocks are reassigned.</td>
</tr>
<tr>
<td></td>
<td>Data on the mirrored drive is compared to</td>
<td>If the data on the mirrored drive does not</td>
</tr>
<tr>
<td></td>
<td>data on the source drive.</td>
<td>match the data on the source drive, the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>data on the mirrored drive is overwritten</td>
</tr>
<tr>
<td></td>
<td></td>
<td>by the data on the source.</td>
</tr>
</tbody>
</table>

Table 7 - 2
RAID Level Verification & Repair Status

Replacing and Reverting Recovery and Master Volumes

If a master or recovery drive fails you will need to add a new identical drive and rebuild the recovery volume to the drive. You can also revert the master drive to the state of the previous volume update. For details on how to do this see the help file “Intel® Rapid Storage Technology Help” on page 7 - 58.

See over for details on how to verify and repair RAID volume data. Verification will identify and repair data inconsistencies on the volume.
Verifying and Repairing RAID Volume Data
1. Before verifying the volume data you will need to initialize the volume.
2. Run the Intel® Rapid Storage Technology application.
3. Click to select the RAID in the pane on the right side of the window.
4. Click Manage and click Advanced.
5. Click Initialize and click Yes (button) to begin the process.
6. The completion percentage will be listed under Status.
7. Click **Advanced** and click **Verify**, then click **Verify** (button) to begin the process.  
8. The completion percentage will be listed under **Status** (verifying and repairing).
Intel® Rapid Start Technology Driver

Intel(R) Rapid Start Technology can resume power from Hibernation within 5 to 6 seconds and can remember your computer's previous state with zero power.

System Requirements to support Intel® Rapid Start Technology:
• Rapid Start Technology should be enabled in the BIOS (see “Intel(R) Rapid Start Technology (Advanced Menu)” on page 5 - 8).
• Intel Rapid Storage Technology software installed.
• A Solid State Drive (SSD) with a minimum capacity of 18.6GB.
• The Solid State Drive (not the HDD) must be configured as outlined on the following pages to support Rapid Start Technology.
• The Windows operating system must be installed on the system hard disk drive, and not on the Solid State Drive (SSD).

Operating System Installation

Note that in order for Intel(R) Rapid Start Technology to function properly the Windows operating system must be installed on the system hard disk drive (e.g. the "C:" drive), and the SSD should be configured as outlined on the following pages. Rapid Start will not function if the operating system is installed on the SSD.

See overleaf for instructions on enabling Intel® Rapid Start Technology.
Intel® Rapid Start Technology Configuration

1. Enable/disable Intel(R) Rapid Start Technology from the BIOS (see “Intel(R) Rapid Start Technology (Advanced Menu)” on page 5 - 8).
2. Go the Windows control panel and double-click Administrative Tools (System and Security)> Computer Management > Storage > Disk Management
3. Right-click the SSD and select Shrink Volume from the menu.
4. Enter the figure, which should be equal to amount of system memory (RAM) in your computer, in “Enter the amount of space to shrink in MB”.

Figure 7 - 47
Shrink Volume Size

5. Click Shrink (any unallocated file space may be formatted for storage use).

Memory Size (Amount of Space to Shrink)

The figure entered in the “Enter the amount of space to shrink in MB” field above should be equal to the amount of system memory in your computer. In the example above the system memory is 4GB (1024MB * 4 = 4096GB). If you are unsure of your total system memory (RAM) then go to System control panel (System and Security) and check Installed memory (RAM). The memory size will be displayed in GB so convert by multiplying the GB figure by 1024 to get the total in MB (e.g. 8GB = 8192MB).
6. Run the Desktop app and right-click the lower left hot corner (or use the *Windows Logo Key* + X key combination) and select **Command Prompt (Admin)**.

7. Type “DISKPART”.

8. At the DISKPART command type “list disk”.

---

**Figure 7 - 48**
Search for CMD Prompt

**Figure 7 - 49**
Diskpart - List Disk
9. Type "select disk #" (# is disk number where you want to create the store partition, so refer to the results obtained from "list disk" for exact disk number).
10. The message "Disk # is now the selected disk." will appear.
11. Type "create partition primary".

Figure 7 - 50
Diskpart - Select Disk #

Figure 7 - 51
Diskpart - Create Partition
13. Type “detail disk”.

14. Type “select Volume #” (# is volume of your storage partition so refer to results obtained from "detail disk" for the exact volume number).

15. The message “Volume # is now the selected volume.” will appear.
16. Type the following, depending on the format of the SSD.
   - For **MBR** formatted SSDs: “set id=84 override” (the id must be set to 84).
   - For **GPT** formatted SSDs: “set id=D3BFE2DE-3DAF-11DF-BA40-E3A556D89593”.

17. The message “DiskPart successfully set the partition ID.” will appear.
18. Close the CMD window.
20. The disk partition should read Healthy Hibernation Partition.

21. Restart the computer.
22. Install the driver (see below).

**Intel® Rapid Start Technology Driver Installation**

1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Option Drivers (button).
3. Click 6.Install Rapid Start Driver > Yes.
4. Click Next > Next > Yes > Next > Next.
5. Click Finish to restart the computer.
Sound Blaster Audio

Install the Sound Blaster AP to allow you to configure the audio settings to your requirements for the best performance in games, music and movies.

Sound Blaster X-Fi MB-3 Audio AP Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Click Option Drivers (button).
3. Click 7.Install SBX-Fi MB 3 AP > Yes.
4. Click Next > Yes to accept the license.
5. Click Next > Full Installation (button).
6. Click Next > Finish to restart the computer.

Run the Sound Blaster X-Fi 3 control panel from the notification area of the taskbar (or from the item in the Start menu). Click on the tabs to access the any of the control panel menus.
Volume Controls
You can click on the volume dials to adjust the level for either the microphone or master volume. You can choose to save the settings for Music, Movie or Game, and these settings can be exported or imported as required.

Figure 7 - 57
Sound Blaster X-Fi 3 Volume Controls
SBX Pro Studio
Click the check box to enable/disable the control, and use the slider to adjust the levels. Press the play button to test settings.

- **Crystalizer:** Enhances audio to make it sound livelier.
- **Surround:** Provides virtual sound channels to control the level of immersion.
- **Bass:** Enhances the bass level of the sound system.
- **Dialog Plus:** Enhances dialogue levels for movies etc.
- **Smart Volume:** Minimizes sudden volume changes to avoid the need for constant adjustment. It is recommended that this is set to **Loud** (see sidebar).
Scout Mode
Click in the box to enable Scout Mode to enhance your ability to hear enemies in games from a further distance away than would normally be possible.

Figure 7 - 59
Sound Blaster X-Fi 3
Scout Mode
Voice FX
Click in the box to enable Voice FX and click on the sliders to adjust the settings. Select the mode required from the dropbox, and click on Test to hear the playback of the effect.

Figure 7 - 60
Sound Blaster X-Fi 3
Voice FX
EAX Effects & EQ
Click to select either/or EAX Effects or EQ, select the mode required from the drop-box and click on the sliders to adjust the settings. Click on Save to save any custom changes to the set levels and effects.

Figure 7 - 61
Sound Blaster X-Fi 3
EAX Effects & EQ
Advanced Settings
Select the speaker/headphone configuration from the dropbox, and click on Test to hear the effect. You can also adjust the Bass Management by clicking the Bass Redirection and Subwoofer Gain, and click on the slider to adjust the Crossover Frequency.
Hot Key Configuration
Click Configure Hot Keys in Scout Mode or Advanced Settings menus to access the Hot Key Configuration menu. Click Enable All Hot Keys, and then click on the task and press the key sequence required. Any hotkeys chosen will be locked by the application, and therefore will not be able to be used in other applications.

Figure 7 - 63
Sound Blaster X-Fi 3
Hot Key Configuration
Creative ALchemy
The Creative ALchemy application can be run from the shortcut in the Start menu. Use the left menu to select any installed games and click the button to move them to the right column to enable ALchemy support for the game. Creative ALchemy restores hardware accelerated audio to enable EAX effects and 3D Audio when playing Direct Sound3D games.

Creative Software AutoUpdate
Run the application from the shortcut in the Start menu and make sure you are connected to the internet, then click Next and follow the on screen instructions to update the software.

Sound Blaster Audio & HDMI
1. When you connect an HDMI display to the HDMI-Out port, the Sound Blaster Cinema controls will be disabled.
2. A warning box will pop-up and will prompt “...Do you want to select another audio device now?”.
3. Click No to continue using the HDMI audio output from your external display (do not attempt to select another audio device when connected to the external HDMI display).
Wireless Display

**Wireless Display** uses your Wireless LAN module/WLAN Bluetooth Combo module (you need to make sure that your video adapter/display device is compatible with your particular WLAN/Combo module) in conjunction with a compatible video adapter/display device (purchased separately) to allow you to display the contents of the notebook display on another display (e.g. HDTV), without the need to have cables stretching across a room.

You can use the wireless display to play games, browse the internet, display videos or photo slide shows on your TV/external display without using HDMI or A/V cables.

Before configuring **Wireless Display** you will need to set up your compatible adapter with your display/speakers. Connect the adapter using an HDMI or A/V cable and turn on the display (or in the case of speakers connect them to the wireless speaker adapter with the cables provided with the adapter), and then set the display to the appropriate input channel (see the documentation supplied with your compatible adapter/display for full details).

Note that no driver or application is required for wireless display in *Windows 8.1*. 
Wireless Display Configuration

1. Note that no driver or application is required for wireless display in Windows 8.1.
2. Go the Charms Bar, select Devices.
3. Click Project.
4. Click Add a wireless display.

Figure 7 - 64
Add a Wireless Display
5. The system will then search for compatible display devices (this may take up to 60 seconds so allow time for this to complete).

6. Double-click any detected display device in the list.
7. You may then need to input a pin number for the device to which you are connecting.
8. Click Next.
9. The display will then connect (for specific settings for your display see the documentation supplied with your compatible adapter/display for full details).
10. Go to the **Project** menu (Charms Bar > Devices) and click **Disconnect** to temporarily disconnect from the wireless display.
11. To permanently disconnect from the display (you will need to go back through the connection process again) you can select it in **PC and Devices > Devices** and click **Remove Device > Yes**.

*Figure 7-67*  
Remove Device/Disconnect
Chapter 8: Troubleshooting

Overview

Should you have any problems with your computer, before consulting your service representative, you may want to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface. If all else fails, talk to your service representative. You should also make a record of what happened and what remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call your service representative.
Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer appears not to be working.

- **Power** - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, make sure it is actually working. Check the LED Power Indicators (see “LED Indicators” on page 1 - 11) to see the computer’s power status.

- **Connections** - Check all the cables to make sure that there are no loose connections anywhere.

- **Power Savings** - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys configured in your Power Options (see “Configuring the Power Buttons” on page 3 - 9), the Fn + F4 key combination, or power button to wake-up the system.

- **Brightness** - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the brightness (see Table 1 - 6, on page 1 - 21).

- **Display Choice** - Press Fn + F7 to make sure the system is not set to “external only” display.

- **Boot Drive** - Make sure there are no optical media and/or USB storage devices in any connected drive when you start up your machine (this is a common cause of the message “Invalid system disk - Replace the disk, and then press any key” / “Remove disks or other media. Press any key to restart”).
Backup and General Maintenance

- Always backup your important data, and keep copies of your OS and programs safe, but close to hand. Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a CD wallet.

- Run maintenance programs on your hard disk and OS as often as you can. You may schedule these programs to run at times when you are not using your computer. You can use those that are provided free with your OS, or buy the more powerful dedicated programs to do so.

- Write down your passwords and keep them safe (away from your computer). This is especially important if you choose to use a Boot password for the SCU (see “Security Menu” on page 5 - 11).

- Keep copies of vital settings files such as network, dialup settings, mail settings etc. (even if just brief notes).

Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your warranty.
Troubleshooting

Viruses

• Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm your computer and cause you to lose data. Anti-Virus programs are commercially available and the definitions file updates are usually downloadable directly from the internet.

• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-mail attachments so take care when opening any attached file. You can configure most Anti-Virus programs to check all e-mail attachments. Note: You should also beware of files from people you know as the virus may have infected an address book and been automatically forwarded without the person’s knowledge.

• Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic information which allows you to startup your computer) handy. You may refer to your OS’s documentation for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at least instructions on how to make one).
Upgrading and Adding New Hardware/Software

- Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are doing, otherwise you will risk severely damaging your system.

- Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what you are doing.

- Read the documentation. We can assume, since you are reading this that you are looking at the computer’s manual, but what about any new peripheral devices you have just purchased? Many problems are caused by the installation of new hardware and/or software. Always refer to the documentation of any new hardware and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

- When installing a new device always make sure the device is powered on, and in many cases you will need to restart the computer. Always check that all the cables are correctly connected.

- Make sure you have installed the drivers for any new hardware you have installed (latest driver files are usually available to download from vendor’s websites).

- Thoroughly check any recent changes you made to your system as these changes may affect one or more system components, or software programs. If possible, go back and undo the change you just made and see if the problem still occurs.
Troubleshooting

• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may be found; **Example** - if your computer has many devices plugged into its ports, and a number of programs running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and removing devices and restarting where necessary) will often find the source of a problem, although this may be time consuming.
## Troubleshooting

### Problems and Possible Solutions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You turned on the power but it doesn’t work.</td>
<td><strong>Battery missing / incorrectly installed.</strong> Check the battery bay, make sure the battery is present and seated properly (the design of the battery only allows it to go in one way). Make sure there’s nothing interfering with the battery contacts.</td>
</tr>
<tr>
<td>The battery LED power indicator  is blinking orange.</td>
<td><strong>Low Battery.</strong> Plug in the DC power source. If the computer doesn’t start up immediately, turn it off then on again.</td>
</tr>
<tr>
<td>You are losing battery power too quickly.</td>
<td><strong>The system is using too much power.</strong> If your OS has a Power Options scheme (see &quot;Power Plans&quot; on page 3 - 5) check its settings. You may also be using a peripheral device/USB device that is drawing a lot of power.</td>
</tr>
</tbody>
</table>
| Actual battery operating time is shorter than expected.               | **The battery has not been fully discharged before being recharged.** Make sure the battery is fully discharged and recharge it completely before reusing (see “Battery Information” on page 3 - 14).  
**Power Options have been disabled.** Go to the Control Panel in Windows and re-enable the options.  
**A peripheral device/USB device is consuming a lot of power.** Turn off/remove the unused device to save power. |
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The computer feels <strong>too hot</strong>.</td>
<td>Make sure the computer is properly ventilated and the Vent/Fan intakes are not blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn it off for an hour. Make sure the computer isn’t sitting on a thermal surface (see “Overheating” on page 1 - 28 - 1 - 31). Make sure you’re using the correct adapter. Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the Vent/Fan intakes to be blocked.</td>
</tr>
<tr>
<td>Nothing appears on screen.</td>
<td><strong>The system is in a power saving mode.</strong> Toggle the sleep/resume key combination, Fn + F4 (see “Configuring the Power Buttons” on page 3 - 9). <strong>The screen controls need to be adjusted.</strong> Toggle the screen control key combinations Fn + F8/F9. If you’re connected to an external monitor, make sure it’s plugged in and turned on. You should also check the monitor’s own brightness and contrast controls. <strong>The computer is set for a different display.</strong> Toggle the screen display key combination, Fn + F7. If an external monitor is connected, turn it on. <strong>The screen saver is activated.</strong> Press any key or touch the TouchPad.</td>
</tr>
<tr>
<td>No image appears on the <strong>external monitor</strong> I have plugged in and powered on.</td>
<td>You haven’t installed the video driver and configured it appropriately from the Control Panel. See Appendix C for instructions on installing and configuring the video driver.</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You forget the <strong>boot password</strong>.</td>
<td>If you forget the password, you may have to discharge the battery of the CMOS. Contact your service representative for help.</td>
</tr>
<tr>
<td>The sound cannot be heard or the <strong>volume is very low.</strong></td>
<td><strong>The volume might be set too low.</strong> Check the volume control in the <strong>Volume Control Panel</strong> in the Windows notification area, or use the key combination <strong>Fn + F5</strong> and <strong>F6</strong> (see “<strong>Keyboard Shortcuts</strong>” on page 1 - 20) to adjust.</td>
</tr>
<tr>
<td>The <strong>CD/DVD cannot be read.</strong></td>
<td><strong>The CD/DVD is dirty.</strong> Clean it with a CD/DVD cleaner kit.</td>
</tr>
<tr>
<td>The <strong>CD/DVD tray will not open</strong> when there is a disc in the tray.</td>
<td><strong>The CD/DVD is not correctly placed in the tray.</strong> Gently try to remove the disc using the eject hole (see “<strong>Loading Discs</strong>” on page 2 - 3).</td>
</tr>
<tr>
<td>The <strong>DVD regional codes</strong> can no longer be changed.</td>
<td><strong>The code has been changed the maximum 5 times.</strong> See “<strong>DVD Regional Codes</strong>” on page 2 - 5.</td>
</tr>
<tr>
<td><strong>Unwelcome numbers</strong> appear when typing.</td>
<td><strong>Num Lock is turned ON</strong> (see “<strong>LED Indicators</strong>” on page 1 - 11).</td>
</tr>
</tbody>
</table>

---

**Password Warning**

If you choose to set a boot password, **NEVER** forget your password. The consequences of this could be serious. If you cannot remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <strong>system freezes</strong> or the screen goes dark.</td>
<td><strong>The system’s power saving features have timed-out.</strong> Use the AC/DC adapter, press the sleep (Fn + F4) key combination, or press the power button if no LEDs are lit.</td>
</tr>
<tr>
<td>The system never goes into a <strong>power saving mode</strong>.</td>
<td>Power Options features are not enabled. Go to the <em>Windows</em> Power Options menu and enable the features you prefer (see “Power-Saving States” on page 3 - 7). Make sure you have enabled Hibernate mode from the control panel.</td>
</tr>
<tr>
<td>The <strong>Wireless LAN/Bluetooth</strong> modules cannot be detected.</td>
<td><strong>The modules are off as the computer is in Airplane Mode.</strong> Check the LED indicator to see if it is in Airplane Mode (see “LED Indicators” on page 1 - 11). Use the Fn + F11 key combination to toggle Airplane Mode on/off (see Table 1 - 6, on page 1 - 21).</td>
</tr>
<tr>
<td>The <strong>PC Camera</strong> module cannot be detected.</td>
<td><strong>The module is off.</strong> Press the Fn + F10 key combination in order to enable the module (see “Function Keys &amp; Visual Indicators” on page 1 - 21). Run the camera application to view the camera picture.</td>
</tr>
</tbody>
</table>

### Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not work.
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <strong>Wireless LAN/Bluetooth</strong> modules cannot be configured.</td>
<td>The driver(s) for the module(s) have not been installed. Make sure you have installed the driver for the appropriate module (see the instructions for the appropriate module in “Wireless LAN Module” on page 7 - 21 and/or “Bluetooth &amp; WLAN Combo Module” on page 7 - 37).</td>
</tr>
<tr>
<td>A file cannot be copied to/from a connected <strong>Bluetooth</strong> device.</td>
<td><em>The transfer of data between the computer and a Bluetooth enabled device is supported in one direction only (simultaneous data transfer is not supported).</em> If you are copying a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Bluetooth enabled device to your computer until the file transfer process has been completed.</td>
</tr>
</tbody>
</table>
| I cannot obtain high speed Bluetooth data transfer.                    | *To obtain high speed Bluetooth data transfer take into account the following:*  
  - To achieve high speed transfer speeds, **both devices must support high speed data transfer** (i.e both the computer and the Bluetooth compatible device you are connecting to).  
  - Check your Bluetooth compatible device’s documentation to confirm it supports high speed data transfer, and for configuration information. |
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
</table>
| The computer is off (or in Sleep Mode) but powered by the AC/DC adapter plugged in to a working outlet, or by battery with a capacity above 20%. I have plugged a device into the powered USB port in order to charge it, but the device is not charging. | The port is not powered on. Toggle power to the port using the **Fn + power button** combination.  
This function may not work with certain external USB compliant devices (check your device’s documentation). If this is the case, power the computer on and connect the external USB device in order to charge it.  
**Note** that this function is designed to help charge USB compliant devices, but is **not designed to allow their operation**.  
**Note** that this function is designed to help charge USB compliant devices, but is **not designed to allow their operation**. |
| **No sound** can be heard through an HDMI connected display.            | You have not configured the HDMI audio output. See “HDMI Audio Configuration” on page C - 27.                                                                                                                                |
| **Audio Volume is too low** when listening through **headphones**.      | You have set the Speaker Configuration to 5.1 or 7.1 Speaker. It is recommended that you set the Speaker Configuration to **Stereo** (not to 5.1 or 7.1 Speaker) when listening through headphones in order to maximize audio quality. See “Audio Features” on page 2 - 7. |
| The **Sound Blaster** audio controls don’t work when the system is connected to an external display through an HDMI cable.      | **Note** that Sound Blaster Audio will be disabled when you are connecting to an external display through an HDMI connection. See “Sound Blaster Audio & HDMI” on page C - 29. |
| The **fingerprint reader** has problems scanning fingers.              | When fingers are wet or sweaty the software application may have difficulty reading a scanned finger. Make sure your fingers are clean and dry when attempting to scan them across the sensor for detection. |

8 - 12 Problems and Possible Solutions
I have used **Update Driver** in **Device Manager** (Unknown device > Other Devices) to try and install the **Airplane Mode** driver. **Windows** encountered a problem in attempting to update the driver, and a **yellow exclamation mark** appears in **Device Manager** against the **Unknown device**.

It is very important that the drivers are installed in the order indicated in Chapter 4 (which is the numbered installation order on the Device Drivers & Utilities + User’s Manual disc). This issue can occur when drivers are manually installed, and not in the correct order.

If you have attempted to **Update Driver** from the **Device Manager** control panel and have encountered problems, then use the method below to correct this:

**To correct this problem:**

1. Go to the **Programs and Features** (**Programs**) control panel in **Windows**.
2. Select any installed Airplane Mode driver item (e.g. Insyde Airplane Mode HID Mini-Driver), and click **Uninstall/Change** to uninstall the current driver.
3. Restart the computer.
4. Insert the **Device Drivers & Utilities + User’s Manual disc** and click **Install Drivers** (button).
5. Double-click the **Airplane Driver** item in the menu.
6. Follow the instructions to install the correct driver (you will need to restart the computer as part of the installation process).
I have connected a Bluetooth Mouse but it loses the Bluetooth connection and no longer responds after a short period of inactivity.

This is an issue with this mouse model and the Intel Wireless 7260 WLAN and Bluetooth combo module series. To resolve this issue do the following:

1. Go to the Device Manager control panel in Windows.
2. Click the arrow alongside Bluetooth to expand the menu if required.
3. Double-click Intel(R) Wireless Bluetooth(R) 4.0 + HS Adapter.
4. Click the Power Management tab.
5. Make sure that the check box alongside “allow the computer to turn off this device to save power” doesn’t have a check alongside it.
6. Click OK and close the control panel.

**Figure 8 - 1 - Device Manager (Bluetooth)**
When using a Bluetooth headset the audio appears to be mono and not stereo.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>This is a common issue with Bluetooth headsets. To resolve this issue do the following (you will need to repeat this procedure after every boot up, restart, or when the system resumes from hibernation):</td>
<td></td>
</tr>
<tr>
<td>1. Go to the Devices &amp; Printers control panel in Windows.</td>
<td></td>
</tr>
<tr>
<td>2. Double-click the Bluetooth headset.</td>
<td></td>
</tr>
<tr>
<td>3. Click Connect to complete the stereo connection.</td>
<td></td>
</tr>
<tr>
<td>OR</td>
<td></td>
</tr>
<tr>
<td>1. Go to the Sound control panel in Windows.</td>
<td></td>
</tr>
<tr>
<td>2. Right-click (in the Playback tab) the Bluetooth Stereo Audio device (the default device is Headset).</td>
<td></td>
</tr>
<tr>
<td>3. Click Connect to complete the stereo connection.</td>
<td></td>
</tr>
</tbody>
</table>
Troubleshooting
Appendix A: Interface (Ports & Jacks)

Overview

The following chapter will give a quick description of the ports & jacks which allow your computer to communicate with external devices, connect to the internet etc.
## Interface (Ports & Jacks)

### Ports and Jacks

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Card Reader</td>
<td>The card reader allows you to use the following digital storage cards: MMC (MultiMedia Card) / RSMMC SD (Secure Digital) / Mini SD / SDHC / SDXC MS (Memory Stick) / MS Pro / MS Duo Push the card into the slot and it will appear as a removable device.</td>
</tr>
<tr>
<td>DC-In Jack</td>
<td>Plug the supplied AC/DC adapter into this jack to power your computer.</td>
</tr>
<tr>
<td>DisplayPort / Mini DisplayPort</td>
<td>The DisplayPort is a digital display interface standard that allows a digital audio/video interconnect, between the computer and its external display or a home-theater system. The Mini DisplayPort is a miniatuarized version of the DisplayPort.</td>
</tr>
<tr>
<td>e-SATA / USB 3.0 Combo Port</td>
<td>This e-SATA (external Serial Advanced Technology Attachment) port allows you to plug-in external Serial ATA hard drives. This port also serves as a USB 3.0 port.</td>
</tr>
</tbody>
</table>
## Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDMI-Out Port</td>
<td>The HDMI-Out (<a href="https://en.wikipedia.org/wiki/High-Definition_Multimedia_Interface">High-Definition Multimedia Interface</a>) port is an audio/video connector interface for transmitting uncompressed digital streams. This allows you to connect an external monitor, TV or Flat Panel Display etc. as a display device (see “Attaching Other Displays” on page C - 21) by means of a HDMI cable. <strong>Note</strong> that HDMI carries both audio and video signals.</td>
</tr>
<tr>
<td>Headphone-Out Jack</td>
<td><strong>Headphones</strong> or <strong>speakers</strong> may be connected through this jack. <strong>Note</strong>: Set your system’s volume to a reduced level before connecting to this jack.</td>
</tr>
<tr>
<td>Line-In Jack</td>
<td>The Line-In jack allows you to play audio sources through the computer’s speakers. Note that audio input through Line-in will default to the <strong>mute</strong> setting. To set up your audio sources to play through the Line-in jack go to the <strong>Sound</strong> control panel and make sure the Mute box is not checked.</td>
</tr>
<tr>
<td>Microphone-In Jack</td>
<td>Plug an external microphone in to this jack to record on your computer.</td>
</tr>
</tbody>
</table>
## Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mini-IEEE 1394a Port</td>
<td>This allows high-speed connection to various peripheral devices, e.g. external disk drives and digital cameras (see note below).</td>
</tr>
<tr>
<td></td>
<td><strong>IEEE 1394</strong></td>
</tr>
<tr>
<td></td>
<td>The Mini-IEEE 1394 ports only support <strong>SELF POWERED</strong> IEEE 1394 devices.</td>
</tr>
<tr>
<td>RJ-45 LAN Jack</td>
<td>This port supports LAN (Network) functions. <strong>Note:</strong> Broadband (e.g. ADSL) modems usually connect to the LAN port.</td>
</tr>
<tr>
<td>S/PDIF-Out Jack</td>
<td>This S/PDIF (<strong>Sony/Philips Digital Interface Format</strong>) Out Port allows you to connect your DVD-capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.</td>
</tr>
<tr>
<td>Security Lock Slot</td>
<td>To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be purchased at any computer store.</td>
</tr>
</tbody>
</table>
## Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB 2.0/1.1 Ports</td>
<td>These USB (<a href="https://en.wikipedia.org/wiki/Universal_Serial_Bus">Universal Serial Bus</a>) 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into the computer, and unplugged from the computer, without the need to turn the system off (if the power rating of your USB device is 500mA or above, make sure you use the power supply which comes with the device). The USB 3.0 ports are denoted by their blue color; USB 2.0 ports are colored black. USB 3.0 will transfer data much faster than USB 2.0, and is backwards-compatible with USB 2.0. Note: The powered USB 3.0 port (see <a href="#">Figure 1 - 17 on page 1 - 26</a>) may be toggled on/off by means of the <strong>Fn + Power Button</strong> key combination. When the powered USB port is on it will supply power (for charging devices only, not for operating devices) when the system is off but still powered by the AC/DC adapter plugged into a working outlet, or powered by the battery with a capacity level above 20% (this may not work with certain devices - see page <a href="#">8 - 12</a>). <strong>Note:</strong> This function is designed to help charge USB compliant devices, but is <strong>not designed to allow their operation</strong>.</td>
</tr>
<tr>
<td>USB 3.0 Port</td>
<td></td>
</tr>
<tr>
<td>Powered USB 3.0 Port</td>
<td></td>
</tr>
</tbody>
</table>
Interface (Ports & Jacks)
Appendix B: Control Center

Overview

The following chapter will give a quick description of the functions of the Control Center. The Control Center gives quick access to frequently used controls, power management features and enables you to quickly turn modules on/off. Click the Control Center icons to toggle the appropriate function, or hold the mouse button down and move the dial control where applicable. Certain functions will automatically be adjusted when a power mode is selected. The Control Center in Windows 8.1 works under the Desktop app and not under the Start screen.

Figure B - 1 - Control Center

Control Center Access

To run the Control Center press the Fn + Esc key combination, or double-click the icon in the notification area of the taskbar.

Close the Control Center by clicking the close icon in the top right of the panel (move the cursor onto the top right corner of the panel to highlight it).
Control Center

Power Modes
You can set a Power Mode by clicking the appropriate icon at the top of the Control Center. Each power mode will affect the Power Conservation Mode, Airplane Mode, Power Plan and PC camera power etc.

You can click a Control Center icon to set an overall power mode and then click individual icons in the Control Center to power on/off the Touchpad and PC camera.

<table>
<thead>
<tr>
<th>Modes</th>
<th>Quiet</th>
<th>Power Saving</th>
<th>Performance</th>
<th>Entertainment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Icon</td>
<td><img src="image" alt="Quiet" /></td>
<td><img src="image" alt="Power Saving" /></td>
<td><img src="image" alt="Performance" /></td>
<td><img src="image" alt="Entertainment" /></td>
</tr>
<tr>
<td>Power Plan</td>
<td>Balanced</td>
<td>Power Saver</td>
<td>High Performance</td>
<td>Balanced</td>
</tr>
<tr>
<td>Power Conservation Mode</td>
<td>Balance</td>
<td>Energy Star</td>
<td>Performance</td>
<td>Balance</td>
</tr>
</tbody>
</table>

- PC Camera: ON, OFF, ON, ON
- TouchPad: ON, ON, ON, OFF
- Airplane Mode: OFF, ON, OFF, OFF

*Table B - 1 - Power Modes*
Control Center Menus
The Control Center contains 3 menu headings (System Program, Device and Gaming) under the Power Modes. Click the menu headings and then click any of the buttons outlined on the following pages.

Figure B - 2 - Control Center Menus
Control Center

**Power Status (System Program)**
The **Power Status** icon will show whether you are currently powered by the battery, or by the AC/DC adapter plugged in to a working power outlet. The power status bar will show the current battery charge state.

**Brightness (System Program)**
The **Brightness** icon will show the current screen brightness level. You can use the slider to adjust the screen brightness or the **Fn + F8/F9** key combinations, or use the **Fn+ F2** key combination to turn off the LED backlight (press any key to turn it on again).

**Volume (System Program)**
The **Volume** icon will show the current volume level. You can use the slider to adjust the Volume or the **Fn + F5/F6** key combinations, or use the **Fn+ F3** key combination to mute the volume.

**Power Conservation (System Program)**
This system supports **Energy Star** power management features that place computers (CPU, hard drive, etc.) into a low-power sleep modes after a designated period of inactivity (see “**Power Conservation Modes**” on page 3 - 12). Click either the **Performance**, **Balanced** or **Energy Star** button.
**Sleep Button (System Program)**

Click either the **Hibernate** or **Sleep** buttons to have the computer enter the selected power-saving mode (see “Power-Saving States” on page 3 - 7).

**Display Switch (System Program)**

Click the **Display Switch** button to access the menu (or use the `Windows` + `P` key combination) and select the appropriate attached display mode.

**Time Zone (System Program)**

Clicking the **Time Zone** button will access the **Date and Time Windows** control panel.

**Desktop Background (System Program)**

Clicking the **Desktop Background** button will allow you to change the desktop background picture.

**TouchPad/PC Camera (Device)**

Click either of these buttons to toggle the TouchPad or camera module’s power status. The icon will appear dimmed when it is off. Note that the power status of the camera module is also effected by the **Power Mode** selected (see *Table B - 1, on page B - 2*).

**Caps Lock/Scroll Lock/ Number Lock/Airplane Mode**

Click the button to toggle the appropriate lock mode and Airplane Mode.
**Control Center**

**Left Windows Key (Gaming)**
Click **Disable** to disable the Windows Key on the left side of the keyboard. This may be useful if you are using the gaming keys (W, A, S & D) and wish to avoid accidentally triggering menus with the Windows Key.

**Fan Speed (Gaming)**
The fan speed will adjust itself automatically to control the heat of the CPU. However you can adjust the setting to maximum if you prefer.

**Headphone (Gaming)**
The headphones may be set for different effects using this menu.

**Backlight Keyboard (Gaming)**
Click the button to access the Backlight Keyboard application.
Appendix C: Video Driver Controls

Overview

The basic settings for configuring the LCD are outlined in "Video Features" on page 1 - 43.

The basic video features for this computer can be configured using the Intel HD Graphics Control Panel. Further video configuration is available through the NVIDIA control panel. See the following pages for further information.

- For Intel video driver control information see pages C - 5 to C - 29.
- For NVIDIA video driver control information see pages C - 30 to C - 36.

Video Card Options

Note that card types, specifications and drivers are subject to continual updates and changes. Check with your distributor/supplier for the latest details on video cards supported (see "Video Adapter Options" on page D - 3).
Microsoft Hybrid Graphics

Most notebook computers come with either a discrete or integrated graphics solution.

Discrete graphics solutions feature a dedicated Graphics Processing Unit (GPU) which are capable of playing games, watching HD video or running GPU-based applications. However computers with discrete graphics solutions tend to be heavy in power consumption, and slightly larger in size in order to incorporate the dedicated discrete GPU.

Integrated graphics solutions usually feature memory sharing technology to help save power consumption and allow for longer battery life. However computers with integrated graphics solutions will not usually run games, HD video or GPU-based applications without severe limitations.

Microsoft Hybrid Graphics is a seamless switchable graphics technology designed to get best performance from the graphics system while allowing longer battery life, without having to manually change settings. Thus when an application is run that requires extra performance or quality, then the system will run the discrete GPU (dGPU); when the system does not require such enhanced performance it will let the integrated (iGPU) handle it.
How Switchable Technology works
When the system is powered up and is displaying just the desktop, the dGPU will be powered off. In this case the system is running in the same way as a system without a discrete graphics solution. However when an application that requires use of the dGPU is run (e.g., a game or HD Video), the dGPU is powered on and takes over the processing duties. If the program is closed, then the dGPU will be powered back down again until required.

The **GPU LED indicator** will display which GPU is currently in use.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Blue/White</td>
<td>Discrete GPU (dGPU) Activated</td>
</tr>
<tr>
<td>Blue/White</td>
<td></td>
<td>Integrated GPU (iGPU) Activated</td>
</tr>
</tbody>
</table>

Make sure you install all the necessary video drivers for your system (see overleaf).
Video Driver Installation

Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3. Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers (button).

Video (VGA)
1. Click 2. Install VGA Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

NVIDIA Video (VGA)
1. Click 3. Install NVIDIA VGA Driver > Yes.
2. Click AGREE AND CONTINUE (button) to accept the terms of the license agreement.
3. Click Next.
4. Click the Close button to complete the installation.
Intel® HD Graphics Control Panel

Advanced video configuration options are provided by the Intel® HD Graphics Control Panel. To access the control panel see below and overleaf:


(see over)
Video Driver Controls

OR
2. Right-click the Desktop and select Graphics Properties from the menu.

OR
3. Click Advanced settings in the Screen Resolution control panel in Windows.
5. Double-click the Intel(R) HD Graphics control panel in the Windows Control Panel.

Figure C - 2
Intel® HD Graphics Control Panel
You may make changes to any of the graphics properties by clicking the appropriate menu panel and adjusting the settings on the right.

Figure C - 3
Intel® HD Graphics Control Panel
Video Driver Controls

**Sub-Menus**

Some of the menu panels will also have sub-menus (in the top left corner of the menu alongside the icon) to display further configuration options.

*Figure C - 4*

Intel® HD Graphics Control Panel

Sub-Menus

- Display
  - Display Settings
  - Multiple Displays
- Options
  - Hot Key Manager
  - Information Center
  - Preferences
- Video
  - Color Enhancement
  - Image Enhancement
  - Image Scaling
  - Gamut Mapping
Display
Click either Display Settings or Color to make display adjustments, including configuration for any attached external displays.

Multiple Display
At least one other display must be attached in order to view multiple display selection options.

Figure C - 5
Intel® HD Graphics Control Panel
Display Settings
Click the **Display** menu at the top of the screen to display the sub-menus. The **Multiple Displays** menu allows you to configure the display mode of any attached displays (see “Attaching Other Displays” on page C - 21).
The **Audio** sub-menu (if applicable) allows you to configure the capability mode of any attached displays (i.e. the attached display supports audio). **Enable Audio Without Video** to keep audio on when the display blanks out for power saving purposes.

*Figure C - 7*
Intel® HD Graphics Control Panel
Display Settings - Audio
3D
This menu allows you to choose how 3D images are displayed. **Quality** displays the most detail, **Balanced** provides better computer performance with good quality and **Custom** allows you to configure the **Anisotropic Filtering** and **Vertical Sync** features to your preferences. Click **Apply** to save changes.

*Figure C - 8*
*Intel® HD Graphics Control Panel 3D*
Options allows you to Customize Hot Keys (for opening the application, rotating the display, scaling etc.,) to your preferences. Click Apply to save changes.

![Figure C - 9 Intel® HD Graphics Control Panel Options](image)
Click the **Options** menu at the top of the screen to display the sub-menus. The **Information Center** provides details on **System Information**, the **Built-In Display** and any attached displays.

![Intel® HD Graphics Control Panel Options - Information Center](image-url)
Video
The Video Profiles menu allows you to brighten or darken movies, or to switch to vivid colors. Click Basic or Advanced to adjust the video settings based on the Application Settings or Driver Settings. The Preview image will display a sample image using the current settings. You can Save Profile and name the Profile to recall the settings at any time. Click Apply to save changes.

Figure C - 11
Intel® HD Graphics Control Panel Video (Basic - Application Settings)
Click the **Video** menu at the top of the screen to display the sub-menus. The **Image Enhancement** menu allows you to adjust the Sharpness, Skin Tone Enhancement, Noise Reduction etc. Click **Apply** to save changes.
The **Image Scaling** and **Gamut Mapping** menus allow you to adjust these items.

*Figure C - 13*
Intel® HD Graphics Control Panel Video Image Scaling & Gamut Mapping
Power
Choose a Power Plan for when the computer is **Plugged in** or **On battery**. When turned on, the **Display Power Saving Technology** (which adjusts the backlight intensity) battery settings may be adjusted by means of the slider towards **Maximum Quality** or **Maximum Battery**. Click on **Apply** to save changes.

*Figure C - 14*
**Intel® HD Graphics Control Panel Power (Battery Settings)**
Support
Click Support and select an item from the menus to bring up the help and support topics. You will need to be connected to the Internet to access the key resource links.
Display Devices & Options

Note that you can use external displays connected to the HDMI-Out port and/or external display port/mini display port. See your display device manual to see which formats are supported.

### Attaching Displays

When you first attach an external display you may find that the desktop does not occupy the full screen area. Use either the display's auto adjust/configure controls, or the Intel(R) HD Graphics Control Panel to configure the full screen display.

<table>
<thead>
<tr>
<th>Display Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Display</td>
<td>One of the connected displays is used as the display device (PC screen only or Second screen only).</td>
</tr>
<tr>
<td>Clone/Duplicate</td>
<td>Both connected displays output the same view and may be configured independently</td>
</tr>
<tr>
<td>Extended / Extend</td>
<td>Both connected displays are treated as separate devices, and act as a virtual desktop</td>
</tr>
<tr>
<td>Collage</td>
<td>A number of connected displays are combined into a single unified higher resolution for larger screen sizes</td>
</tr>
</tbody>
</table>
Attaching Other Displays

To Clone Displays:
1. Attach your external display to the display port/mini display port/HDMI-Out port, and turn it on.
2. Go to the Intel(R) HD Graphics Control Panel control panel and click Display > Multiple Displays (sub-menu).
3. Click Clone from the Select Multiple Display Mode menu.
4. Click Apply, and OK to confirm the settings change.
5. You can select the displays to be used from the Select Active Displays menu.

Multiple Display
At least one other display must be attached in order to view Multiple Display selection options.

Figure C - 16
Display > Multiple Displays (Clone)
To Enable Extended Mode:
1. Attach your external display to the display port/mini display port/HDMI-Out port, and turn it on.
2. Go to the Intel(R) HD Graphics Control Panel control panel and click Display > Multiple Displays (sub-menu).
3. Click Extended from the Select Multiple Display Mode menu.
4. Click Apply, and OK to confirm the settings change.

Display Settings

Extended Desktop
You can have different Colors, Screen Area and Monitor Refresh Rates for each display device provided your monitor can support them.

You can drag the monitor icons to match the physical layout of your displays. Icons and programs may also be dragged between the displays.

Click the appropriate monitor icon and drag it to match the physical arrangement you wish to use (e.g. the secondary display may be extended left/right/above/below the primary display).

Click Display Settings to make any adjustments required.
To Enable Collage Mode:
1. Attach your external displays to the external monitor port and HDMI-Out port, and turn them on.
2. Go to the Intel(R) HD Graphics Control Panel control panel and click Display > Multiple Displays (sub-menu).
3. Click Collage from the Select Multiple Display Mode menu.
4. Click Enable Collage and click On.
5. Click Vertical or Horizontal to arrange and displays as required.
6. Click Apply, and OK to confirm the settings change.

Collage Mode
Collage mode is used to combine a number of displays into a single unified higher resolution for larger screen sizes.

Figure C - 18
Display > Multiple Displays (Collage)
Attaching Other Displays - Devices (Charms Bar)

You can configure attached displays from Devices (in the Charms Bar).

1. Attach your external display to the display port/mini display port/HDMI-Out port, and turn it on.
2. Go to the Charms Bar, select Devices.
3. Click Project (you may need to click Second Screen).
4. Click on any one of the options from the menu to select PC screen only, Duplicate, Extend or Second screen only.

Windows Logo Key + P Key Combination

You can use the Windows Logo Key + P key combination to quickly bring up the Second Screen menu.

You can also use the Display Switch button in the Control Center to access the menu and select the appropriate attached display mode.

You can also use the Fn + F7 key combination to quickly access the Second Screen menu in Windows 8.

Figure C - 19
Second Screen (Devices)
Configuring an External Display In Windows

1. Attach your external display to the display port/mini display port/HDMI-Out port, and turn it on.
2. Go to the **Screen resolution** control panel (see page 1 - 44) in the Desktop app.
3. Click the **Detect** button.
4. The computer will then detect any attached displays.

![Screen Resolution](image)

*Figure C - 20
Screen Resolution
Multiple Displays*
5. You can configure the displays from the Multiple Displays menu.

- Duplicate these displays - Shows an exact copy of the main display desktop on the other display(s)
- Extend these displays - Treats both connected displays as separate devices
- Show desktop only on 1/2 - Only one of your displays is used.

Figure C - 21
Screen Resolution
Multiple Display Options
HDMI Audio Configuration

HDMI (High-Definition Multimedia Interface) carries both audio and video signals. In some cases it will be necessary to go to the Sound control panel and manually configure the HDMI audio output as per the instructions below.

1. Go to the Control Panel.
2. Click Sound (Hardware and Sound) and click Playback (tab)
3. Depending on your display, the playback device may be selected, however in some cases you may need to select the audio device and click Set Default (button).
4. Double-click the device to access the control panel tabs illustrated overleaf.

Volume Adjustment

The sound volume level can be set using the volume control in the Settings menu in the Charms Bar.

Figure C - 22
Sound - HDMI Device (set Default)
Video Driver Controls

5. Adjust the HDMI settings from the control panel tabs.
6. Click **OK** to close the **Sound** control panel.

---

**Figure C - 23**

HDMI Device Properties

---

C - 28 HDMI Audio Configuration
HDMI Notes
• Connect a device with HDMI support to the HDMI-Out port BEFORE attempting to play audio/video sources through the device.
• To play audio sources through your external display’s (TV or LCD) speakers you will need to go to the audio configuration control panel on the display and configure the audio input accordingly (see your display device manual).

HDMI Video Configuration
1. Connect an HDMI cable from the HDMI-Out port to your external display.
2. Configure your external display as per the instructions in “Attaching Other Displays” on page C - 21.
3. Set up your external display (TV or LCD) for HDMI input (see your display device manual).
4. You can now play video/audio sources through your external display.

Sound Blaster Audio & HDMI
1. When you connect an HDMI display to the HDMI-Out port, the Sound Blaster Cinema EQ controls will be disabled.
2. A warning box will pop-up and will prompt “...Do you want to select another audio device now?”. 
3. Click No to continue using the HDMI audio output from your external display (do not attempt to select another audio device when connected to the external HDMI display.

Other Applications
If you are using a third party application to play DVDs etc. from any attached DVD device, you will need to consult the application's documentation to see the appropriate audio configuration (the application must support digital to analog translation).
Video Driver Controls

NVIDIA Control Panel

More advanced video configuration options are provided in the NVIDIA Control Panel tab.

1. Go to the Control Panel.
2. Double-click NVIDIA Control Panel (click to view the control panel in either Large icons or Small icons if you are in Category view).

Figure C - 24
NVIDIA Control Panel

C - 30 NVIDIA Control Panel
The NVIDIA Control Panel provides additional video configuration controls and tools which allow quick access to features such as image settings, 3D Settings and video configuration.

Navigating the Control Panel

Navigate through the control panels in much the same way as you would a web page. Click on the sub-heading tasks in the left menu (and on the highlighted links) for information. Use the buttons on the top left to go back, forward etc.

Figure C - 25
NVIDIA Control Panel
Customization Options

One of the most important aspects of hybrid technology is that it will switch between the integrated GPU and discrete GPU seamlessly and automatically, and does not require any input from the user. However, customization options are offered for users who prefer to set their own parameters for GPU usage.

Context Menu

One of the quickest ways to choose which GPU to use for a particular application is by using the "Run with graphics processor" in the context menu.

1. Go to the NVIDIA Control Panel.
2. Click Desktop from the top menu and select Add “Run with graphics processor” to Context Menu (it should have a check alongside it).

![NVIDIA Control Panel - View](image)
3. Close the NVIDIA Control Panel.
4. Find the executable file icon of the application you want to run.
5. Right-click the icon and select **Run with graphics processor** from the context menu.
6. Select either **High-performance NVIDIA processor** (dGPU) or **Integrated graphics** (iGPU) to run the program with the selected GPU.

Note the NVIDIA control panel refers to **High-performance NVIDIA processor** (which is the discrete GPU) and **Integrated graphics** (which is the integrated GPU).

*Figure C - 27 Context Menu with Run with graphics processor*
Global Settings

Global settings allows you to set the preferred graphics processor for overall use. Ideally this would be the iGPU for battery life, but this can be set to the dGPU if preferred.

1. Go to the NVIDIA Control Panel.
2. Click Manage 3D Settings (3D Settings) and select Global Settings (tab).
3. Select either Integrated graphics (iGPU) or High performance NVIDIA Processor (dGPU) from the drop-down menu.
4. Click the Setting menu items to select any options required.
5. Click Apply to save the settings.
Program Settings
Program settings allows you to make specific adjustments for installed applications.

1. Go to NVIDIA Control Panel.
2. Click Manage 3D Settings (3D Settings) and select Program Settings (tab).
3. Select a program to customize from the drop-down menu, or click Add to add any program that does not appear in the menu.
4. Select the preferred graphics processor for the program from the drop-down menu.
5. Click the Setting menu items to select any options required.
6. Click Apply to save the settings.

![Figure C - 29 Program Settings](image)
Set PhysX® Configuration

NVIDIA® PhysX® is a physics engine that can use the GPU to accelerate game and 3D application performance. You can select the GeForce video card or CPU as a PhysX® processor, or configure the computer to auto-select a PhysX® processor (recommended default setting).

1. Go to NVIDIA Control Panel.
2. Click Set PhysX configuration.
3. Click to Select a PhysX processor from the menu; Auto-select (recommended) is the default setting.
4. Click Apply to save the settings.

Figure C - 30
Set PhysX® Configuration
Appendix D: Specifications

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check with your distributor/supplier for details.
## Specifications

### Processor

<table>
<thead>
<tr>
<th>For Models A, B, C, E &amp; F Only:</th>
<th>Intel® Core™ i7-4930MX (3.00GHz) Extreme Edition Processor</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>8M L3 Cache, 22nm (2 Nanometer), DDR3L-1600MHz, TDP 57W</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>For All Models:</th>
<th>Intel® Core™ i7-4900MQ (2.80GHz) Processor</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>8M L3 Cache, 22nm (2 Nanometer), DDR3L-1600MHz, TDP 47W</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Intel® Core™ i7-4800MQ (2.70GHz) Processor</th>
</tr>
</thead>
<tbody>
<tr>
<td>6M L3 Cache, 22nm (2 Nanometer), DDR3L-1600MHz, TDP 47W</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Intel® Core™ i7-4700MQ (2.40GHz) Processor</th>
</tr>
</thead>
<tbody>
<tr>
<td>6M L3 Cache, 22nm (2 Nanometer), DDR3L-1600MHz, TDP 47W</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Intel® Core™ i7-4600M (2.9GHz) Mobile Processor</th>
</tr>
</thead>
<tbody>
<tr>
<td>4M L3 Cache, 22nm (2 Nanometer), DDR3L-1600MHz, TDP 37W</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>For All Models:</th>
<th>Intel® Core™ i5-4330M (2.8GHz) Mobile Processor</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>3M L3 Cache, 22nm (2 Nanometer), DDR3L-1600MHz, TDP 37W</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Intel® Core™ i5-4300M (2.6GHz) Mobile Processor</th>
</tr>
</thead>
<tbody>
<tr>
<td>3M L3 Cache, 22nm (2 Nanometer), DDR3L-1600MHz, TDP 37W</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Intel® Core™ i5-4200M (2.5GHz) Mobile Processor</th>
</tr>
</thead>
<tbody>
<tr>
<td>3M L3 Cache, 22nm (2 Nanometer), DDR3L-1600MHz, TDP 37W</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Intel® Core™ i3-4100M (2.5GHz) Mobile Processor</th>
</tr>
</thead>
<tbody>
<tr>
<td>3M L3 Cache, 22nm (2 Nanometer), DDR3L-1600MHz, TDP 37W</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Intel® Core™ i3-4000M (2.4GHz) Mobile Processor</th>
</tr>
</thead>
<tbody>
<tr>
<td>3M L3 Cache, 22nm (2 Nanometer), DDR3L-1600MHz, TDP 37W</td>
</tr>
</tbody>
</table>

### Core Logic

<table>
<thead>
<tr>
<th></th>
<th>Mobile Intel® HM87 Express Chipset</th>
</tr>
</thead>
</table>

### Memory

<table>
<thead>
<tr>
<th>Dual Channel DDR3L</th>
</tr>
</thead>
<tbody>
<tr>
<td>Four 204 Pin SO-DIMM Sockets</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Supporting DDR3L 1600 MHz Memory Modules (real operational frequency depends on the FSB of the processor)</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Note: Four SO-DIMMs are only supported by Quad-Core CPUs; Dual-Core CPUs support two SO-DIMMs maximum</td>
</tr>
</tbody>
</table>

| Memory Expandable up to 16GB/32GB |
| Compatible with 2GB/4GB/8GB Modules |

### Display

<table>
<thead>
<tr>
<th>Models A, B C &amp; D:</th>
<th>15.6&quot; (39.62cm) FHD (1920 * 1080) 16:9 Backlit Panel</th>
</tr>
</thead>
</table>

| Models E & F:      | 17.3" (43.94cm) FHD (1920 * 1080) 16:9 Backlit Panel |
## Specifications

### Video Adapter Options

<table>
<thead>
<tr>
<th>For All Models:</th>
<th>For Model B Only:</th>
</tr>
</thead>
<tbody>
<tr>
<td>NVIDIA® GeForce GTX 860M PCIe * 16 Video Card</td>
<td>Two Changeable 2.5&quot; (h) Hard Disk Drives (HDD) / Solid State Drives (SSD), 1st 9.5mm (h) &amp; 2nd 7mm (h), with SATA Interface supporting RAID Level 0/1</td>
</tr>
<tr>
<td>NVIDIA® GeForce GTX 870M PCIe * 16 Video Card</td>
<td>For Models E &amp; F:</td>
</tr>
<tr>
<td>6GB GDDR5 Video RAM</td>
<td>Two Changeable 2.5&quot; 9.5 mm (h) Hard Disk Drives (HDD) / Solid State Drives (SSD) with SATA Interface and RAID Level 0/1 Support</td>
</tr>
<tr>
<td>NVIDIA® GeForce GTX 870M PCIe * 16 Video Card</td>
<td>BIOS</td>
</tr>
<tr>
<td>8GB GDDR5 Video RAM</td>
<td>One 48Mb SPI Flash ROM</td>
</tr>
<tr>
<td>NVIDIA® GeForce GTX 860M PCIe * 16 Video Card</td>
<td>AMI BIOS</td>
</tr>
<tr>
<td>NVIDIA® GeForce GTX 870M PCIe * 16 Video Card</td>
<td>Audio</td>
</tr>
<tr>
<td>NVIDIA® GeForce GTX 860M PCIe * 16 Video Card</td>
<td>High Definition Audio</td>
</tr>
<tr>
<td>NVIDIA® GeForce GTX 860M PCIe * 16 Video Card</td>
<td>S/PDIF Digital Output</td>
</tr>
<tr>
<td>NVIDIA® GeForce GTX 860M PCIe * 16 Video Card</td>
<td>Built-In Microphone</td>
</tr>
<tr>
<td>NVIDIA® GeForce GTX 860M PCIe * 16 Video Card</td>
<td>2 Built-In Speakers</td>
</tr>
<tr>
<td>NVIDIA® GeForce GTX 860M PCIe * 16 Video Card</td>
<td>1 Built-In Sub Woofer</td>
</tr>
<tr>
<td>NVIDIA® GeForce GTX 860M PCIe * 16 Video Card</td>
<td>Sound Blaster® X-Fi® MB3</td>
</tr>
<tr>
<td>NVIDIA® GeForce GTX 860M PCIe * 16 Video Card</td>
<td>7.1CH Audio output supported by headphone, microphone, S/PDIF &amp; Line-In Jack</td>
</tr>
</tbody>
</table>

### Switchable GPU (iGPU or dGPU)

- Intel® Integrated GPU with NVIDIA® GeForce Video:
- Intel® HD Graphics 4600 Integrated GPU (GPU type is processor dependent)
- Dynamic Frequency
- Intel® Dynamic Video Memory Technology Supporting Shared Memory up to 1.7GB
- Microsoft DirectX® 11 compatible
- NVIDIA PhysX™
- NVIDIA CUDA™ Technology

### For Models A, B, C, E & F Only:

- NVIDIA® GeForce GTX 880M PCIe * 16 Video Card
- 8GB GDDR5 Video RAM
- Microsoft DirectX® 11.1 compatible
- NVIDIA PhysX™
- GeForce CUDA™ Technology

### Storage

<table>
<thead>
<tr>
<th>For Models A, C &amp; D:</th>
<th>For Model B Only:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Two mSATA Solid State Drives (SSDs) with SATA (Serial) Interface with RAID Level 0/1 Support (Factory Option)</td>
<td>Two Changeable 2.5&quot; (h) Hard Disk Drives (HDD) / Solid State Drives (SSD), 1st 9.5mm (h) &amp; 2nd 7mm (h), with SATA Interface supporting RAID Level 0/1</td>
</tr>
<tr>
<td>One 12.7 mm Super Multi/Blu-Ray Combo/Blu-Ray Writer SATA Optical Device Drive (Factory Option)</td>
<td>For Models E &amp; F:</td>
</tr>
<tr>
<td>For Models A, C &amp; D:</td>
<td>Two Changeable 2.5&quot; 9.5 mm (h) Hard Disk Drives (HDD) / Solid State Drive (SSD) with SATA Interface</td>
</tr>
<tr>
<td>One Changeable Caddy Bay 12.7mm (h) Optical Device Drive (ODD), 2.5&quot; 9.5 mm (h) Hard Disk Drive (HDD) with SATA Interface (Factory Option)</td>
<td>BIOS</td>
</tr>
<tr>
<td>One Changeable 2.5&quot; 9.5 mm (h) Hard Disk Drive (HDD) / Solid State Drive (SSD) with SATA Interface</td>
<td>One 48Mb SPI Flash ROM</td>
</tr>
<tr>
<td>Sound Blaster® X-Fi® MB3</td>
<td>AMI BIOS</td>
</tr>
<tr>
<td>7.1CH Audio output supported by headphone, microphone, S/PDIF &amp; Line-In Jack</td>
<td>Audio</td>
</tr>
</tbody>
</table>

### BIOS

- High Definition Audio
- S/PDIF Digital Output
- Built-In Microphone
- 2 Built-In Speakers
- 1 Built-In Sub Woofer
- Sound Blaster® X-Fi® MB3
- 7.1CH Audio output supported by headphone, microphone, S/PDIF & Line-In Jack
## Specifications

<table>
<thead>
<tr>
<th>Keyboard &amp; Pointing Device</th>
<th>Interface</th>
<th>Slots</th>
<th>Card Reader</th>
<th>Communication</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>For Models A, B, E &amp; F Only:</strong></td>
<td>One USB 2.0 Port</td>
<td>Three Mini-Card Slots:</td>
<td>Embedded Multi-In-1 Push-Push Card Reader</td>
<td>Built-In 10/100/1000Mb Base-TX Ethernet LAN</td>
</tr>
<tr>
<td>Full Size Winkey Illuminated Keyboard with</td>
<td>Three USB 3.0 Ports *(Note: One powered</td>
<td>Slot 1 for WLAN or WLAN &amp; Bluetooth</td>
<td>- MMC / RSMMC</td>
<td>2.0M FHD PC Video Camera Module</td>
</tr>
<tr>
<td>Numeric Keypad *(Models C &amp; D have a</td>
<td>USB3.0 port (AC/DC)*</td>
<td>Combo Half Mini-Card Module with PCIe and USB</td>
<td>- SD / Mini SD / SDHC / SDXC</td>
<td>(see over)</td>
</tr>
<tr>
<td>Non-Illuminated Keyboard)**</td>
<td>One eSATA Port (SATA USB 3.0 Combo)</td>
<td>Interface*</td>
<td>- MS / MS Pro / MS Duo</td>
<td></td>
</tr>
<tr>
<td><strong>For Models A, C, D &amp; E Only:</strong></td>
<td>One Mini-IEEE1394a Port</td>
<td>Slot 2 &amp; 3 for mSATA SSD Full Size</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Built-In TouchPad *(with Multi Gesture</td>
<td>One Display Port 1.2</td>
<td>Mini-Card Module with SATA Interface</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Functionality)*</td>
<td>One Mini Display Port 1.2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>For Models B &amp; F Only:</strong></td>
<td>One HDMI™ *(High-Definition Multimedia</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Built-In Illuminated or Non-Illuminated</td>
<td>Interface) Out Port (with HDCP)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TouchPad <em>(with Multi Gesture Functionality)</em></td>
<td>One Microphone-In Jack</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>For All Models:</strong></td>
<td>One Headphone/Speaker-Out Jack</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>W/A/S/D Game Key Markings</td>
<td>One S/PDIF Out Jack</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Indicators</strong></td>
<td>One Line-In Jack</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LED Indicators - Power/Suspend, Battery,</td>
<td>One RJ-45 LAN Jack</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HDD/ODD, Airplane Mode, GPU Mode, Num Lock,</td>
<td>One DC-In Jack</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Caps Lock, Scroll Lock, Camera</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Security</strong></td>
<td>Security *(Kensington® Type) Lock Slot</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BIOS Password</td>
<td>Fingerprint Reader Module *(Factory Option)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fingerprint Reader Module *(Factory Option)</td>
<td>Trusted Platform Module 1.2 *(Factory Option)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

D - 4 Specifications
Specifications

Intel® Centrino® Ultimate-N 6300 3*3 (802.11 a/g/n) Half Mini-Card PCIe WLAN Module (Factory Option)

Intel® Dual Band Wireless-AC 7260 (2*2 802.11 a/c) Half Mini-Card PCIe WLAN + Bluetooth Combo Module (Factory Option)

Intel® Wireless-N 7260 (2*2 802.11 b/g/n) Half Mini-Card PCIe WLAN + Bluetooth Combo Module (Factory Option)

Qualcomm® Atheros Killer™ Wireless-N 1202 Dual Band (2*2 802.11 a/b/g/n) Half Mini-Card PCIe WLAN + Bluetooth Combo Module (Factory Option)

(802.11b/g/n) Half Mini-Card PCIe WLAN + Bluetooth V4.0+LE Combo Module (Factory Option)

Operating System
Windows® 8.1 (64-bit)

Features
Rubber Painted Style (Models A, B & F)
Painted Style (Models C & D)
AI-Alloy Plate (Model E)

Intel® Rapid Start Technology
Intel® Smart Response Technology

Power Management
Supports Wake on LAN
Supports Wake on USB
Supports Wake on RTC Alarm

Power
Removable 8 Cell Smart Lithium Ion Battery Pack 76.96WH

Models A, B & C:
Full Range AC/DC Adapter – AC in 100 - 240V, 50 - 60Hz DC Output 19.5V, 9.2A or 19V, 9.5A (180 Watts)

Model D:
Full Range AC/DC Adapter – AC in 100 - 240V, 50 - 60Hz DC Output 19.5V, 6.15A (120 Watts)

Models E & F:
Full Range AC/DC Adapter – AC in 100 - 240V, 50 - 60Hz DC Output 19.5V, 11.8A (230 Watts)

Environmental Spec

Temperature
Operating: 5°C - 35°C
Non-Operating: -20°C - 60°C

Relative Humidity
Operating: 20% - 80%
Non-Operating: 10% - 90%

Physical Dimensions & Weight

Models A, C & D:
376mm(w) * 256mm(d) * 35 - 43mm(h)
3.1kg with ODD and Battery

Model B:
375mm(w) * 268mm(d) * 22 - 45mm(h)
3.3kg with ODD and Battery

Model E:
412mm(w) * 276mm(d) * 45.4 - 41.8mm(h)
3.9kg with ODD and Battery

Model F:
414mm(w) * 286mm(d) * 25.3 - 46.1mm(h)
4.1kg with ODD and Battery